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FileMaker Server 9 Help
  

This document contains the same information provided in the online Help system for FileMaker 
Server 9. It is provided in this format to enable you to read the information independent of the Help 
system.

Are You New to FileMaker Server?

What is FileMaker Server? 
Find out what you can do.

FileMaker Server Getting Started 
Guide 
Learn how to install and start using 
FileMaker Server. See the Start Page.

What’s new in FileMaker Server?
All-new Admin Console, server-side 
scripting, more... 

Answers to Your FileMaker Server Questions

Uploading database files 
Use the Upload Database assistant to transfer databases 
from any networked computer to FileMaker Server.

Backing up databases 
Set up schedules to automatically back up databases on 
FileMaker Server.

Hosting a website 
Learn where to place your files.

Troubleshooting 
Find solutions to common problems.

On the Web

Video Demos and 
Resources 
Take a tour of key features 
and find more resources.

FileMaker Server Technologies 
Learn about ODBC, external 
SQL data sources, web 
publishing, and more.

Knowledge Base 
Find more answers now.

Customer Support 
Get service and support. 

http://www.filemaker.com/products/fms/resources.html
http://www.filemaker.com/products/fms/resources.html
http://www.filemaker.com/support/technologies
http://www.filemaker.com/kb
http://www.filemaker.com/support
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About FileMaker Server
FileMaker® Server is a dedicated database server that opens FileMaker Pro files, makes them 
available to clients on your network, and publishes FileMaker data in web pages or to other 
applications.

FileMaker Server Advanced has all the features of FileMaker Server plus:

• Instant Web Publishing. See Using Instant Web Publishing (page 50).

• Sharing data as a SQL data source via ODBC and JDBC. See Sharing FileMaker 
databases via ODBC and JDBC (page 103).

To upgrade an existing FileMaker Server deployment to FileMaker Server Advanced, you need a 
FileMaker Server Advanced license key. You can enter a new license without reinstalling any 
software. To update your license key, see Server information settings (page 55). 

Supported clients
Supported clients include:

• FileMaker Pro 7, 8, 8.5, and 9 

• Web users accessing data via the FileMaker Server Web Publishing Engine 

• FileMaker ODBC (Open Database Connectivity) and JDBC (Java Database Connectivity) 
clients using the FileMaker client drivers (FileMaker Server Advanced license required)

Admin Console
FileMaker Server Admin Console is an application that lets you easily configure and administer 
FileMaker Server, work with and monitor hosted databases and clients, and track statistical 
information.

You can run Admin Console on the same machine where FileMaker Server is running or on almost 
any Windows or Mac OS machine that has network access to FileMaker Server. See Starting Admin 
Console (page 29).

Related topic
New features in FileMaker Server 9 (page 9)
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New features in FileMaker Server 9
FileMaker Server 9 includes the following new features and improvements: 

All-new Admin Console 
• Start from almost any networked computer. No installation required.

• Same user interface on both Windows and Mac OS.

• Configure and administer all FileMaker Server components from a single administration 
application.

Run server-side ScriptMaker scripts
• Schedule a ScriptMaker™ script in a hosted database to run on FileMaker Server. See 

Running ScriptMaker scripts (page 131).

Upload databases
• Upload Database assistant enables you to upload databases to FileMaker Server from 

almost any networked computer. See Uploading database files (page 33).

• Upload multiple databases at once.

• Requires administrator login.

Receive email notifications
• Get an email message when scheduled backups and scripts complete successfully. See 

Enabling email notifications in schedules (page 147).

• Know when FileMaker Server logs errors and warnings. See Email notification settings 
(page 57).

Publish data to external web sites using PHP
• Custom Web Publishing with PHP enables you to access FileMaker data from a PHP web 

application. See Hosting PHP websites (page 45).

• The FileMaker API for PHP provides a FileMaker-supported, object-oriented interface to 
FileMaker databases.

Create server-based connections to external SQL data sources
• Host FileMaker Pro databases designed to connect to external SQL data sources via 

ODBC. 

• Set up connections on FileMaker Server to external data sources. Clients of FileMaker 
Server need no special drivers or set up. See Accessing external ODBC data sources (page 
105).

Other features
• View detailed information about clients and the databases they are using. See 

Administering clients (page 88) and Administering databases (page 93).

• Remove databases from FileMaker Server using Admin Console. See Removing hosted 
files (page 100).
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• Control how much information is logged by FileMaker Server. See Logging and statistics 
settings (page 76).

Related topic
About FileMaker Server (page 8)
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Deploying FileMaker Server
When you install FileMaker Server, you decide whether to deploy FileMaker Server on a single 
machine or on multiple machines. 

In a multiple-machine deployment, one machine is always the master and the others are workers.

• The master machine is always the machine on which the Database Server is deployed.

• The worker machines are the machines that run the Web Publishing Engine or the web 
server.

In a single-machine deployment, all components run on one machine, which can be considered the 
master machine.

For more information, see Which deployment type is right for me? (page 23)

After you install FileMaker Server on the master machine, the Deployment assistant guides you 
through the process of deploying FileMaker Server components.

The Deployment assistant helps you perform the following tasks:

• Create an administrator account that you use to login to FileMaker Server Admin Console 

• Set the name of your FileMaker Server deployment

• Enable sharing via ODBC and JDBC (FileMaker Server Advanced license required)

• Enable web publishing and select the web publishing technologies you want to use 

• Select a deployment type, and in a multiple-machine deployment, assign machine roles 

• Specify a web server (when web publishing is enabled)

You can also test your deployment after initial setup and change your deployment later as your 
needs change. See Changing a FileMaker Server deployment (page 28).

Note If you cancel the Deployment assistant during initial deployment, Admin Console exits and 
FileMaker Server is not deployed. Any attempt to start Admin Console starts the Deployment 
assistant for you to finish deploying FileMaker Server.

Related topics
Testing FileMaker Server (page 24)
Checking the status of your deployment (page 26)
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Setting up an administrator account
In this Deployment assistant step, set up the account that you’ll use to login to FileMaker Server 
Admin Console.

To set up an administrator account:
1. For User Name, enter the name that you want to login with.

2. For Password, enter the password that you want to login with.

You cannot leave Password empty.

3. Reenter your password in Confirm Password.

4. Click Next to go to the next step.

Click Cancel to exit the Deployment assistant.

Notes
• User Name is not case-sensitive.

• Password is case-sensitive.

• You can change the user name and password in Admin Console. You can also enable all 
members of a group to access Admin Console. See Admin Console settings (page 59).

Related topic
Deploying FileMaker Server (page 11)
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Naming FileMaker Server
In this Deployment assistant step, assign a name to your FileMaker Server deployment and 
optionally provide additional information.

To name your FileMaker Server deployment:
1. For Server Name, enter a name for your FileMaker Server deployment.

FileMaker Pro users see this name when they use the Open Remote File dialog box.

2. For Server Description, enter an optional description of your FileMaker Server 
deployment.

Administrators see this information on the Admin Console Start Page.

3. Under Administrator Contact Information, you can choose to enter contact information. 

This information appears on the Admin Console Start Page. You can also publish this 
information to a directory service. See Admin Console settings (page 59).

4. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Note You can change this information in Admin Console. See Admin Console settings (page 59).

Related topic
Deploying FileMaker Server (page 11)
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Enabling sharing via ODBC and JDBC
In this Deployment assistant step, enable your server to be a data source via ODBC and JDBC, if 
you purchased a FileMaker Server Advanced license.

To enable sharing via ODBC and JDBC:
1. Click Yes, enable ODBC/JDBC to enable sharing or click No, do not enable ODBC/JDBC 

to disable.

2. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes
• Enabling this feature allows clients to use FileMaker Server as a data source using ODBC 

and JDBC. For more information, see FILEMAKER ODBC AND JDBC GUIDE on the Start 
Page.

• This OBDC/JDBC data source feature is not needed to host FileMaker Pro databases that 
access an external SQL data source via ODBC. See Accessing external ODBC data 
sources (page 105).

• You can change this setting in Admin Console. See Enabling sharing via ODBC and JDBC 
(page 104).

Related topic
Deploying FileMaker Server (page 11)
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Enabling web publishing
In this Deployment assistant step, enable web publishing if you want to publish FileMaker databases 
to web users. You must enable this feature if you want to use FileMaker Server Custom Web 
Publishing or Instant Web Publishing. For more information, see Using Instant Web Publishing 
(page 50), Hosting XSLT websites (page 47), or Hosting PHP websites (page 45).

To enable web publishing:
1. Click Yes, enable Web Publishing to enable web publishing or click No, do not enable 

Web Publishing to disable.

2. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes
• To use web publishing, a supported web server must be installed and activated. For more 

information, see FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

• You can change the web publishing technology settings in Admin Console. However, you 
must use the Deployment assistant to enable or disable web publishing as a whole (click 
Edit Server Deployment on the FileMaker Server Overview pane).

Related topics
Deploying FileMaker Server (page 11)
Enabling technologies for web publishing (page 16)
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Enabling technologies for web publishing
In this Deployment assistant step, choose the technologies you want to use to publish your 
FileMaker databases on the web.

To enable the technologies for web publishing:
1. Select the web publishing technologies that you want to use.

2. If you enable PHP publishing, choose whether to install the FileMaker supplied version of 
PHP.

3. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes
• Enabling Instant Web Publishing requires a FileMaker Server Advanced license.

• You can change the web publishing technology settings in Admin Console. However, you 
must use the Deployment assistant to change the option to use the FileMaker supported 
PHP engine. See Hosting PHP websites (page 45).

• If you use your own version of PHP, you must manually install the FileMaker API for PHP in 
order to use PHP publishing. See FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP 
for more information.

If you want to Enable

Send HTTP requests along with XML query commands and 
parameters and retrieve FileMaker data as an XML document. 

XML 

Transform, filter, or format XML data in a FileMaker database 
using XSLT stylesheets for use in a web browser or in other 
applications.

XSLT 

Quickly and easily publish FileMaker databases on the web 
that look and work much like they do in FileMaker Pro.

Instant Web Publishing 

Requires a FileMaker Server 
Advanced license.

Access FileMaker data using the FileMaker API for PHP in 
PHP web applications.

PHP 

If you want to Choose

Install FileMaker supplied PHP 
and the FileMaker API for PHP

Yes, install the FileMaker supported version of PHP 
(PHP 5.2) 
If you already have PHP installed, it will be disabled.

Use your own installation of PHP No, use my existing installation of the PHP engine 

FileMaker Server supports PHP versions 4.3.11, PHP 
4.4.1, and PHP 5.x.

You must manually install the FileMaker API for PHP. For 
instructions, see FILEMAKER SERVER CUSTOM WEB 
PUBLISHING WITH PHP on the Start Page.
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Related topics
Deploying FileMaker Server (page 11)
Enabling web publishing (page 15)
Changing a FileMaker Server deployment (page 28)
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Selecting a deployment type
In this Deployment assistant step, choose how to deploy FileMaker Server components. FileMaker 
Server includes three components: the Database Server, Web Publishing Engine, and Web Server 
components. With the Deployment assistant, you can choose to deploy these components on one, 
two, or three machines to meet your needs.

See Which deployment type is right for me? (page 23) for more information.

To select a deployment type:
1. For Deployment Type, choose one of the following:

2. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes
• The master machine is always the machine that runs the Database Server.

• If you are deploying FileMaker Server components on more than one machine, install the 
software on the worker machines first and then the master machine to ensure a smoother 
deployment process.

Related topics
Deploying FileMaker Server (page 11)
Assigning worker machine roles (page 19)

Deployment type Deployment details

Single Machine Master: all FileMaker Server components
Two Machines Master: Database Server 

Worker: Web Publishing Engine and web server
Two Machines (Alternative) Master: Database Server and Web Publishing Engine 

Worker: web server
Three Machines Master: Database Server 

Worker: Web Publishing Engine 
Worker: web server
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Assigning worker machine roles
In this Deployment assistant step, unassigned worker machines on your local network are detected 
and presented with their IP addresses in the list beside each machine role. Assign a worker 
machine to each machine role (Web Publishing Engine or web server).

To assign a worker machine role:
1. In the Machines column beside the machine role that you want to assign, choose the IP 

address of an unassigned worker machine. 

If the address of a worker is not listed, click Rescan. Then check to see whether the worker is 
listed.

2. If a worker's IP address is still not listed, enter the address in IP Address and click Lookup.

The IP address you entered is added to the Machines list if the machine can be contacted and 
is an available worker.

3. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes
• You will not be able to see your worker machines if the necessary ports of your firewall are 

not open. See Ports used by FileMaker Server (page 161).

• If you are deploying FileMaker Server components on more than one machine, install the 
software on the worker machines first and then the master machine to ensure a smoother 
deployment process.

• If you cannot find the IP addresses for the worker machines on your network, see Ports 
used by FileMaker Server (page 161).

Related topics
Deploying FileMaker Server (page 11)
Selecting a deployment type (page 18)
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Specifying a web server
In this Deployment assistant step, specify a web server to use for web publishing.

To specify the web server:
1. For Web server, select the web server you wish to use.

If you want to configure the web server setting later, click Skip this step and configure later.
Note If you skip this step, web publishing will not be available and you will have to use Edit 
Server Deployment to activate it later.

2. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes
• If the Deployment assistant fails to detect the web server, check that you have installed and 

enabled the web server. Also check that the necessary firewall ports are open. Review the 
instructions provided in the FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

• If you are deploying FileMaker Server components on more than one machine, install the 
software on the worker machines first and then on the master machine to ensure a 
smoother deployment process.

• If you cannot find the IP addresses for the web server on your network, see Web Server 
Test Failed (page 21).

Related topic
Deploying FileMaker Server (page 11)
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Web Server Test Failed
If the Deployment assistant cannot communicate with the web server that you specified, you can 
provide more information and try again.

To change web server settings:
1. In the Web Server Test Failed step in the Deployment assistant, specify the settings to use 

to communicate with the web server.

2. Click Retry.

3. Examine the Web Server Test Results:

• If successful, the result is Web Server Test Passed.

• If unsuccessful, the Deployment assistant could not communicate with the web server. 
This test can fail if your web server requires HTTPS or uses a port other than 80. You 
can re-enter this information and try to communicate with the web server again. 

Ensure that you can access the web server from the master machine — for example, using 
a web browser — and try these steps again. 

If still unsuccessful, then click Skip this step and configure later. 
4. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Related topics
Deploying FileMaker Server (page 11)
Specifying a web server (page 20)

To change Do this

The protocol FileMaker Server 
uses to communicate with the 
web server

For Protocol, choose either HTTP or HTTPS. If the web 
server is configured to use HTTPS, choose HTTPS to enable 
FileMaker Server to communicate with the web server 
securely via SSL.

The host address of the web 
server

For Host address, enter the IP address or host name.

The port to communicate with 
the web server

For Port, enter a port number.
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Deployment summary
In this Deployment assistant step, review and confirm your deployment selections before FileMaker 
Server implements them.

To confirm your deployment:
• Click Finish if you are satisfied with your deployment details.

The Deployment assistant deploys FileMaker Server according to your selections. This may 
take a few minutes.

• Otherwise, click Back to return to the previous step or Cancel to exit the Deployment 
assistant.

Notes
• If Admin Console doesn’t start after deployment on the master machine, try the following:

• On the Start Page, click Click here to start Admin Console.

• Open a web browser on the master machine and enter http://localhost:16000.

Related topics
Deploying FileMaker Server (page 11)
Changing a FileMaker Server deployment (page 28)
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Which deployment type is right for me?
The type of deployment you should use depends primarily on the web publishing load, as 
summarized below. The greater the web publishing load, the more machines you may want to 
include in your FileMaker Server deployment. You can first deploy on fewer machines and, if the 
load increases over time, you can change the deployment later to use up to three machines.

If you're considering a multiple-machine deployment, three variations give you the flexibility to 
decide which components are on each machine. For details, see FILEMAKER SERVER GETTING 
STARTED GUIDE on the Start Page.

Related topics
Deploying FileMaker Server (page 11)
Selecting a deployment type (page 18)
Assigning worker machine roles (page 19)

FileMaker Server use Deployment type

FileMaker Pro clients only Single machine. No benefit from a multiple-machine deployment.
Solution development and 
testing

Single machine. No benefit from a multiple-machine deployment.

FileMaker Pro clients and 
moderate web publishing 
load

Single machine. Provides good web publishing performance in 
most environments. You can expand to a multiple-machine 
deployment later, if web publishing load increases.

Two machines (alternative). Available when you need to integrate 
with an existing web server on a separate machine.

Moderate to heavy web 
publishing load

Multiple machines. You can expand from two to three machines as 
load increases.

FileMaker Pro clients and 
heavy web publishing load

Multiple machines. Deploy only the Database Server on the master 
machine. Deploy the Web Publishing Engine and web server on 
one or two worker machines.

Three machines. Select this only when you:

• Need to combine the performance improvement of the two-
machine deployment with separate web server offered by 
the two-machine (alternative) deployment type.

• Expect a high volume of static web traffic in addition to 
FileMaker Pro and dynamic web publishing traffic.
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Testing FileMaker Server
The easiest way to test your FileMaker Server deployment is to use the Technology Tests page. The 
links on this page access the hosted FMServer_Sample.fp7 database via the technologies listed 
below. If a test succeeds, then all the FileMaker Server components are working. 

To test the FileMaker Server deployment:
1. Open the Technology Tests page.

There are two ways to view the page: 

• Start Admin Console and click the Open Test Page icon: 

• Type the following in a web browser:

http://[host or IP address of master]:16000/test 

2. Click the link for each test that you want to perform.

Related topics
Deploying FileMaker Server (page 11)
Configuring Database Server settings (page 62)

To Do this

Test FileMaker Pro Click Test FileMaker Pro.

If FileMaker Pro starts and successfully opens the sample database 
hosted on FileMaker Server, then the Database Server is working 
and responding to requests from FileMaker Pro clients.

Note You must have FileMaker Pro or FileMaker Pro Advanced 
installed locally on the machine where you are conducting the test.

Tip You can perform the same test another way: start 
FileMaker Pro from any networked machine, click File menu > 
Open Remote, select the server you want to test, and select 
FMServer_Sample.fp7.

Test Instant Web 
Publishing 

Click Test Instant Web Publishing.

If another web browser window or tab opens and displays the 
sample database, then Instant Web Publishing is working.

Note A FileMaker Server Advanced license is required.
Test PHP Custom Web 
Publishing 

Click Test PHP Custom Web Publishing.

If another web browser window or tab opens and displays a table 
containing data from the sample database, then Custom Web 
Publishing with PHP is working.

Test XSLT Custom Web 
Publishing

Click Test XSLT Custom Web Publishing. 

If another web browser window or tab opens and displays a table 
containing data from the sample database, then Custom Web 
Publishing with XSLT is working.
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Configuring web publishing settings (page 78)
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Checking the status of your deployment
The FileMaker Server Overview pane displays real-time status information about your FileMaker 
Server deployment updated every few seconds. 

The Server Status Information area shows the overall condition of your FileMaker Server 
deployment.

The diagram illustrates how many machines are in your deployment along with the IP address of 
each machine and the status of the Database Server, Web Publishing Engine, and web server. If the 
indicator next to any component name is red, then that component is not functioning or the master 
machine cannot communicate with the worker machine the component is running on.

The diagram also shows whether a supported web publishing technology or ODBC/JDBC sharing is 
enabled (ON/OFF).

The Server Information list provides the following:

To change the number and role of machines in your deployment, click Edit Server Deployment. For 
more information, see Changing a FileMaker Server deployment (page 28).

To change the maximum number of web publishing sessions, see General web publishing settings 
(page 79).

Notes
• Instant Web Publishing and sharing via ODBC/JDBC require a FileMaker Server Advanced 

license. 

• If you set up a machine as a worker and want to change it to a master, uninstall and then 
reinstall FileMaker Server. Choose Master in the installer’s Master/Worker Designation 
dialog box. For more information on moving an existing installation, see the FILEMAKER 
SERVER GETTING STARTED GUIDE on the Start Page.

Server information Description

FileMaker Server Host Name The name you assigned to your FileMaker Server deployment. 
To change the name, see Server information settings (page 
55).

Server Version The version of FileMaker Server.
Server Start TIme The date and time stamp when the server was lasted started.
Hosted Files The number of databases that are currently open.
FileMaker Pro Clients The number of clients connected using FileMaker Pro.
Instant Web Publishing 
Sessions 

The number of web publishing sessions currently used by 
Instant Web Publishing. 

Custom Web Publishing 
Sessions 

The number of web publishing sessions currently used by 
Custom Web Publishing. 

Note The sessions count shown on the FileMaker Server 
Overview pane is an instantaneous count that is updated at 
the same interval as the statistics log. This data is not subject 
to the five-second threshold that is required for sessions to 
appear in the Clients or Databases panes.

ODBC/JDBC Sessions The number of database sessions currently used by ODBC 
and JDBC clients. 
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Related topics
Troubleshooting (page 156)
Deploying FileMaker Server (page 11)
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Changing a FileMaker Server deployment
You can first deploy on fewer machines and, if the web publishing load increases over time, you can 
use the Deployment assistant to change your FileMaker Server deployment to use up to three 
machines.

To change a FileMaker Server deployment:
1. Click FileMaker Server Overview, then click the Edit Server Deployment link.

The Deployment assistant starts. 

2. Click Next until you see the options you want to change. 

The Deployment assistant shows the current selections.

3. Change any of the selections in these Deployment assistant steps:

• Enabling web publishing (page 15)

• Enabling technologies for web publishing (page 16)

• Selecting a deployment type (page 18)

• Assigning worker machine roles (page 19)

• Specifying a web server (page 20)

Except for enabling or disabling specific web publishing technologies, the other steps listed 
above can be changed only in the Deployment assistant. You can change all other settings in 
the Admin Console panes under Configuration.

4. In the Deployment Summary step, review your selections and click Finish to confirm your 
selections. 

FileMaker Server implements your deployment changes. This may take a few minutes.

Click Back to return to the previous step or Cancel to cancel the deployment.

Notes
• To change the master machine, you must uninstall FileMaker Server and reinstall it on the 

new master machine. You should also uninstall and then reinstall the worker machines in a 
multiple-machine deployment. For more information on upgrading or moving FileMaker 
Server from an existing installation, see the FILEMAKER SERVER GETTING STARTED GUIDE on 
the Start Page.

• You can add one more worker machine to a two-machine deployment and you can add up 
to two worker machines to a single-machine deployment.

• You can also remove worker machines from an existing deployment.

Related topic
Deploying FileMaker Server (page 11)
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Starting Admin Console
You can start FileMaker Server Admin Console on a Windows or Mac OS computer that has 
network access to the master machine in your FileMaker Server deployment. FileMaker Server 
delivers Admin Console as a lightweight Java client to your remote computer via Java Web Start 
technology. 

Note Remote computers must have at least version 5 of the Java Runtime Environment installed 
before they can start Admin Console. 

To start Admin Console:
1. Open a web browser and enter: 

http://<host>:16000 

where <host> is the IP address or domain name of the master machine in your FileMaker 
Server deployment. 

The Admin Console Start Page appears.

2. Click Start Admin Console. 

The admin_console_webstart.jnlp file downloads to your machine.

3. Before Admin Console starts, you must respond to a security message. The security 
message is a signed certificate that ensures the authenticity of the product and it must be 
accepted to start Admin Console. To suppress this message in the future and continue:

• Windows: enable Always trust content from this publisher, then click Run. 

• Mac OS: click Show Certificate and open Trust Settings. For When using this 
certificate, choose Always Trust, then click Trust. 

4. In the Create Shortcut dialog box, click Yes to create a shortcut that you can use to start 
Admin Console again later.

Windows: A shortcut is created on the desktop and in the Start menu under FileMaker Server. 
Depending on the version of Java installed, the shortcuts are created without prompting you. 

Mac OS: After you click Yes, specify a name and location in the Save dialog box where to save 
the shortcut, and then click Save.

The shortcut is helpful if you are managing several deployments of FileMaker Server from the 
same machine. The shortcut name starts with "FMS9-" and is followed by the FileMaker Server 
name that you specified in the Deployment assistant.

5. In the Admin Console Login dialog box, enter the user name and password for the Admin 
Console account.

Admin Console starts and displays the FileMaker Server Overview pane.

Notes
• Each shortcut starts Admin Console for a specific FileMaker Server deployment. If the IP 

address of the master machine changes, you must remove the shortcut and start Admin 
Console from the Admin Console Start Page again.

• Admin Console always displays in the language of the base OS installation on the master 
machine. The language setting of the machine running Admin Console has no effect.

• Internet Explorer: If the Start Page doesn’t appear, click the Information Bar at the top of the 
browser window and allow Internet Explorer to run the Java Web Start ActiveX Control add-
on.
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• If Admin Console doesn’t start, your browser might have downloaded the Java Web Start 
file but might not have started it. Check your web browser configuration to enable Java or 
automatically open downloaded files. You can also look for the 
admin_console_webstart.jnlp file where your browser saves downloaded files. Double-click 
this file to start Admin Console.

Related topic
Admin Console problems (page 158)
About FileMaker Server (page 8)
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Hosting databases
Before you can share FileMaker Pro database files, it’s important to prepare the files for hosting. 
The steps below provide an overview of the process. 

1. Edit the accounts and privileges sets that clients will use for shared access. See Editing 
accounts and privilege sets (page 32).

2. Upload the database files to FileMaker Server. See Uploading database files (page 33).

3. Verify the status of your files in the Admin Console Databases pane, and verify that the files 
are available to FileMaker clients. See Verifying databases are available to FileMaker Pro 
clients (page 42).

Notes
• You must convert databases created in FileMaker Pro 6 and earlier to FileMaker Pro 7 

format. FileMaker Pro versions 7, 8, 8.5, and 9 share the same file format. See 
FileMaker Pro Help for information on converting files.

• If a hosted database is designed to access data from an external SQL data source, you 
must set up the same ODBC data source name (DSN) on the FileMaker Server master 
machine as was set up on the machine running FileMaker Pro when the database was 
created. See Accessing external ODBC data sources (page 105). 

• If a hosted database uses server-side plug-ins or if you want to automatically update client-
side plug-ins, then you must place the plug-ins on FileMaker Server also. See Managing 
plug-ins (page 119).

• You cannot use peer-to-peer database hosting in FileMaker Pro on the same computer that 
FileMaker Server is running on.

• As FileMaker Server opens files that were not closed properly or have not been opened in a 
FileMaker 8 or later product, FileMaker Server performs a consistency check on each file 
and logs the result of the check in the event log.

• Up to 125 FileMaker Pro database files can be hosted on FileMaker Server and 
automatically opened when FileMaker Server starts. 

Related topics
Administering databases (page 93)
Closing hosted files (page 97)
Administering clients (page 88)
Viewing statistics (page 108)
Sending messages to FileMaker Pro clients (page 91)
Enabling auto-update for plug-ins (page 123)
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Editing accounts and privilege sets
In FileMaker Pro, edit the accounts and privilege sets that clients will use for access to each 
database. Choose File menu > Manage > Accounts & Privileges.

• Enable the appropriate extended privileges for particular privilege sets. Every account 
assigned to a privilege set with extended privileges will be able to access the database 
through the protocol associated with an extended privilege (for example, Access via 
FileMaker Network). For more information on accounts, privilege sets, and extended 
privileges, see the FILEMAKER PRO USER’S GUIDE.

• Enable the privilege to Disconnect user from FileMaker Server when idle to disconnect 
idle users from FileMaker Server for each account (or keep them connected), as necessary. 
For more information on setting the length of time a user must be idle before being 
disconnected, see FileMaker Pro client settings (page 63).

• If you plan to use external authentication, then you must edit each FileMaker Pro account 
that clients will use for shared access. In the Edit Account dialog box, for Account is 
authenticated via, choose External Server. For more information on enabling external 
authentication for FileMaker Pro accounts, see FileMaker Pro Help. For more information 
on setting up FileMaker Server to support external authentication, see Database Server 
security settings (page 70). 

Related topics
Uploading database files (page 33)
Verifying databases are available to FileMaker Pro clients (page 42)
Hosting databases (page 31)
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Uploading database files
Use the Upload Database assistant to transfer database files from your computer’s file system to 
FileMaker Server, and optionally have FileMaker Server open the files.

To upload database files to FileMaker Server: 
1. Ensure that the appropriate accounts and privilege sets are enabled.

See Editing accounts and privilege sets (page 32).

2. If the database files are open, you must close them before you can upload them.

3. Click the Upload Database icon in the toolbar to start the Upload Database assistant:

4. Select the FileMaker Server folder where you want to place the database files. Or click 
Create Subfolder to create a new subfolder.

FileMaker Server hosts database files in the default database folder and in an optional 
additional database folder that you can specify as described in Default folder settings (page 73). 
You can also create one level of subfolders in either folder. 

5. Click Add Database, select one or more databases to upload to FileMaker Server, then 
click Select.

Important Database files must be closed before you can upload them. If you have the 
databases open in FileMaker Pro, for each file choose File menu > Close.

See Selecting databases to upload (page 38) for more information.

6. Click Next.
7. Select Automatically open databases after upload if you want FileMaker Server to open 

the database immediately after the upload is complete.

See Specifying an upload option (page 39) for more information.

8. Click Next.
9. View the upload progress. When completed, click Next.

See Viewing the database upload status (page 40) for more information.

10. Confirm the status of the uploaded database files and click Finish.

See Reviewing the upload summary (page 41) for more information.

For detailed instructions, click the Help button in the Upload Database assistant.

Notes
• Alternate ways to start the Upload Database assistant are: 

• Click Server menu > Upload Database. 

• Choose Databases > Actions menu > Upload database and click Perform Action.

• Move your mouse to the Databases pane, then right-click your mouse, and select 
Upload database.
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• After uploading is complete, the Database Server checks whether a database has some 
form of sharing enabled. If no sharing is enabled, the Database Server automatically 
enables sharing via FileMaker Network (extended privilege fmapp) for the Full Access 
privilege set.

• For information on how to remove databases that are already hosted, see Removing hosted 
files (page 100).

• You can upload only files with a filename extension of .fp7 or of a registered runtime 
solution. For more information on registered runtime file types, see Database settings (page 
67).

• File names must be unique for the entire server regardless of the folder or subfolder.

• You can also manually copy database files to FileMaker Server. See Uploading database 
files manually (page 35).

• In Mac OS, the Upload Database assistant automatically sets the file owner to fmserver 
and the group to fmsadmin. Both the owner and group have read and write permission, but 
others have read-only permission. You must set ownership and permissions yourself if you 
upload databases manually. 

Related topics
Verifying databases are available to FileMaker Pro clients (page 42)
Hosting databases (page 31)
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Uploading database files manually
You can manually copy FileMaker Pro database files to FileMaker Server instead of using the 
Upload Database assistant. However, you must be sure to do the following:

• Place database files in the proper location.

• Change group ownership for files (Mac OS only). 

Important If you need to move, copy, or rename a hosted file, be sure to close it first.

Place database files in the proper location
Place the FileMaker Pro database files that you want FileMaker Server to open — or shortcuts 
(Windows) or aliases (Mac OS) to those files — in the following folders:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Data\Databases\ 

• Mac OS: /Library/FileMaker Server/Data/Databases/ 

Or you can place your files in an optionally specified additional database folder. See Default folder 
settings (page 73).

Change group ownership for files (Mac OS)
For files that will be shared from Mac OS, change the files to belong to the fmsadmin group. To edit 
databases shared from Mac OS, files should also have group read and write access enabled. 

For more information, see Users, groups, and permissions (Mac OS) (page 36).

Note Any Mac OS subfolders containing databases, backups, script files, or plug-ins must also be 
readable and executable by the fmsadmin group. Database and backup folders need to be writable 
by the fmsadmin group for backups and uploads. Some plug-ins or scripts that use preferences or 
folders of additional files may require write permission to those files or folders.

Related topics
Uploading database files (page 33)
Verifying databases are available to FileMaker Pro clients (page 42)
Enabling auto-update for plug-ins (page 123)
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Users, groups, and permissions (Mac OS)
Note The Upload Database assistant automatically sets the correct ownership and permissions in 
Mac OS. This section describes what you must do only if you upload databases manually.

During installation, the fmserver user and the fmsadmin group are created. The fmsadmin group 
must have read and write access to the FileMaker Pro databases that FileMaker Server hosts. You 
need to change the group permission to allow members of the fmsadmin group to edit the 
databases. 

By default, only the Mac OS X user account that installed FileMaker Server can:

• manually operate FileMaker Server from the command line 

• add files to or remove files from the FileMaker Server folder 

• access any of the FileMaker Pro databases stored within the FileMaker Server default 
database and backup folders 

Note Any user with the correct login, however, can access the FileMaker Server Admin Console 
application.

To allow other user accounts to work with FileMaker Server and database files, you can add them to 
the fmsadmin group using the NetInfo Manager or Terminal applications. This task must be 
performed by a user with administrative privileges. 

To add a user to the fmsadmin group using NetInfo Manager in Mac OS X 
10.4:
Note If you are using Mac OS X Server, you can use the Workgroup Manager administration tool to 
add users to the fmsadmin group. 

1. Start the NetInfo Manager application (/Applications/Utilities/NetInfo Manager/).

2. Select groups in the second column (labeled “/”).

3. Select fmsadmin in the groups column.

4. Select users in the Property pane, located in the bottom half of the NetInfo Manager 
window.

5. Click the lock and enter an administrative password.

6. Choose Directory menu > Insert Value.

7. Enter the login account name of the user you are adding.

8. Choose Domain menu > Save Changes.

9. In the Confirm Modification alert box, click Update this copy to confirm your changes.

10. Choose NetInfo Manager menu > Quit NetInfo Manager.
For more information on ways to add users to the fmsadmin group, see the FileMaker Knowledge 
Base. See Customer support and Knowledge Base (page 198).

Important The following procedures are recommended only for advanced users who are familiar 
with the Terminal application. You must be logged in with administrative privileges.
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To add a user to the fmsadmin group using the Terminal application:
1. Start the Terminal application (/Applications/Utilities/Terminal/).

2. Enter the following at the command line:

sudo dseditgroup -o edit -a username -t user fmsadmin

where username is the name of the existing user you wish to add to the fmsadmin group.

To change group permissions for database files hosted by FileMaker Server:
1. Place database files in the folder /FileMaker Server/Data/Databases/ or the optional 

additional database folder.

2. Start the Terminal application and use the cd command to set your path as needed.

3. Enter the following at the command line:

chmod g+rw <filename>.fp7 

where filename is the name of the database

To change the group of a file or folder to the fmsadmin group: 
1. Start the Terminal application and use the cd command to set your path as needed.

2. Enter the following at the command line:

chgrp fmsadmin <filepath> 

Example: chgrp fmsadmin dbfile.fp7

Related topics
Editing accounts and privilege sets (page 32)
Uploading database files (page 33)
Verifying databases are available to FileMaker Pro clients (page 42)
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Selecting databases to upload

Important Database files must be closed before you can upload them. Uploading a database file 
that is open in FileMaker Pro could result in data loss. If you have the databases open in 
FileMaker Pro, for each file choose File menu > Close.

1. Select the FileMaker Server folder where you want to place the database files. 

FileMaker Server hosts database files in the default database folder and in an additional 
database folder that you can specify as described in Default folder settings (page 73). 

Alternatively, you can create subfolders in the default and additional database folders. Select 
the default or additional database folder then click Create Subfolder to create a new subfolder. 
Enter the new folder Name in the dialog box and click OK.

2. Click Add Database to open the select databases dialog.

3. Select one or more database files on your local file system that you want to upload and click 
Select.

Tip Use Ctrl+click (Windows) or -click (Mac OS) to select multiple files.

The Upload Database assistant lists the databases to be uploaded in the selected folder in bold 
type.

4. To remove a database from the list, select the database and click Remove. 

You can remove from the list only databases that have not been uploaded yet. Removing a 
database from the list does not delete or otherwise change the database file. You can also 
remove a subfolder in the same way.

5. Click Next to specify options to open the database.

Click Cancel to exit the Upload Database assistant.

Notes
• You can upload only files with a filename extension of .fp7 or with a filename extension of a 

registered runtime solution. You can’t upload a folder or an application package (Mac OS), 
but you can select multiple files that are in the same folder and upload them at one time.

• You cannot overwrite a hosted file using the Upload Database assistant. To replace a 
hosted file with another file that has the same filename, you must close and remove the 
hosted file and then upload the new file. 

• For information on how to remove databases that are already hosted, see Removing hosted 
files (page 100).

• Database files should be writable in Windows or Mac OS (and unlocked in Mac OS) before 
you upload them. You will see a warning message when you upload a read-only or locked 
file. See Windows Help or Mac OS Help for how to make read-only files writable and how to 
unlock files. 

Related topic
Uploading database files (page 33)
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Specifying an upload option
1. You can optionally select Automatically open the database after upload.

Select this option to open all files after the upload is complete. If you don’t select this option, the 
uploaded databases remain closed. To open the files later, see Opening hosted files (page 96).

2. Click Next to begin the database upload.

Click Back to return to the previous pane or Cancel to exit the Database Upload assistant.

Note The Upload Database assistant checks whether a database has some form of sharing 
enabled. If no sharing is enabled, the Database Server automatically enables sharing via FileMaker 
Network (extended privilege fmapp) for the Full Access privilege set. 

Related topic
Uploading database files (page 33)
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Viewing the database upload status
During the upload, you can view the progress. When the upload is complete, you can:

• Click Next when the database upload successfully completes.

• If the upload fails, click Back to return to a previous step to correct the problem.

• Click Cancel to exit the Upload Database assistant.

Note If you want to stop the upload, click Cancel next to the progress meter. The upload stops and 
FileMaker Server discards all files uploaded in this operation.

Related topic
Uploading database files (page 33)
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Reviewing the upload summary
Database files that have uploaded successfully are listed OK in the Status column. If there is an 
error, the Message column describes the problem uploading the associated database.

• Click Finish to exit the Upload Database assistant.

Click Back to return to the previous pane.

Note An upload can fail because the database is open. If you have the database open in 
FileMaker Pro on your computer, choose File menu > Close and try to upload the database again.

Related topic
Uploading database files (page 33)
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Verifying databases are available to FileMaker Pro 
clients

When FileMaker Server starts, it automatically opens and hosts all FileMaker Pro databases located 
in the default database folder and in an additional database folder, if specified. In the Databases 
pane, the databases are listed as Normal in the Status column.

To verify that databases were opened when FileMaker Server started and that databases are 
available to FileMaker Pro clients, check the following:

• the status of files listed in the Databases pane is Normal 
• the Pro column contains a check mark (the fmapp extended privilege is set for at least one 

account)

• you can open remote files in FileMaker Pro

• review the Event.log (or the Windows Event Viewer) for FileMaker Server messages about 
opening the file

To verify the status of files listed in the Databases pane:
1. Start FileMaker Server Admin Console. See Starting Admin Console (page 29).

2. Click Databases.

If you manually added files to the default database folder after startup, those files are listed as 
Closed and you must open them manually.

3. If the status of a database is Closed, select the database. For Actions, select Open.

4. Click Perform Action.

It may take several minutes to open a large file. As FileMaker Server opens files that were not 
closed properly or have not been opened in a FileMaker 8 or later product, FileMaker Server 
performs a consistency check on each file and logs the result of the check in the event log.

Tip If a folder containing databases is closed, click the handle next to the folder to open it. If the 
databases are still not visible, it may be necessary to refresh the Databases pane. Select 
Databases, then click Refresh.

5. If the Pro column does not contain a check mark, then no user can open the hosted 
database with FileMaker Pro. You must close the file on the server and open it with 
FileMaker Pro and enable the fmapp extended privilege for the desired accounts.

To verify that a database is usable from a FileMaker Pro client machine:
1. Start FileMaker Pro or FileMaker Pro Advanced.

2. Choose File menu > Open Remote. 

3. Select Local Hosts from the View menu, and choose your server from the list. The name of 
the database should appear in the column on the right.

If the database is not listed, review the steps above and in Hosting databases (page 31).

Related topics
Editing accounts and privilege sets (page 32)
Uploading database files (page 33)
Sharing FileMaker databases via ODBC and JDBC (page 103)
Hosting XSLT websites (page 47)
Hosting PHP websites (page 45)
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Closing hosted files (page 97)
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Hosting websites
With FileMaker Server you can publish your FileMaker databases on the web in these ways:

To Use See 

Access FileMaker data using the 
FileMaker API for PHP in PHP web 
applications 

Custom Web Publishing 
with PHP 

Hosting PHP websites 
(page 45)

Transform, filter, or format XML data in a 
FileMaker database using XSLT 
stylesheets for use in a web browser or in 
other applications 

Custom Web Publishing 
with XSLT

Hosting XSLT websites 
(page 47)

Send HTTP requests along with XML 
query commands and parameters and 
retrieve FileMaker data as an XML 
document 

Custom Web Publishing 
with XML

Hosting databases for 
XML queries (page 49)

Quickly and easily publish FileMaker 
databases on the web that look and work 
much like they do in FileMaker Pro 

Instant Web Publishing 

(requires a FileMaker 
Server Advanced license) 

Using Instant Web 
Publishing (page 50)
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Hosting PHP websites
Custom Web Publishing with PHP lets you use the PHP scripting language to integrate data from 
FileMaker databases with your customized webpage layouts. In your webpages, you call the 
FileMaker API for PHP, which is a PHP class created by FileMaker that accesses databases hosted 
by FileMaker Server. This PHP class connects to the Web Publishing Engine and makes data 
available to your web server’s PHP engine. 

For more information on developing a PHP website and preparing a database, see FILEMAKER 
SERVER CUSTOM WEB PUBLISHING WITH PHP on the Start Page.

To host a website that uses Custom Web Publishing with PHP:
1. In FileMaker Pro, open the database and edit the privilege set for the account that will 

access the database. Enable the extended privilege Access via PHP Web Publishing - 
FMS only.

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must use this privilege set with the extended privilege Access via PHP Web 
Publishing - FMS only enabled.

2. In FileMaker Server Admin Console, use the Deployment assistant to enable Custom Web 
Publishing with PHP and choose whether to install the FileMaker supported PHP engine, if 
you haven’t already. 

Click Edit Server Deployment on the FileMaker Server Overview pane. In the Deployment 
assistant, confirm your settings and click Next until you reach the Enable Web Publishing 
Technologies step. For more information, see Enabling technologies for web publishing (page 
16).

3. In Admin Console, configure the settings on the Web Publishing > PHP tab.

For more information on configuring Custom Web Publishing with PHP, see PHP web publishing 
settings (page 80).

4. Verify that Custom Web Publishing with PHP is working in your FileMaker Server 
deployment. See Testing FileMaker Server (page 24) for instructions.

5. Upload the database file to FileMaker Server with the Upload Database assistant. See 
Hosting databases (page 31).

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be on the same computer.

6. Copy your PHP files to the root folder of the web server software on the machine in your 
FileMaker Server deployment that is running the web server:

• For IIS (Windows): [drive]:\inetpub\wwwroot

• For Apache (Mac OS): /Library/WebServer/Documents

Note You can also place the PHP files in an optional folder or folder hierarchy in the web server 
root folder.

7. Copy or move any referenced container objects to the web server machine.

If a database container field stores a file reference instead of an actual file, then the referenced 
container object will be stored in the FileMaker Pro Web folder when the record is created or 
edited. To host your site on FileMaker Server, you must then copy or move the referenced 
containers to a folder with the same relative location in the root folder of the web server 
software.
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Note If the database file is properly hosted and accessible on FileMaker Server, and the 
container fields store the actual files in the FileMaker database, then you need not relocate the 
container field contents.

8. To access your PHP website, use the following URL syntax:

<scheme>://<host>[:<port>]/<path>/<filename>

where:

• <scheme> is the HTTP or HTTPS protocol.

• <host> is the IP address or domain name of the host computer where the web server is 
installed.

• <port> is optional and specifies the port that the web server is listening on. If no port is 
specified, then the default port for the protocol is assumed (port 80 for HTTP, or port 
443 for HTTPS).

• <path> is optional and specifies the folder inside the web server root folder where the 
PHP file is located.

• <filename> is the filename of a page in your website.

For example:

http://192.168.123.101/my_site/home.php

Related topics
PHP web publishing settings (page 80)
Hosting websites (page 44)
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Hosting XSLT websites
FileMaker Custom Web Publishing with XSLT provides the ability to transform, filter, or format XML 
data for use in a web browser or in other applications. You can use an XSLT stylesheet to transform 
the data between a FileMaker XML grammar and another XML grammar for use in another 
application or database. 

For more information on developing an XSLT website and preparing a database, see FILEMAKER 
SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT on the Start Page.

To host a website that uses Custom Web Publishing with XSLT:
1. In FileMaker Pro, open the database and edit the privilege set for the account that will 

access the database. Enable the extended privilege Access via XSLT Web Publishing - 
FMS only.

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must use this privilege set with the extended privilege Access via XSLT Web 
Publishing - FMS only enabled.

2. In FileMaker Server Admin Console, enable and configure XSLT Web Publishing on the 
Web Publishing > XSLT tab.

3. Verify that Custom Web Publishing with XSLT is working in your FileMaker Server 
deployment. See Testing FileMaker Server (page 24) for instructions.

4. Upload the database file to FileMaker Server with the Upload Database assistant. See 
Hosting databases (page 31).

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be on the same computer.

5. Copy the XSLT stylesheets to the following directory on the machine that is running the Web 
Publishing Engine:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Web Publishing\xslt-
template-files

• Mac OS: /Library/FileMaker Server/Web Publishing/xslt-template-files

Note You can also place the stylesheets in an optional folder or folder hierarchy in the xslt-
template-files folder.

6. Copy any referenced container objects to the web server machine.

If a database container field stores a file reference instead of an actual file, then the referenced 
container object will be stored in the FileMaker Pro Web folder when the record is created or 
edited. To stage your site, you must copy or move the referenced containers to a folder with the 
same relative location in the root folder of the web server software.

Note If the database file is properly hosted and accessible on FileMaker Server, and the 
container fields store the actual files in the FileMaker database, then you don’t need to relocate 
the container field contents.

7. Use the following URL syntax to request and process an XSLT stylesheet, and generate the 
resulting HTML:

<scheme>://<host>[:<port>]/fmi/xsl/<path>/<stylesheet>.xsl[?<query 
string>]

where:

• <scheme> is the HTTP or HTTPS protocol.
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• <host> is the IP address or domain name of the host computer where the web server is 
installed.

• <port> is optional and specifies the port that the web server is listening on. If no port is 
specified, then the default port for the protocol is assumed (port 80 for HTTP, or port 
443 for HTTPS).

• <path> is optional and specifies the folder inside the xslt-template-files folder where the 
XSLT stylesheet is located.

• <stylesheet> is the name of the stylesheet with an .xsl extension.

• <query string> can be a combination of one query command and one or more query 
parameters for Custom Web Publishing with XSLT.

Related topics
XSLT web publishing settings (page 82)
Hosting websites (page 44)
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Hosting databases for XML queries
FileMaker Custom Web Publishing with XML enables you to send query requests to FileMaker 
Server, and display, modify, or manipulate the resulting data as needed. Using an HTTP request 
along with the appropriate query commands and parameters, you can retrieve FileMaker data as an 
XML document. 

For more information on preparing a database and accessing XML data, see CUSTOM WEB 
PUBLISHING WITH XML AND XSLT on the Start Page.

To host a database that uses Custom Web Publishing with XML:
1. In FileMaker Pro, open the database and edit the privilege set for the account that will 

access the database. Enable the extended privilege Access via XML Web Publishing - 
FMS only.

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must use this privilege set with the extended privilege Access via XML Web 
Publishing - FMS only enabled.

2. In FileMaker Server Admin Console, select Enable XML publishing on the Web 
Publishing > XML tab.

3. Prepare databases for Custom Web Publishing. For more information, see FILEMAKER 
SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT.

4. Upload the database file to FileMaker Server with the Upload Database assistant. See 
Hosting databases (page 31).

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be on the same computer.

5. Send an HTTP or HTTPS request in the form of a URL that specifies the FileMaker XML 
grammar, one query command, and one or more FileMaker query parameters to the Web 
Publishing Engine through an HTML form, an HREF link, or a script in your program or 
webpage. You can also type the URL in a web browser.

For more information on specifying a URL for XML data, see FILEMAKER SERVER CUSTOM WEB 
PUBLISHING WITH XML AND XSLT. 

Related topics
XML web publishing settings (page 86)
Hosting websites (page 44)
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Using Instant Web Publishing
Instant Web Publishing allows you to quickly and easily publish your database on the web. You don’t 
need to modify your database files or install additional software — anyone with compatible web 
browser software and access to the internet or an intranet can connect to your database to view, 
edit, sort, or search records, if you give them access privileges. 

Note Instant Web Publishing is available only if you have a FileMaker Server Advanced license.

For more information on developing a FileMaker Pro database that works well with Instant Web 
Publishing, see FILEMAKER INSTANT WEB PUBLISHING GUIDE on the Start Page.

To host a website using Instant Web Publishing:
1. In FileMaker Pro, open the database and edit the privilege set for the account that will 

access the database. Enable the extended privilege Access via Instant Web Publishing.

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must use this privilege set with the extended privilege Access via Instant Web 
Publishing enabled.

2. Upload the database file to FileMaker Server with the Upload Database assistant. See 
Hosting databases (page 31).

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be on the same computer.

3. In FileMaker Server Admin Console, enable and configure Instant Web Publishing on the 
Web Publishing > Instant Web Publishing tab.

4. (Optional) You can replace the default Database Homepage that web users see when they 
log out of a session or the session times out. 

Place your custom home page named iwp_home.html in the following location on the machine 
that is running the Web Publishing Engine:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Web Publishing\IWP

• Mac OS: /Library/FileMaker Server/Web Publishing/IWP 

5. If you’re using static HTML pages, images, or other externally referenced files with your 
FileMaker database, you need to move those files to the root folder of the web server 
software. Make sure the relative path is preserved.

• For IIS (Windows), move the files to: [drive]:\inetpub\wwwroot

• For Apache (Mac OS), move the files to: /Library/WebServer/Documents

6. Test that your database is being published with Instant Web Publishing. Enter the following 
URL into a web browser:

http://<address>/fmi/iwp

where <address> is either the IP address or host name of the web server. 

Related topics
Instant Web Publishing settings (page 87)
Hosting websites (page 44)
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Starting and stopping FileMaker Server
Admin Console allows you to start and stop the Database Server and the Web Publishing Engine 
individually without restarting the machine. 

To start or stop the Database Server:
In Admin Console, click one of the toolbar icons: 

To start or stop the Web Publishing Engine:
In Admin Console, click one of the toolbar icons: 

Notes
• If FileMaker Pro is already running while the Database Server is starting up on the same 

machine, the Database Server will start up but then abruptly stop. Stop FileMaker Pro, then 
start the Database Server. If this problem persists, restart your computer, then start the 
Database Server before starting FileMaker Pro.

• If you have large files or files with many connected clients, the process of stopping the 
Database Server may take several minutes. If you encounter problems, disconnect clients. 
For more information, see Disconnecting clients (page 92). Also try closing hosted files. For 
more information see Closing hosted files (page 97).

• When you stop the Database Server, Admin Console functionality is limited to FileMaker 
Server Overview. To use other functionality, you must start the Database Server again.

• When you stop the Web Publishing Engine, you must start it again before you can configure 
web publishing settings.

• If you need to start or stop the FileMaker Server service or daemons manually, see Starting 
or stopping the FileMaker Server service (Windows) (page 52) or Starting or stopping 
FileMaker Server daemons (Mac OS) (page 53).

Related topic
Auto Start settings (page 61)

Start Database Server Stop Database Server

Start Web Publishing Engine Stop Web Publishing Engine
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Starting or stopping the FileMaker Server service 
(Windows)

In some cases, you may need to start or stop all components of FileMaker Server on a machine. For 
example, after you restrict access to Admin Console (General Settings > Admin Console tab), you 
must restart all FileMaker Server components. You can restart all FileMaker Server components 
either by restarting the machine or by restarting the FileMaker Server service.

In Windows, FileMaker Server runs as a service named “FileMaker Server” that manages all 
FileMaker Server components on the machine. In a multiple-machine deployment, the FileMaker 
Server service runs on each machine.

Typically, the FileMaker Server service is automatically started when the machine is started. If you 
choose not to automatically start the FileMaker Server service during Windows startup or if you 
stopped the FileMaker Server service, you can start it again manually.

To start or stop the FileMaker Server service:
You must be logged in with administrator privileges on the machine where FileMaker Server is 
running.

1. Click Start button > Control Panel > Administrative Tools.

2. Double-click Services. 

3. In the Services window, select FileMaker Server in the Name column.

4. Choose Action menu > Start to start the service or Action menu > Stop to stop the service.

To start or stop the FileMaker Server service from the command prompt:
• Open the Command Prompt window.

Related topic
Starting and stopping FileMaker Server (page 51)

To Enter

Start FileMaker Server net start "FileMaker Server" 
Stop FileMaker Server net stop "FileMaker Server" 
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Starting or stopping FileMaker Server daemons 
(Mac OS)

In some cases, you may need to start or stop all components of FileMaker Server on a machine. For 
example, after you restrict access to Admin Console (General Settings > Admin Console tab), you 
must restart all FileMaker Server components. You can restart all FileMaker Server components 
either by restarting the machine or by restarting the FileMaker Server daemons.

In Mac OS, FileMaker Server runs as several background processes, or daemons. The daemons 
start when FileMaker Server is installed. In a multiple-machine deployment, FileMaker Server 
daemons run on each machine.

Typically, the FileMaker Server daemons are automatically started when the machine is started. If 
you choose not to automatically start the FileMaker Server daemons during Mac OS startup or if you 
stopped the daemons, you can start them again manually.

To start or stop FileMaker Server manually:
You must be logged in to the machine where FileMaker Server is running. 

• Open the Terminal application and enter the start or stop command:

Note The sudo command requires you to authenticate. 

Related topic
Starting and stopping FileMaker Server (page 51)

To Enter

Start FileMaker Server 
daemons

sudo launchctl start com.filemaker.fms 

Stop FileMaker Server 
daemons

sudo launchctl stop com.filemaker.fms 
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Configuring general settings
Choose General Settings and select one of the following tabs to specify FileMaker Server settings:

After you change a setting in a tab, you can click Save to save your changes immediately. Or, if you 
want to make changes in other tabs in this pane, you can click another tab, make changes, then 
click Save. At any time, you can click Revert to undo all changes you’ve made in these tabs since 
the last save.

Related topics
Configuring Database Server settings (page 62)
Configuring web publishing settings (page 78)
Enabling sharing via ODBC and JDBC (page 104)

Choose To

Server Information Specify the FileMaker Server name and description, specify optional 
server and administrator contact information, and update the FileMaker 
Server license. See Server information settings (page 55).

Email Notifications Specify the users that will receive emails whenever errors or warnings 
occur in FileMaker Server. Sending email notification requires the email 
server’s SMTP information. See Email notification settings (page 57).

Admin Console Restrict access to Admin Console, change the Admin Console user 
name and password, allow members of the fmsadmin group to log in, 
and enable checking for FileMaker Server updates. See Admin Console 
settings (page 59).

Auto Start Start the Database Server or the Web Publishing Engine when the 
computer starts. See Auto Start settings (page 61).
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Server information settings
The General Settings > Server Information tab specifies the following configuration settings:

• Specify the host name that is displayed in the FileMaker Admin Console and FileMaker Pro, 
and the server description that is displayed on the Admin Console Start Page.

• Enter FileMaker Server contact information that is published in the directory service and the 
Start Page. 

• View the current FileMaker Server license information and update the license.

To specify server information settings:
1. Choose General Settings > Server Information tab.

To Do this

Specify the host name that is 
displayed in FileMaker Server 
Admin Console and 
FileMaker Pro

Enter the Server Name.

Tip Use names consisting of standard ASCII characters 
without spaces.

The server name appears in these locations:

• on the Start Page

• in FileMaker Pro, when users invoke the Open 
Remote File dialog box

Specify a server description For Server Description, enter a description of the 
FileMaker Server computer. This description appears on 
the Start Page.

Specify the FileMaker Server 
owner, email address, location, 
and phone number

For Administrator Contact Information, enter the 
contact information for the person who administers this 
FileMaker Server deployment. 

This contact information appears in these locations:

• on the Start Page

• on a directory service

For information on publishing the administrator contact 
information to a directory service, see FileMaker Pro client 
settings (page 63).
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2. Click Save.

Related topics
Uploading database files (page 33)
Database Server security settings (page 70)
Admin Console settings (page 59)
Configuring general settings (page 54)

View or update your FileMaker 
Server license information

For License Information, click Update License Key.

1. Enter the User Name and Organization and 
your new License Key.

2. Click Update, then click Close.

Your FileMaker Server license information is listed on the 
tab. See About the license key (page 170). You can also 
update the license key if you are using a trial version or 
you want to upgrade to FileMaker Server Advanced.

Upgrading to FileMaker Server Advanced enables Instant 
Web Publishing and sharing data as an SQL data source 
via ODBC/JDBC. Because all the necessary files are 
already installed, no additional installation is necessary to 
upgrade.

To Do this



Configuring general settings Email notification settings

FILEMAKER SERVER 9 HELP 57

Email notification settings
You can configure FileMaker Server to send an email notification when errors or warnings are 
detected or to receive email notification of scheduled tasks. You configure for email notification by 
entering the SMTP server configuration settings and then sending a test message to test the 
connection. Then, enter the email addresses of the users who will receive notification of errors or 
warnings.

To specify email notification settings:
1. Choose General Settings > Email Notifications tab.

To Do this

Enter the SMTP 
configuration information 
for the email server

For SMTP Information:

• From Address: Enter the email address of the sender.

• Reply-to Address: Enter the email address that users can 
reply to after receiving an error or warning email from 
FileMaker Server. For example, the email address of the 
FileMaker Server administrator.

• SMTP Server Address: Enter an IP address (example: 
127.1.1.1) or a host name (example: 
postoffice.emailserver.com).

• Port: The port number required to connect to the SMTP 
server. The default port number is 25.

• Select SMTP Authentication if required and choose the 
authentication type:

• Plain Text: Plain text authentication using LOGIN 
mechanism

• CRAM-MD5: Challenge-Response Authentication 
Mechanism-Message Digest 5 authentication to 
encrypt the password for the SMTP mail server

Note Contact your email administrator to find out whether 
authentication is required and what type is used.

• User: Enter the user name required to log in to the 
SMTP server.

• Password: Enter the user’s password.
Test your SMTP settings Click Test SMTP Settings. Enter an email address in the dialog 

box and click OK to send a test message.

If the test message fails, check your SMTP settings or the email 
address.
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2. Click Save.

Note Each schedule can be enabled to send email notification when the schedule completes. Each 
schedule can have its own set of email addresses, but all email notifications use the same SMTP 
settings. For more information about enabling email notifications in scheduled tasks, see Enabling 
email notifications in schedules (page 147).

Related topics
FileMaker Pro client settings (page 63)
Creating schedules (page 134)
Configuring general settings (page 54)

Enable email 
notifications

For Notification Settings: 

• Select Enable email notifications.

Send Email Notifications to: Enter the email addresses for 
users who will be notified.

Specify email addresses separated by commas.

• Severity Level: Specify whether emails will be sent only 
when FileMaker Server detects errors or when FileMaker 
Server detects warnings or errors.

To Do this



Configuring general settings Admin Console settings

FILEMAKER SERVER 9 HELP 59

Admin Console settings
The General Settings > Admin Console tab specifies the following configuration settings:

• Restrict running Admin Console to a specific system or a range of systems identified by IP 
addresses. 

Using FileMaker Server Admin Console, you can remotely control, or administer, FileMaker 
Server from a different computer than the one on which FileMaker Server is installed and 
hosting databases. 

You can restrict access to Admin Console to the system currently running the console or to 
systems with specific IP addresses.

• Change the FileMaker Server administrator’s user name or password, or allow members of 
the fmsadmin group to log in. 

• Check for FileMaker Server updates. 

To specify Admin Console settings:
1. Choose General Settings > Admin Console tab.

To Do this

Restrict Admin Console to 
specific IP addresses

For Restrict Access: 

• Select Enable access restrictions.

• Enter one or more IP addresses, separated by 
commas. 

Note Any changes to this setting require restarting 
FileMaker Server on the master machine. See Starting or 
stopping the FileMaker Server service (Windows) (page 52) 
or Starting or stopping FileMaker Server daemons (Mac OS) 
(page 53).

Important You can run FileMaker Server Admin Console on 
the master machine even if you enable access restrictions.

Change the Admin Console 
account user name and 
password 

For Authentication:

1. Click Change User Name/Password to open 
the dialog box.

2. Enter a New User Name.

3. Enter the Current Password.

4. Enter a New Password, then enter it again in 
Confirm Password.

5. Click OK.

This change is effective immediately.
Allow members of the 
fmsadmin group to log in

For Authentication, select Allow members of the 
"fmsadmin" group to login.

You can allow Admin Console users to log in with accounts 
that are members of the fmsadmin group. This group is 
defined on the master machine running FileMaker Server.
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2. Click Save.

Related topic
Database Server security settings (page 70)
Configuring general settings (page 54)

Check for FileMaker Server 
updates

For Check for Updates, select Enable FileMaker Server to 
check for updates.

You can check for updates by selecting Help menu > Check 
for Update. See Checking for updates (page 169).

To Do this
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Auto Start settings
You can automatically start the Database Server when the system restarts. You can also 
automatically start the Web Publishing Engine when the system restarts.

To specify Auto Start settings:
1. Choose General Settings > Auto Start tab.

2. Choose the Auto Start options:

3. Click Save.

Notes 
• You can start or stop the Database Server or the Web Publishing Engine without restarting 

the machine. See Starting and stopping FileMaker Server (page 51).

• You can manually start the Database Server and Web Publishing Engine if you don't enable 
the Auto Start options. When the machine restarts, you can start Admin Console and start 
the Database Server, the Web Publishing Engine, or both. 

Related topics
Uploading database files (page 33)
Database Server security settings (page 70)
General web publishing settings (page 79)
Configuring general settings (page 54)

To Do this

Automatically start the Database 
Server component on the master 
machine when the computer 
restarts

Select Automatically start Database Server.

Automatically start the Web 
Publishing Engine when the 
computer restarts 

Select Automatically start Web Publishing Engine.

Note This option is available only when Automatically 
start Database Server is selected.
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Configuring Database Server settings
Choose Database Server and select one of the following tabs to specify FileMaker Server settings:

After you change a setting in a tab, you can click Save to save your changes immediately. Or, if you 
want to make changes in other tabs in this pane, you can click another tab, make changes, then 
click Save when you are done. At any time, you can click Revert to undo all changes you’ve made 
in these tabs since the last save.

Related topics
Configuring general settings (page 54)
Configuring web publishing settings (page 78)
Enabling sharing via ODBC and JDBC (page 104)

Choose To

FileMaker Pro Clients Specify the maximum number of simultaneous FileMaker Pro client 
connections and the maximum idle time before disconnecting clients. 
You can also configure the FileMaker Server to work with a directory 
service. See FileMaker Pro client settings (page 63).

Databases Specify the maximum number of database files that FileMaker Server 
can host, specify database cache values, and allow FileMaker Server to 
automatically host runtime solutions. See Database settings (page 67).

Security Select how FileMaker Pro clients are authenticated when connecting to 
the FileMaker Server and whether to display only databases that each 
user is allowed to access. You can also choose to encrypt client 
connections using Secure Sockets Layer (SSL). See Database Server 
security settings (page 70).

Default Folders Specify an additional database folder to host database files and a 
backup folder. See Default folder settings (page 73).

Logging Select whether to log client access in the Access.log or usage statistics 
in the Stats.log. You can also specify the log size and collection interval. 
See Logging and statistics settings (page 76).

Server Plug-ins Select whether to use plug-ins with hosted databases and choose 
which plug-ins to use. See Server plug-in settings (page 77).
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FileMaker Pro client settings
The Database Server > FileMaker Pro Clients tab specifies the following configuration settings:

• Specify the maximum number of simultaneous FileMaker Pro client connections to 
FileMaker Server. 

• Enable FileMaker Pro users to download updated plug-ins used by hosted databases.

• Specify the maximum idle time before disconnecting FileMaker Pro clients. 

• Configure FileMaker Server to work with a directory service. 

To specify FileMaker Pro client settings:
1. Choose Database Server > FileMaker Pro Clients tab.

To Do this

Set the number of 
simultaneous FileMaker Pro 
clients that can access 
databases hosted by 
FileMaker Server 

For Maximum number of FileMaker Pro connections, 
enter a number.

The memory requirements of FileMaker Server are directly 
related to the number of connected clients, open files, and 
the size of database cache. If your server has large numbers 
of clients or files, you can increase the amount of RAM 
reserved for the database cache to improve performance. 
For more information, see Database settings (page 67).

Allow FileMaker Pro clients to 
download updated plug-ins 
used by databases hosted by 
FileMaker Server

Select Allow FileMaker Pro clients to download updates 
automatically.

Set the maximum idle time for 
FileMaker clients

Select Set maximum idle time allowed for FileMaker 
clients and enter the time.

You can set the maximum time a FileMaker Pro client can be 
idle when connected to a database hosted by FileMaker 
Server. FileMaker Server only notifies FileMaker Pro of this 
setting. In FileMaker Pro, you should edit privilege sets to 
enable the option Disconnect user from FileMaker Server 
when idle. Because you can set this option on a privilege set 
basis, certain users will be disconnected while other users 
always maintain their connections.

Note Because clients who are disconnected have to reopen 
the files, make sure the idle time is long enough to avoid 
frequent disconnections.
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2. Click Save.

Related topics
Administering clients (page 88)
Database Server security settings (page 70)
Configuring Database Server settings (page 62)

Configure FileMaker Server to 
work with a directory service

Use the Directory Service assistant:

1. Click Configure Directory Service to open the 
Directory Service assistant.

2. Enter the directory service settings. See 
Specifying directory service settings (page 65). 
Click Next.

3. Select the information you want to publish. See 
Publishing directory server settings (page 66). 

4. Click Finish to update the directory service 
information in this tab. (Clicking Save in this tab 
is not required.)

If your organization uses a Lightweight Directory Access 
Protocol (LDAP) compliant directory service, such as 
Windows Active Directory, Netscape Directory, OpenLDAP, 
or Open Directory (Mac OS), you can centrally manage your 
hosted databases by registering FileMaker Server with your 
directory service.

When FileMaker Server is registered with a directory service, 
host names and IP addresses are published to the directory 
service so that FileMaker Pro clients can use the directory 
service to find the server in a network. The FileMaker Server 
administrator's contact information can also be published 
(see Server information settings (page 55)). This is useful if 
the directory service administrator needs to contact you (for 
example, if hosted databases are unavailable for client 
access).

Note If you do not know what your directory service settings 
are, contact your network administrator.

To Do this
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Specifying directory service settings
In this Directory Service assistant step, specify the server settings.

1. For Server Information, enter the following information:

• Directory Server (host name or IP address).

• Port number for the LDAP connection.

• Directory Entry Point. The distinguished name that specifies the location of FileMaker 
Server in the directory service. For example: 

ou=FileMaker,dc=mydomain,dc=filemaker,dc=com 

Spaces after commas are optional. 

2. For Login Information, choose the authentication method for the directory service:

• If the directory services requires a login, select My directory service requires me to 
log on, and enter the User Name and Password.

• If the user name and password you specified are defined in a Windows domain, enable 
Use Windows authentication to access Windows Active Directory.

3. Click Test Directory Service Settings to verify that FileMaker Server can communicate 
with the directory service.

4. Click Next.
Click Cancel to exit the Directory Service assistant.

For more information, see FileMaker Pro client settings (page 63). 
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Publishing directory server settings
In this Directory Service assistant step, choose the information you want to publish.

1. Select Publish FileMaker Server to publish the FileMaker Server name, host name, and IP 
address to the directory service.

2. Select Publish administrator contact information to publish the administrator’s contact 
information specified in the General Settings > Server Information tab.

3. Click Finish to update the directory service information in the Database Server > 
FileMaker Pro Clients tab. (Clicking Save in this tab is not required.)

Click Back to return to the previous step or Cancel to exit the Directory Service assistant.

For more information, see FileMaker Pro client settings (page 63). 
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Database settings
The Database Server > Databases tab specifies the following configuration settings:

• Specify the maximum number of files that FileMaker Server can host. 

• Select whether FileMaker Server automatically hosts registered runtime solution.

• Specify the amount of database cache memory.

• Specify how often to flush the database cache. 

To specify database settings:
1. Choose Database Server > Databases tab.

To Do this

Specify the maximum 
number of database 
files FileMaker Server 
can open at one time

For Maximum number of files to host, enter a number.

Note The memory requirements of FileMaker Server are directly 
related to the number of clients and open files. If you specify large 
values, you should also increase the amount of RAM reserved for 
the database cache.

Automatically host 
runtime solution files 

In Registered Runtime Solutions, select Allow FileMaker Server 
to automatically host registered runtime solutions.

• To register a file type for a runtime solution, click Register 
and type the filename extension. Click OK.

• To remove a registered file type, select the file type in the 
File Type list and click Remove. Click Yes to confirm.

If you host runtime database solutions created by FileMaker Pro 
Advanced, you can enable FileMaker Server to automatically open 
runtime solutions when FileMaker Server starts. Runtime solutions 
must be stored in one of the designated locations. See Default 
folder settings (page 73).

If the runtime solutions do not have .fp7 filename extensions, you 
must register their filename extensions in FileMaker Server.

Specify the RAM 
reserved for database 
cache

For RAM reserved for database cache, select the amount of 
memory.

The maximum setting is dynamically determined based on physical 
RAM. The maximum setting is (Physical RAM – 128 MB) / 4, with a 
fixed minimum of 64 MB and a fixed maximum of 800 MB, and 
Physical RAM is the amount of RAM available in the master 
machine of your FileMaker Server deployment. 

Increasing the RAM reserved for the database cache can speed up 
overall performance for a correctly designed database, especially if 
your server hosts large files or a large number of clients or files.
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2. Click Save.

Related topics
Uploading database files (page 33)
Administering databases (page 93)
Configuring Database Server settings (page 62)

Specify the cache flush 
distribution interval

For Cache flush distribution interval, enter the time between 
cache flushes in hours and minutes.

To enhance performance, FileMaker Server saves changes to a 
RAM-based cache. Every second, a portion of the cache is saved 
(flushed) to disk.

By default FileMaker Server attempts to scan the entire cache every 
minute. You can increase the interval so it takes longer for the entire 
cache to be flushed but less of the cache is scanned every second. 
For more information, see Cache flushing operation (page 69).

To Do this
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Cache flushing operation
In FileMaker Server, the cache is constantly being flushed. The cache flushing routine scans the 
cache, looking for pages that have changed. FileMaker Server inspects up to 1/60th of the cache 
and writes any changed pages it discovers to the disk. The process repeats continuously, writing 1/
60 of the cache to disk every second, even during scheduled backups.

For example, in a 64 MB cache FileMaker Server will inspect up to 1/60th of the cache, or a little 
more than a megabyte, and flush all of the changed records it finds. It will then wait a second and 
begin again, inspecting up to 1/60th of the cache, looking for changed records. This method of 
flushing the cache distributes writing to the hard disk over the span of a minute. 

By default, the cache flush mechanism will attempt to scan the entire cache in a minute. In most 
cases this means all cached changes on the server will be no more than one minute old, although 
database size and hard disk speed can affect these results.

To change this behavior and spread the cache flushing over a longer period of time, increase the 
value of the Cache flush distribution interval (hh:mm). Unsaved changes in FileMaker Server will 
be no older than the interval you specify. FileMaker Server reduces the amount of data it inspects 
every second, but never less than 128 KB per second. 

Before increasing the cache flushing interval, the administrator should carefully consider the risk of 
data loss in the event of a computer failure. Locations that require maximum performance and are 
less concerned about the potential for lost data can use a longer cache flush distribution interval, 
while locations that want maximum data integrity should use a smaller cache flush distribution 
interval.

For example, if the value is set to 10 minutes with a 64 MB cache, the engine will inspect 1/600th of 
the cache each second, or about 110 KB of cache (less than the minimum, so the engine will 
actually inspect 128 KB of cache), and write only the changed data to disk. However, if this interval 
is set to 10 minutes with a 500 MB cache, it will only inspect 853 KB as opposed to the default value 
of 1/60th of the cache, or 8.5 MB. Used this way, the server can distribute its disk writing over time, 
and therefore allow the server CPU a higher priority to service client requests, as it will take much 
less time to inspect 853 KB compared to 8.5 MB.

Related topic
Database settings (page 67)
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Database Server security settings
The Database Server > Security tab lets you configure the following security settings: 

• Specify whether clients are authenticated using FileMaker accounts only or also using an 
external authentication server.

• Limit the list of hosted databases that clients can view.

• Encrypt data passed between the Database Server and clients.

To specify Database Server security settings:
1. Choose Database Server > Security tab.

To Do this

Specify whether to authenticate 
access to hosted databases 
using an external server

For Client Authentication, select one of the following: 

• FileMaker accounts only: The user name and 
password are authenticated against the account name 
and password specified in the FileMaker Pro accounts 
of hosted databases.

• FileMaker and external server accounts: The user 
name and password are authenticated against the 
account name and password specified in FileMaker Pro 
accounts or against an external server. The external 
server returns local and domain group accounts that 
the user belongs to, which are then authenticated 
against the group accounts specified in FileMaker Pro 
External Server accounts. 

For more information, see External authentication for 
database access (page 72).

For more information on creating accounts that 
authenticate via an external server, see FileMaker Pro 
Help.

Specify whether to filter the list 
of databases in: 

• Open Remote File dialog 
box in FileMaker Pro

• Instant Web Publishing 
home page

• Custom Web Publishing 
database list requests 

For File Display Filter, select one of the following: 

• List all databases: Display all hosted databases. 

• List only the databases each user is authorized to 
access: Display only the databases for which the user 
has access privileges in each hosted database.
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2. Click Save.

Related topics
Auto Start settings (page 61)
Admin Console settings (page 59)
Configuring Database Server settings (page 62)

Encrypt data passed between 
the Database Server and clients

Select Secure connections to FileMaker Server. 
All Database Server client connections use the Secure 
Sockets Layer (SSL), except ODBC and JDBC 
connections. For more information about data security, see 
Securing your data (page 125).

Secure connections are slower because of data encryption. 
Data transfer rates are affected by the number of clients 
and the amount of data transferred.

Note If you change this setting, you must stop and start the 
Database Server again for the change to take effect. See 
Starting and stopping FileMaker Server (page 51).

To Do this
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External authentication for database access
FileMaker Server authenticates users with FileMaker accounts defined within a FileMaker Pro 
database. In addition, FileMaker Server supports authentication with the following externally defined 
accounts and groups:

• Windows or Mac OS accounts and groups locally defined on the master machine

• Apple Open Directory and Windows Active Directory accounts and groups, which can be on 
a centrally-managed authentication server

If you’re hosting FileMaker Pro database files with FileMaker Server, you can use your existing 
authentication server to control access to databases without having to manage an independent list 
of accounts in each FileMaker Pro database file.

If in the Database Server > Security tab you choose FileMaker and external server accounts, 
the clients’ access privileges are determined by the accounts defined in the hosted databases and 
by accounts that are defined on the master machine or on an authentication server. Using 
FileMaker Pro, you specify in a database whether an account is authenticated via FileMaker or an 
external authentication server. These are Active Directory accounts (Windows) or Open Directory 
accounts (Mac OS). Depending on the specific network configuration, an external authentication 
server on one platform can authenticate users on the other platform. In other words, a Mac OS user 
might be authenticated by Active Directory or a Windows user might be authenticated by Open 
Directory in Mac OS X Server.

If you choose FileMaker and external server accounts, records of all login attempts are logged in 
the Windows Security Log, if the master machine is a Windows machine. For more information 
about the Security Log, see your Windows documentation.

Important When a database file contains one or more External Server accounts, make sure you 
use operating system security settings to limit direct access to the file. Otherwise, it might be 
possible for an unauthorized user to move the file to another system that replicates your 
authentication server environment and gain access to the file. Group names for accounts 
authenticated with the external server feature are stored as text strings. If the group name is 
reproduced on another system, the copied file can be accessed with the privilege set assigned to 
the members of the group, which might expose data inappropriately.

Notes
• For more information on setting up accounts in FileMaker Pro, see “Creating accounts that 

authenticate via an external server” in FileMaker Pro Help. 

• For more information on setting up external authentication, go to www.filemaker.com/kb and 
search for articles containing the keywords external and authentication (and optionally 
cross-platform). 

Related topics
Database Server security settings (page 70)
Securing your data (page 125)

http://www.filemaker.com/kb
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Default folder settings
Choose the Database Server > Default Folders tab to specify the following configuration settings:

• Specify an additional database folder for database files. 

• Specify a backup folder for database files. 

Setting up an additional database folder
At startup, FileMaker Server searches the default database folder (and in subfolders one level 
down) for databases to host. It also searches an optional additional database folder. The databases 
are backed up to the default backup folder.

The full path for the default database folder is:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Data\Databases\

• Mac OS: /Library/FileMaker Server/Data/Databases/

1. For Database Folders, select Use additional database folder. 
2. Enter the full path to the location of the additional database folder. The maximum length of 

the path is 255 characters.

• Windows: The path you enter must start with filewin:/ and end with a slash (/). 

For example, filewin:/driveLetter/folderName/ 

• Mac OS: The path you enter must start with filemac:/ and end with a slash (/).

For example, filemac:/volumeName/folderName/ 

Note Click Restore to undo changes made to the path.

3. Click Validate to ensure that the path entered is correct. 

When the path is found to be valid, the label changes from Not a valid path to Valid path. If the 
path is not valid, see Tips for valid folders (page 75). 

4. Click Save.

Setting up a backup database folder
Specify the path to a folder used by FileMaker Server when a Back Up Database scheduled task 
runs.

Important Do not put the default backup folder in the same folder as the databases to be hosted, or 
in a subfolder within that folder. Any databases in that folder are automatically opened when 
FileMaker Server starts.

1. For Backup Folder, enter the full path to the location of the new default backup folder. The 
maximum length of the path is 255 characters.

• Windows: The path you enter must start with filewin:/ and end with a slash (/). 

For example, filewin:/driveLetter/folderName/ 

• Mac OS: The path you enter must start with filemac:/ and end with a slash (/).

For example, filemac:/volumeName/folderName/ 

Note Click Restore to undo changes made to the path.
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2. Click Validate to ensure that the path entered is correct. 

When the path is found to be valid, the label changes from Not a valid path to Valid path. If the 
path is not valid, see Tips for valid folders (page 75). 

3. Click Save. 

Related topic
Uploading database files (page 33)
Configuring Database Server settings (page 62)
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Tips for valid folders 
The folders you specify as a backup folder and as an additional database folder must be valid. 

• Specify a folder on a local volume, not on a remote volume. 

If you want to store database backups on a remote volume, first backup the database to a local 
volume, and then copy the backup to a remote volume. 

• Ensure that the folder has permissions set correctly so that FileMaker Server can read and 
write to the folder. 

(Mac OS) The folder must be owned by the user fmserver (or in the group fmsadmin). 

• Specify the folder as an absolute path: 

• Windows: The path you enter must start with filewin:/ and end with a slash (/).

For example, filewin:/driveLetter/folderName/ 

• Mac OS: The path you enter must start with filemac:/ and end with a slash (/).

For example, filemac:/volumeName/folderName/ 

Refer to the FileMaker Knowledge Base for more information. See Customer support and 
Knowledge Base (page 198). 

Related topic
Default folder settings (page 73)
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Logging and statistics settings
The Database Server > Logging tab lets you configure how the Database Server collects and logs 
events, client access, and statistical information while FileMaker Server is running. You can enable 
usage statistics logging to collect performance information and write to your log at a specified 
interval.

In this tab you can configure the following settings:

• Statistics. Specify how often the Database Server collects statistical information for display 
and for optional logging.

• Logging. Specify whether optional client access is collected while FileMaker Server is 
running. You can enable usage statistics logging to collect performance information and 
write to your log files at a specified interval.

When you enable usage statistics for FileMaker Server, a log file named Stats.log is created in the 
FileMaker Server/Logs/ folder. Stats.log is a tab-delimited text file. Real-time statistics are displayed 
in the Statistics pane. You can also view the Stats.log file in FileMaker Pro, a spreadsheet, or a text 
editor.

You can specify the maximum size for the Access.log, Event.log, and Stats.log files, and a collection 
interval for Stats.log so that it doesn't get too large.

To specify event logging settings:
1. Choose Database Server > Logging tab.

2. Click Save.

Related topics
General web publishing settings (page 79)
Viewing statistics (page 108)
Tracking activity in log files (page 110)
Configuring Database Server settings (page 62)

To Do this

Set the time between collecting 
statistics

For Collection Interval, enter the time in minutes and 
seconds.

The collection interval determines how frequently 
FileMaker Server collects the statistical information that 
is displayed in the Statistics pane and optionally logged 
in the Stats.log file.

Specify the log size For Log Size, specify the maximum size in MB for the 
Access.log, Event.log, and Stats.log files. 

Enable logging Events are always logged in the Event.log file. Event 
logging cannot be disabled.

Select Access to log connections to FileMaker Server 
in the Access.log file.

Select Usage statistics to log performance 
measurements in the Stats.log file.
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Server plug-in settings
The Database Server > Server Plug-ins tab allows you to enable FileMaker Server to use external 
function plug-ins with hosted FileMaker Pro databases that are designed to use server-side plug-
ins. 

For more information on plug-ins, see Managing plug-ins (page 119).

To allow FileMaker Server to use plug-ins:
1. Select Enable FileMaker Server to use plug-ins.

The list shows the plug-ins that are in the plug-in folder. 

2. Select Enabled for each plug-in that you want to execute on FileMaker Server.

3. Click Save.

Related topics
Enabling server-side plug-ins (page 120)
Uploading database files (page 33)
Configuring Database Server settings (page 62)
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Configuring web publishing settings
Choose Web Publishing and select one of the following tabs to specify FileMaker Server settings:

After you change a setting in a tab, you can click Save to save your changes immediately. Or, if you 
want to make changes in other tabs in this pane, you can click another tab, make changes, then 
click Save. At any time, you can click Revert to undo all changes you’ve made in these tabs since 
the last save.

When you configure web publishing settings, Admin Console prompts you to restart the Web 
Publishing Engine after you save changes to settings. This makes all web published databases 
unavailable to web users while the Web Publishing Engine restarts.

Important Change web publishing settings only when the Web Publishing Engine is not being 
used. Web publishing clients can lose unsaved work when the Web Publishing Engine restarts.

Related topics
Configuring general settings (page 54)
Configuring Database Server settings (page 62)
Enabling sharing via ODBC and JDBC (page 104)

Choose To

General Settings Specify the web publishing error logging level and the maximum 
number of web publishing sessions. See General web publishing 
settings (page 79).

PHP Enable and configure Custom Web Publishing with PHP. See PHP web 
publishing settings (page 80)

XSLT Enable and configure Custom Web Publishing with XSLT. See XSLT 
web publishing settings (page 82)

XML Enable and configure Custom Web Publishing with XML. See XML web 
publishing settings (page 86)

Instant Web 
Publishing 

Enable and configure Instant Web Publishing. See Instant Web 
Publishing settings (page 87)
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General web publishing settings
You can specify the following web publishing settings on the Web Publishing > General Settings 
tab:

• Select the logging level for web publishing.

• Set the maximum number of web publishing sessions.

To specify web publishing settings:
1. Choose Web Publishing > General Settings tab.

2. Click Save.

For more information on web publishing log files, see Web publishing logs (page 117).

Related topics
Administering databases (page 93)
Administering clients (page 88)
Logging and statistics settings (page 76)
Configuring web publishing settings (page 78)

To Do this

Enable access logging Select Enable access logging, to generate the Web 
Publishing Core internal access logs.

Access logging enables the Web Publishing Core 
internal access logs, which are called 
wpc_access_log.txt and pe_internal_access_log.txt.

Enable error logging Select Enable error logging, to generate the Web 
Publishing Engine application log.

Error logging enables the Web Publishing Engine 
application log, which is called pe_application_log.txt.

Log ScriptMaker Errors Select ScriptMaker Errors to log errors in the 
pe_application_log.txt file.

Only errors from ScriptMaker scripts run by Web 
Publishing Engine requests are logged.

Log XSLT user errors Select User (XSLT only) to log messages generated by 
the XSLT <xsl:message> element in XSLT stylesheets 
in the pe_application_log.txt file.

Set the maximum number of web 
publishing sessions

Specify the Maximum number of web publishing 
sessions.

The number specified is the maximum number of 
simultaneous client sessions allowed for all web 
technologies enabled on FileMaker Server.
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PHP web publishing settings
Custom Web Publishing with PHP enables PHP web applications to access data using the 
FileMaker API for PHP. You can configure how the Web Publishing Engine responds to the API.

You can specify the following PHP Publishing settings on the Web Publishing > PHP tab:

• Enable PHP publishing.

• Enable pre-validation of record data.

• Select the default character encoding.

• Select the language used with PHP publishing.

Note Changing any of these settings requires restarting the Web Publishing Engine.

For more information about hosting a PHP website, see Hosting PHP websites (page 45). For more 
information about creating a PHP website and using the FileMaker API for PHP, see FILEMAKER 
SERVER CUSTOM WEB PUBLISHING WITH PHP on the Start Page. 

To specify PHP Publishing settings:
1. Choose Web Publishing > PHP tab.

2. Click Save.

Note The FileMaker API for PHP and a supported PHP engine must be installed on the web server 
for Custom Web Publishing with PHP to work. For more information, see Enabling technologies for 
web publishing (page 16).

Related topics
Administering databases (page 93)
Administering clients (page 88)
General web publishing settings (page 79)

To Do this

Enable Custom Web Publishing with 
PHP

Select Enable PHP publishing. 

This setting must be enabled to configure the other 
settings in this tab.

Enable pre-validation of record data 
on the web server 

Select Enable record data pre-validation.

Enables the FileMaker API for PHP to validate record 
data before committing a record to the Database 
Server. To use this feature, your PHP code must call 
the validate() method where necessary and 
respond to validation errors. 

Select the default character 
encoding

For Default Character Encoding, choose an 
encoding.

The encoding you choose should match the encoding 
you use in the <head> section of your PHP files.
The PHP default language is Latin-1. The FileMaker 
Server default is Unicode. Use UTF-8 if your data 
contains non-Latin characters.

Select the PHP publishing error 
message language

For Language, choose a language for error messages 
returned by the FileMaker API for PHP.
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Configuring web publishing settings (page 78)
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XSLT web publishing settings
You can specify the following XSLT Publishing settings on the Web Publishing > XSLT tab:

• Enable XSLT Publishing.

• Enable database sessions.

• Set the session timeout value.

• Configure SMTP information to send email messages in an XSLT stylesheet.

• Select the default character encoding.

Note Changing any of these settings requires restarting the Web Publishing Engine.

For more information about XSLT web publishing, see FILEMAKER SERVER CUSTOM WEB PUBLISHING 
WITH XML AND XSLT on the Start Page.

To enable XSLT Publishing:
1. Choose Web Publishing > XSLT tab.

To Do this

Enable XSLT Publishing Select Enable XSLT publishing.

This setting must be enabled to configure the other settings 
in this tab.

Choose how errors are 
generated

Select one of these modes:

• Development mode: Generate a specific error 
page when an error occurs in the Web Publishing 
Engine.

Use this mode when you are developing and testing 
XSLT stylesheets. You cannot enable server-side 
stylesheet caching in Development mode.

• Production mode: Generate a default general text 
message in the error page when an error occurs in 
the Web Publishing Engine.

Use this mode to use the Web Publishing Engine to 
host XSLT stylesheets.

Enable server-side stylesheet 
caching

If Production mode is selected, select Enable stylesheet 
caching and choose a value for Cache Size.

Server-side caching stores frequently-used XSLT 
stylesheets in memory, which increases Web Publishing 
Engine performance. The Web Publishing Engine uses 
caching only when it is in Production mode.

Enable XSLT database 
sessions

Select Enable database sessions.

Sessions are optional in Custom Web Publishing with XSLT. 
For more information, see Configuring the interaction 
between web sessions and database sessions (page 85).
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2. Click Save.

Related topics
Administering databases (page 93)
Administering clients (page 88)
General web publishing settings (page 79)
Email notification settings (page 57)
Configuring web publishing settings (page 78)

Set the default session timeout 
value

For Session Timeout, set the default session time-out for 
Custom Web Publishing with XSLT.

Sessions are optional in Custom Web Publishing with XSLT 
and you create them by using the 
fmxslt:create_session() extension function. You can 
override the default setting by using the 
fmxslt:invalidate_session() and 
fmxslt:set_session_timeout() extension functions. 
See FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH 
XML AND XSLT.

Specify SMTP information for 
email messages sent in an 
XSLT stylesheet

Specify the following:

• SMTP Server Address: Enter an IP address 
(example: 127.1.1.1) or a host name (example: 
postoffice.emailserver.com).

• Port: The port number required to connect to the 
SMTP server. The default port number is 25.

• Select SMTP Authentication if required and 
choose the authentication type:

• Plain Text: Plain text authentication using 
LOGIN mechanism

• CRAM-MD5: Challenge-Response 
Authentication Mechanism-Message Digest 5 
authentication to encrypt the password for the 
SMTP mail server

Note Contact your email administrator to find out 
whether authentication is required and what type is 
used.

• User: Enter the user name required to log in to 
the SMTP server.

• Password: Enter the user’s password.
Select the default character 
encoding

For Default Character Encoding, select the Page 
Encoding and the Email Encoding. See Text encoding for 
XSLT requests (page 84)

To Do this
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Text encoding for XSLT requests
When the Web Publishing Engine is installed, the initial default text encoding for XSLT requests is 
UTF-8. For email messages, the default is ISO-8859-1. You can change these default text encoding 
settings. For more information about overriding default settings for individual requests, see the 
FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT on the Start Page.

Related topic
XSLT web publishing settings (page 82)

Encoding Description

US-ASCII Basic ASCII character set typically used for plain text English email
ISO-8859-1 Latin-1 character set typically used for Roman character-based 

webpages and email messages
ISO-8859-15 Latin-9 character set, which is almost the same as the Latin-1 character 

set. Includes the Euro € symbol.
ISO-2022-JP ISO Japanese encoding typically used for Japanese email messages
Shift_JIS Japanese encoding typically used for Japanese webpages
UTF-8 Eight-bit encoding of Unicode. Because UTF-8 supports the full range of 

Unicode characters, it can handle pages for any language.
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Configuring the interaction between web sessions and database 
sessions

Sessions allow you to store data or maintain states between requests. Custom Web Publishing with 
XSLT supports two types of sessions:

• Database sessions: FileMaker Server creates a database session whenever it retrieves 
data for a request. The maximum number of concurrent database sessions is determined by 
your FileMaker Server license.

• Web sessions: The Web Publishing Engine creates a web session whenever you use the 
fmxslt:create_session() extension function in an XSLT stylesheet. For information 
on the fmxslt:create_session() extension function, see FILEMAKER SERVER CUSTOM 
WEB PUBLISHING WITH XML AND XSLT on the Start Page. The maximum number of web 
sessions is limited only by the amount of memory on the Web Publishing Engine machine.

In Admin Console, you can use the Enable database sessions option to configure the interaction 
between these two types of sessions. If you enable this option, the Web Publishing Engine uses a 
database session for each web session. Otherwise, the Web Publishing Engine uses a database 
session for each request. This option is disabled by default.

If you enable the database sessions:

• Global values are stored between requests.

• If a ScriptMaker script modifies a state, that state is maintained between requests. For 
example, privileges that are modified by the Re-Login script step to switch accounts persist 
between requests.

• The total number of web sessions is limited to the maximum number of concurrent web 
database sessions on FileMaker Server. This limit applies to Instant Web Publishing 
sessions and XSLT sessions.

If you disable the database sessions:

• Global values are not stored between requests.

• If a script modifies a state, that state is not maintained between requests.

• The number of XSLT web sessions is not limited to the maximum number of web database 
sessions on FileMaker Server, which allows greater scalability to Custom Web Publishing. 
However, Instant Web Publishing sessions are still subject to the limit.

If your stylesheets do not use global values or scripts that require a state to be maintained between 
requests, you should disable database sessions. The setting for the Enable database sessions 
option applies to all stylesheets deployed on the Web Publishing Engine.

Related topic
XSLT web publishing settings (page 82)
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XML web publishing settings
On the Web Publishing > XML tab, you can enable or disable Custom Web Publishing with XML. 
Select Enable XML publishing to allow FileMaker Server to generate XML data from hosted 
databases based on query commands and parameters.

Note Disabling XML does not affect your ability to use XSLT or the FileMaker API for PHP, but 
could affect the connectivity of other third-party web technologies.

Related topics
Administering databases (page 93)
Administering clients (page 88)
General web publishing settings (page 79)
Configuring web publishing settings (page 78)
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Instant Web Publishing settings
You can specify the following Instant Web Publishing settings on the Web Publishing > Instant 
Web Publishing tab:

• Enable Instant Web Publishing.

• Set the Instant Web Publishing session timeout value.

• Select the language for the Instant Web Publishing status area.

Notes
• Changing any of these settings requires restarting the Web Publishing Engine.

• Instant Web Publishing requires a FileMaker Server Advanced license. 

To specify Instant Web Publishing settings:
1. Choose Web Publishing > Instant Web Publishing tab.

2. Click Save.

For more information, see FILEMAKER INSTANT WEB PUBLISHING GUIDE on the Start Page.

Related topics
Administering databases (page 93)
Administering clients (page 88)
General web publishing settings (page 79)
Server information settings (page 55)
Configuring web publishing settings (page 78)

To Do this

Enable Instant Web Publishing Select Enable Instant Web Publishing.

This setting must be enabled to configure the other 
settings in this tab.

Set the database session timeout 
value

Set a value for Session Timeout. 
The Web Publishing Engine disconnects users who have 
been inactive for the specified timeout period.

Instant Web Publishing solutions automatically use 
database sessions and you cannot disable them.

Select the status area label 
language

For Status Area Language, select the language for the 
labels displayed in the status area of the Instant Web 
Publishing page. 

This setting changes the language for all text in the 
Instant Web Publishing user interface — for example, the 
status area, Instant Web Publishing homepage, forms-
based authentication, dialog boxes, and error messages.

The status area language setting does not change the 
language of data stored in databases.
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Administering clients
The Clients pane lists all users, including FileMaker Pro and Web Publishing clients, currently 
connected to databases hosted by FileMaker Server. You can view details about each user, send 
messages to users, and disconnect users.

Viewing client details
Select a User Name to view client details below the Connected Clients list. Click the Databases 
Open tab to view the list of databases that the user is currently using (see About databases open 
details (page 90)). Or, choose the User Details tab to view details about the user’s system (see 
About user details (page 89)).

Managing client connections
Select one or more clients, choose one of the following Actions, and then click Perform Action:

Notes
• To sort clients in the list in ascending or descending order, click a column heading.

• To resize the width of a column, select the column heading border and drag it horizontally.

• To put the columns in a different order, click a column heading, drag it, and drop it at the 
desired location.

• To copy information from the client list, databases open list, or the user details list, select the 
row and choose Edit menu > Copy.

Related topics
FileMaker Pro client settings (page 63)
General web publishing settings (page 79)
Enabling sharing via ODBC and JDBC (page 104)

For Actions, choose To

Send Message Send a text message to selected FileMaker Pro clients connected to 
FileMaker Server. See Sending messages to FileMaker Pro clients 
(page 91).

Send Message to All 
Clients 

Send a text message to all FileMaker Pro clients connected to 
FileMaker Server. See Sending messages to FileMaker Pro clients 
(page 91).

Disconnect Disconnect selected clients connected to FileMaker Server. See 
Disconnecting clients (page 92).

Disconnect All Clients Disconnect all clients connected to FileMaker Server. See 
Disconnecting clients (page 92).
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About user details
The User Details tab lists detailed information about the client connected to FileMaker Server.

Related topic
Administering clients (page 88)

Detail Description

Computer Name The client's computer name.
MAC Address The MAC (Media Access Control) address for the 

computer network adapter that the client is using 
to connect to FileMaker Server. 

Operating System The name of the client computer operating 
system. 

Client/Browser Version For FileMaker Pro clients, the version of 
FileMaker Pro that the client is using.

For Instant Web Publishing, the name of the Web 
Browser that the client is using.

Language The language used by the client.
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About databases open details
The Databases Open tab lists detailed information about the client and the databases the client is 
currently using.

Related topic
Administering clients (page 88)

Detail Description

Database Name The database that the client is using. If the client is 
connected to more than one database, the databases 
will be listed here. 

Account Name The account name used to log in to FileMaker Server.
Privilege Set The FileMaker Pro privilege set used by the account to 

access the hosted database.
Connect Time The date and time the client connected to the database.
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Sending messages to FileMaker Pro clients
You can send a message to FileMaker Pro clients connected to databases hosted by FileMaker 
Server. You can send a message to selected or all FileMaker Pro clients.

To send a message to one or more clients:
1. Choose Clients, then select a client in the Connected Clients list.

2. For Actions, select Send Message or Send Message to All Clients.

If you select Send Message, the message is sent to the selected clients.

If you select Send Message to All Clients, the message is sent to all clients connected to all 
databases hosted by FileMaker Server.

3. Click Perform Action to open the Send Message dialog box.

4. Type a message, then click Send Message.

FileMaker Server sends the message to the selected clients.

Notes
• You cannot send messages to clients connected via Instant Web Publishing or Custom Web 

Publishing.

• You can also send a message to FileMaker Pro clients by scheduling a Send Message task.

Related topics
Sending messages to FileMaker Pro clients of selected databases (page 95)
Disconnecting clients (page 92)
Sending scheduled messages to clients of hosted databases (page 133)
Administering clients (page 88)
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Disconnecting clients

To disconnect a selected client or all clients from FileMaker Server:
1. Choose Clients, then select a client in the Connected Clients list.

2. For Actions, select Disconnect or Disconnect All Clients.

3. Click Perform Action.

The Disconnecting Clients dialog box opens.

4. For Message, type the message to send to clients before they are disconnected.

5. For Delay time, enter the number of minutes between when the notification is sent and 
when clients are disconnected. 

6. Click Send Message.

Clients see a notification dialog box with your message requesting they close their connection to 
a file. 

If the client hasn’t already disconnected, FileMaker Server disconnects the client when the 
delay time elapses.

Related topics
Sending messages to FileMaker Pro clients (page 91)
Closing hosted files (page 97)
Administering clients (page 88)
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Administering databases
The Databases pane lists all databases hosted by FileMaker Server. The database files are 
grouped in the default Databases folder, the additional database folder, and any subfolders. To 
manage hosted databases, choose what you want to do from Actions and click Perform Action.

About hosted databases
When FileMaker Server starts, it automatically opens, or hosts, all files in the FileMaker Server 
Databases folder and the optional additional database folder as well as files in subfolders one level 
down. See Hosting databases (page 31).

Viewing database details
You can view the Status of each database, the extended privileges enabled by FileMaker Pro, and 
the Details for clients currently connected to the database.

Managing hosted databases
Select one or more databases, choose one of the following Actions, then click Perform Action:

For Actions, choose To

Send Message Send a text message to all FileMaker Pro clients connected to 
the selected databases. See Sending messages to FileMaker 
Pro clients of selected databases (page 95).

Send Message to all Send a text message to all FileMaker Pro clients connected to 
any database hosted by FileMaker Server. See Sending 
messages to FileMaker Pro clients of selected databases (page 
95).

Open Open selected databases with the Status: Closed or 
Checking. See Opening hosted files (page 96).

Open all Open all databases with the Status: Closed or Checking. See 
Opening hosted files (page 96).

Close Close selected databases with the Status: Normal, Paused, 
Opening, or Checking. See Closing hosted files (page 97).

Close all Close all databases with the Status: Normal or Paused. See 
Closing hosted files (page 97).

Pause Pause selected databases with the Status: Normal. See 
Pausing hosted files (page 98).

Pause all Pause all databases with the Status: Normal. See Pausing 
hosted files (page 98).

Resume Resume selected databases with the Status: Paused. See 
Resuming hosted files (page 99)

Resume all Resume all databases with the Status: Paused. See Resuming 
hosted files (page 99).

Remove Remove selected databases with the Status: Closed or delete 
empty subfolders. See Removing hosted files (page 100).
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Notes
• You can use the shortcut menu in the Databases list to perform the commands listed in 

Actions. Right-click selected databases and choose an action.

• To resize the width of a column, select the column heading border and drag it horizontally.

• To put the columns in a different order, click a column heading, drag it, and drop it at the 
desired location.

• To copy information from the databases list or details list, select the row and choose Edit 
menu > Copy.

Related topics
Hosting databases (page 31)
Database Server security settings (page 70)
Scheduling database backups (page 128)

Upload Upload FileMaker Pro databases. Selecting this option opens 
the Upload Database assistant to copy database files to the 
FileMaker Server Default Folder or Additional Folder. See 
Uploading database files (page 33).

For Actions, choose To
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Sending messages to FileMaker Pro clients of selected 
databases

You can send a message to FileMaker Pro clients connected to selected databases or all databases 
hosted by FileMaker Server.

To send a message:
1. Choose Databases.

2. Open the Databases folder or the additional database folder, if required.

3. If you are sending a message to clients of selected databases, select one or more 
databases.

4. For Actions, select Send Message or Send Message to all.
If you select Send Message, the message is sent to all FileMaker Pro clients connected to the 
selected databases.

If you select Send Message to all, the message is sent to all FileMaker Pro clients connected 
to any databases hosted by FileMaker Server.

5. Click Perform Action to open the Send Message dialog box.

6. Type a message, then click Send Message.

FileMaker Server sends the message to clients connected to the selected databases.

Note You cannot send messages to clients connected via Instant Web Publishing or Custom Web 
Publishing.

Related topics
Sending messages to FileMaker Pro clients (page 91)
Sending scheduled messages to clients of hosted databases (page 133)
Administering databases (page 93)
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Opening hosted files
Open one or more database files with a Closed status. 

To open hosted databases:
1. Choose Databases.

2. Open the Databases folder or the additional database folder, if required.

3. If you are opening selected databases, select one or more Closed databases.

4. For Actions, select Open or Open all. 
5. Click Perform Action.

Notes
• If you select a folder in the Databases list, FileMaker Server opens all of the files in that 

folder.

• If the status changes to Checking, FileMaker Server is checking the file’s structure before 
opening it. Checking a large file may take several minutes. 

• You can also open a database with the Checking status to skip the consistency check. You 
should do this only if the database does not open.

Related topics
Closing hosted files (page 97)
Disconnecting clients (page 92)
Administering databases (page 93)



Administering databases Closing hosted files

FILEMAKER SERVER 9 HELP 97

Closing hosted files
Close one or more hosted databases with Normal or Paused status.

To close databases and disconnect clients:
1. Choose Databases.

2. Open the Databases folder or the additional database folder, if required.

3. If you are closing selected databases, select one or more Normal or Paused databases.

4. For Actions, select Close or Close all. 
5. Click Perform Action.

6. If you see the Close Databases dialog box, do the following:

• For Message, type the message to send to clients before they are disconnected.

• For Delay time, enter the number of minutes between when the notification is sent and 
when clients are disconnected. 

• Click Send Message.

Clients see a notification dialog box with your message requesting they close their connection to 
a file. 

When the delay time elapses, FileMaker Server disconnects any remaining clients and closes 
the file or files in the folder. The status of the affected files changes to Closed.

The Status of the files being closed changes to Closing to indicate that FileMaker Server has 
begun closing files.

Completing the process of closing many database files, a large database file, or a file with many 
connected clients may take several minutes.

Note Close can be performed on a database with the Opening or Checking status, canceling the 
consistency check performed when the file is opened.

Related topics
Disconnecting clients (page 92)
Viewing statistics (page 108)
Sending messages to FileMaker Pro clients (page 91)
Administering databases (page 93)
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Pausing hosted files
Temporarily stop access to one or more open databases with Normal status. Connected clients can 
read data from the database while it is paused, but cannot modify the database until the database is 
resumed. For example, you can pause a database and safely use the operating system to make a 
copy of the file.

To pause one or more hosted databases:
1. Choose Databases.

2. Open the Databases folder or the additional database folder, if required.

3. If you are pausing selected databases, select one or more Normal databases.

4. For Actions, select Pause or Pause all. 
5. Click Perform Action.

Related topics
Resuming hosted files (page 99)
Opening hosted files (page 96)
Closing hosted files (page 97)
Administering databases (page 93)
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Resuming hosted files
Make available one or more databases that have been paused.

To resume one or more hosted databases:
1. Choose Databases.

2. Open the Databases folder or the additional database folder, if required.

3. If you are resuming selected databases, select one or more Paused databases.

4. For Actions, select Resume or Resume all. 
5. Click Perform Action.

Related topics
Pausing hosted files (page 98)
Opening hosted files (page 96)
Closing hosted files (page 97)
Administering databases (page 93)
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Removing hosted files
You can remove one or more selected databases with Closed status or delete empty subfolders. 
The selected databases are moved to the folder Removed_by_FMS/Removed. The 
Removed_by_FMS/Removed folder is created inside either the default Databases folder or the 
additional database folder, depending on which folder the selected databases are in. 

The following table shows examples of where hosted databases are moved to after they are 
removed: 

To remove one or more databases:
1. Choose Databases. 

2. Open the Databases folder or the additional database folder, if required.

3. Select one or more Closed databases.

4. For Actions, select Remove. 

5. Click Perform Action. 

6. Click Yes to remove the selected databases.

Note If you remove a hosted file, upload a file with the same filename, and remove the second file, 
then FileMaker Server overwrites the first removed file with the second removed file.

To delete empty subfolders:
1. Choose Databases. 

2. Select one or more empty subfolders in the list.

You must remove all files from a subfolder before you can delete it.

3. For Actions, select Remove. 

4. Click Perform Action. 

5. Click Yes to remove the empty folder.

The selected empty folders are deleted, not moved as when a database is removed.

Related topics
Closing hosted files (page 97)
Hosting databases (page 31)
Administering databases (page 93)

Location before remove Location after remove

Databases\ABC.fp7 Databases\Removed_By_FMS\
Removed\ABC.fp7 

Databases\[Subfolder]\
ABCsub.fp7 

Databases\Removed_By_FMS\Removed\
[Subfolder]\ABCsub.fp7 

[Additional]/ABCadd.fp7 [Additional]/Removed_By_FMS/Removed/
ABCadd.fp7 

[Additional]/[Subfolder]/
ABCsub.fp7 

[Additional]/Removed_By_FMS/Removed/
[Subfolder]/ABCsub.fp7 
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Using ODBC and JDBC with FileMaker Server
You can use FileMaker Server as:

• a data source, if you have a FileMaker Server Advanced license. You can share hosted 
FileMaker Pro database files with other applications on the same computer or over a 
network using ODBC (Open Database Connectivity) and JDBC (Java Database 
Connectivity). For example, you can create charts, analyze numbers, and generate reports 
using FileMaker Pro data in other applications.

• an ODBC client application. Hosted FileMaker Pro databases can interact with data sources 
on the same computer or over a network. For example, hosted FileMaker Pro databases 
can work with an Oracle data source interactively as defined in the FileMaker Pro 
relationships graph and in layouts.

FileMaker Server Advanced as a data source
FileMaker Server Advanced includes the software you need to share databases as data sources via 
ODBC and JDBC, including the FileMaker client drivers you use to access your databases from 
other ODBC- or JDBC-compliant applications. See Sharing FileMaker databases via ODBC and 
JDBC (page 103) for information about enabling a database file for sharing. 

For details about supported SQL statements, expressions, Catalog functions, and client drivers, see 
the FILEMAKER ODBC AND JDBC GUIDE on the Start Page.

FileMaker Server as an ODBC client application
When you use FileMaker Server or FileMaker Server Advanced as a client application, you must 
install and configure drivers for the ODBC data sources to access and set up the data source names 
(DSNs) that hosted FileMaker Pro databases are designed to use. For example, to access data from 
an Oracle database using ODBC, you must install and configure an Oracle ODBC client driver and 
set up exactly the same DSNs that the FileMaker Pro database was designed to use. FileMaker 
Server supports several third-party drivers. For more information, see Accessing external ODBC 
data sources (page 105).

See FileMaker Pro Help for information about:

• working with ODBC data sources interactively, in real-time, in the relationships graph and in 
layouts.

• importing ODBC data in batch operations with SQL queries.

What you need to work with ODBC in FileMaker Server 

What do you want to do? See Product

Host a FileMaker Pro database 
as a data source

Sharing FileMaker databases 
via ODBC and JDBC (page 
103)

FILEMAKER ODBC AND JDBC 
GUIDE on the Start Page

FileMaker Server Advanced 
license required

Host a FileMaker Pro database 
that accesses an external 
ODBC data source 

Accessing external ODBC data 
sources (page 105)

FileMaker Pro Help

FileMaker Server or FileMaker 
Server Advanced
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Related topic
Server information settings (page 55)
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Sharing FileMaker databases via ODBC and JDBC
You can use FileMaker Server Advanced to host a FileMaker database file as a data source, sharing 
your data with other applications using ODBC and JDBC. FileMaker Server allows up to 50 
connections and supports local access (same computer) and remote access (both for middleware 
such as web servers, and for remote client access from desktop productivity applications).

To share a hosted FileMaker Pro database via ODBC and JDBC:
1. In FileMaker Pro, open the database and edit the privilege set for the accounts that will 

access the database. Enable the extended privilege Access via ODBC/JDBC. For more 
information, see FileMaker Pro Help.

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must use this privilege set with the extended privilege Access via ODBC/JDBC 
enabled.

2. In FileMaker Server Admin Console, click ODBC/JDBC and select Enable ODBC/JDBC. 

3. Upload the database file to FileMaker Server. See Hosting databases (page 31).

Note If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be hosted on the same FileMaker Server deployment.

4. On each client computer that needs to access the hosted database, install and configure the 
FileMaker ODBC or JDBC client driver. 

For details on installing and configuring a client driver to access your FileMaker data source, 
see the FILEMAKER ODBC AND JDBC GUIDE on the Start Page.

Related topics
Enabling sharing via ODBC and JDBC (page 104)
Using ODBC and JDBC with FileMaker Server (page 101)
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Enabling sharing via ODBC and JDBC
FileMaker Server Advanced can host data via ODBC/JDBC for other applications (like 
spreadsheets, word processors, and reporting tools). Users can view, analyze, and modify data in 
hosted FileMaker databases. To host data, you must enable this feature in FileMaker Server Admin 
Console and use FileMaker Pro to enable sharing via ODBC/JDBC in each database that you want 
to share. 

For more information, see Sharing FileMaker databases via ODBC and JDBC (page 103).

Note Sharing via ODBC/JDBC requires a FileMaker Server Advanced license.

To enable sharing via ODBC/JDBC:
1. Choose ODBC/JDBC.

2. Select Enable ODBC/JDBC.

3. Click Save.

Notes
• Enabling this feature allows clients to use FileMaker Server as a data source via ODBC and 

JDBC. You do not need to enable this OBDC/JDBC data source feature to host 
FileMaker Pro databases that access an external SQL data source via ODBC. See 
Accessing external ODBC data sources (page 105).

• For other applications to access FileMaker data hosted on FileMaker Server, ODBC and 
JDBC client drivers must be installed on the machines running the other applications. 
Installers for the client drivers are provided on the FileMaker Server CD or you can 
download them.

• You must use FileMaker Pro to enable ODBC/JDBC sharing in each database you want to 
share. For details about sharing via ODBC/JDBC, see FileMaker Pro Help.

• For more information on installing the client drivers and for details on the SQL statements 
supported by FileMaker Server Advanced, see the FILEMAKER ODBC AND JDBC GUIDE on 
the Start Page.

Related topics
Uploading database files (page 33)
Email notification settings (page 57)
Database Server security settings (page 70)
Server information settings (page 55)
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Accessing external ODBC data sources
If you want to host a FileMaker Pro database that works with data in an external ODBC data source, 
you must configure an ODBC client driver for the ODBC data source that the FileMaker Pro 
database accesses. For example, if the database accesses records from an Oracle database, you 
must configure an Oracle client driver. 

Note The ODBC client driver must be installed and configured on the master machine in your 
FileMaker Server deployment.

When a FileMaker Pro or web publishing client connects to the hosted FileMaker Pro database, 
FileMaker Server accesses data in the external ODBC data source on behalf of the client. 
Therefore, the client connected to FileMaker Server does not directly interact with the external data 
source, and does not need to install and configure an ODBC client driver. Only the master machine 
in the FileMaker Server deployment requires the ODBC client driver.

For detailed information on designing a FileMaker Pro database that accesses external data 
sources, see FileMaker Pro Help.

To configure an ODBC client driver and set up a DSN on FileMaker Server:
The way you interact with the data source, provide a password, and perform and display query 
results varies with each application’s client driver. Additionally, data source configuration can vary 
from one ODBC client driver manufacturer to another. 

For a list of supported data sources and ODBC client drivers, see FileMaker Pro Help.

Use the following procedure as a general guideline for configuring data sources (refer to the 
documentation that accompanies each data source application for details).

1. (Windows) In the Windows Control Panel, choose Administrative Tools > Data Sources 
(ODBC). In Windows XP, Administrative Tools appear in the Performance and 
Maintenance category.

(Mac OS) Start the ODBC data source administrator. The ODBC Administrator utility is available 
with Mac OS X (in the Applications/Utilities folder).

2. Click the System DSN tab.

If your data source appears in the list, the driver is already configured. You can skip the 
remaining steps and begin accessing ODBC data, or choose your data source and click 
Configure to modify how you’ll interact with the data source.

A System DSN (Data Source Name) is available to all users who log in to your computer. A User 
DSN is available only when you log in. 

Important Only System DSNs are supported for FileMaker Pro databases that work with 
ODBC tables in the FileMaker Pro relationships graph.

3. Click Add to configure a driver for your data source.

A list displays all ODBC client drivers installed on your computer. 

FileMaker Server supports several third-party drivers. For more information on supported 
drivers, see www.filemaker.com/support/technologies.

To install a new driver, use the driver’s installation program.

4. Choose the driver for the data source that the hosted FileMaker Pro database is designed to 
access, then click Finish.

A setup dialog box appears.

http://www.filemaker.com/support/technologies
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5. In Data Source Name, enter the identical Data Source Name that the FileMaker Pro 
database is designed to connect to.

Important The Data Source Name you enter here must be exactly the same as the Data 
Source Name that the database was designed to use in FileMaker Pro. So for each Data 
Source Name used by each database you host, you must configure a matching Data 
Source Name on the FileMaker Server master machine.

Many drivers also offer options to customize how you access a data source, such as identifying 
a particular data source file.

6. Click OK.

Related topic
Using ODBC and JDBC with FileMaker Server (page 101)
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Monitoring FileMaker Server
You can view usage statistics and track the activity of FileMaker Server. Admin Console displays 
usage statistics that help you monitor server performance. To help you monitor your FileMaker 
Server deployment and troubleshoot problems, FileMaker Server helps you perform the following 
tasks:

• Viewing statistics (page 108)

• Tracking activity in log files (page 110)

The following table summarizes where you can find the information that FileMaker Server tracks for 
you.

All log files are located in the Logs folder:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Logs 

• Mac OS:/Library/FileMaker Server/Logs

Note In a multiple machine deployment, the log files are on the machines indicated in the table 
above.

To monitor See Description

Usage statistics Statistics pane

Stats.log (master machine)

FileMaker Server performance and 
number of clients logged in.

Events Events.log (master machine)

Windows: Event Viewer 
(master machine)

Database Server start and stop 
events, consistency checks, error 
conditions in FileMaker Server 
configuration.

Client accesses to the 
Database Server

Access.log (master machine) Client connect/disconnect and 
database open/close operations.

Web Publishing Core 
internal access 

wpc_access_log.txt (Web 
Publishing Engine machine)

End-user requests to generate XML 
and to use FileMaker Server Instant 
Web Publishing including requests 
from the FileMaker API for PHP.

pe_internal_access_log.txt 
(Web Publishing Engine 
machine)

Internal XML requests that the XSLT-
CWP software component of the Web 
Publishing Engine makes while 
processing XSLT requests.

Web Publishing Engine 
application log

pe_application_log.txt. (Web 
Publishing Engine machine)

Web Publishing Engine start and stop 
events, error, script, and user log 
information.

Web Server Module web_server_module_log.txt 
(web server machine)

Communication errors between the 
web server and with Web Publishing 
Engine
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Viewing statistics
To view FileMaker Server statistics in Admin Console, choose Statistics. The Statistics pane lists a 
summary of Connection and Database Statistics attributes. 

Connection Statistics
The attributes collected for each statistic Type include the number of Current, Average, Low, and 
Peak client connections.

Database Statistics
The attributes collected for each statistic Type include the Current, Average, Low, and Peak value.

Statistic Description

FileMaker Pro Clients Number of connected FileMaker Pro clients. Use this information to 
configure the maximum number of FileMaker Pro clients.

ODBC/JDBC Number of connected ODBC/JDBC clients.
Instant Web Publishing Number of connected Instant Web Publishing clients.
Custom Web Publishing 
(PHP, XML, XSLT) 

Number of connected Custom Web Publishing clients. Use this 
information to configure the maximum number of Custom Web 
Publishing clients.

Statistic Description

Cache Hit % Percentage of times FileMaker Server retrieved data from the cache 
(RAM) rather than the hard disk. Reading data from RAM is much 
more efficient than rereading it from the hard disk, so this value 
should be a high number, like 90 or 95. If it isn't, you can allocate 
more memory to FileMaker Server database cache.

Cache Unsaved % Percentage of cache that is currently unsaved. This should be a low 
number, such as 0 or 5, so you won't lose data if you experience a 
system crash. If the number is consistently high, decrease the 
cache flush interval. 

Disk (Kbytes/second) Amount of data being written to disk. Data is measured in KB.
Elapsed Time/Call Time to process a remote call. If the average Elapsed Time/Call is 

high, but the average Wait Time/Call is low, ask clients whether the 
operations they are performing on the Server have changed. 
Adding indexes for more fields or other solution changes may be 
required. 

I/O Time/Call Time a remote call waits for disk reads or writes. If the average I/O 
Time/Call is high and the average Cache Hit % is low, you can 
increase the Database Cache Size. If the average I/O Time/Call is 
high and the average Cache Hit % is high, you can use additional 
hard drives or a RAID system on your computer.

Network (Kbytes/second) Amount of data being transferred across the network, measured in 
KB.

Open Databases Number of open databases. Use this information to configure the 
Maximum number of files to host option.
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FileMaker Server updates the statistics list at the time interval you specify. To reduce the overhead 
required to calculate statistics, you can increase the interval between each time FileMaker Server 
collects statistics. However, the statistics then become approximations of how FileMaker Server is 
actually using system resources. 

For information on configuring the statistics collection interval, see Logging and statistics settings 
(page 76).

FileMaker Server can also store statistics in a log file. See Tracking activity in log files (page 110).

Related topics
Administering clients (page 88)
Administering databases (page 93)
Logging and statistics settings (page 76)
Monitoring FileMaker Server (page 107)

Remote Calls/Second Number of separate remote calls received from all clients, divided 
by the statistics sampling interval. Note that there can be multiple 
remote calls to perform a single operation from the client's 
perspective.

Wait Time/Call Time a remote call waits for other processes.

Statistic Description
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Tracking activity in log files
FileMaker Server tracks activity and client access and other information as it operates and stores 
this information in these log files:

• Event log (page 111)

• Access log (page 115)

• Statistics log (page 116)

• Web publishing logs (page 117)

• Web Server Module log (page 118)

You can use any application capable of opening plain text files or the Mac OS Console application to 
view or print the log files. 

You can have the log file open in the Mac OS Console application when FileMaker Server is 
running. Events are logged continuously, with the most recent log entry at the bottom of the Console 
application window. 

All log files are located in the Logs folder:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Logs 

• Mac OS:/Library/FileMaker Server/Logs

Note In a multiple machine deployment, the log files are on the same machine as the FileMaker 
Server component that generates the log.

Related topics
Logging and statistics settings (page 76)
General web publishing settings (page 79)
Monitoring FileMaker Server (page 107)
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Event log
Events that occur while the Database Server is running are logged and timestamped. Typical events 
that are logged include: 

• Database Server starting and stopping 

• database files opened and closed by the Database Server

• consistency checks performed on files that were not closed properly or have not been 
opened in a FileMaker product

• new, completed, upcoming, and currently running schedules 

• pre-defined errors and conditions that the Database Server detects in your configuration

• current properties settings when the Database Server starts up, as well as settings that are 
changed during a Database Server session

Events are logged in the tab-delimited Event.log file that is created in the FileMaker Server/Data/
Logs/ folder.

You can view the Event.log file in any application that can read tab-delimited data (FileMaker Pro or 
a text editor) or the Console application (Mac OS). 

When the Event.log file reaches the Log Size specified on the Database Server > Logging tab, it is 
renamed Event-old.log and a new Event.log file is created. To configure the size of the Event.log file, 
see Logging and statistics settings (page 76).

In Windows, events are also logged in the Windows Application Log accessed with the Event 
Viewer. For more information, see Viewing activities in the Event Viewer (Windows) (page 112). 

For more information about the error conditions reported in the event log, see FileMaker Server 
event log messages (page 164).

Related topics
Changing the language of the Event log (page 113)
Tracking activity in log files (page 110)



Monitoring FileMaker Server Tracking activity in log files

FILEMAKER SERVER 9 HELP 112

Viewing activities in the Event Viewer (Windows)
To view information about FileMaker Server activities, you can use the Windows Event Viewer. To 
open Event Viewer, click Start menu > Control Panels > Administrative Tools > Event Viewer. 
Select the Application log.

In the Source column, look for events logged by FileMaker Server. Double-click an event to display 
details about it.

To save the log file contents in a text file, choose Action menu > Export List to save information 
displayed in the Event Viewer as a tab-delimited text file (.TXT) and then import the information into 
a FileMaker Pro database for further analysis.

Related topics
Event log (page 111)
Tracking activity in log files (page 110)
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Changing the language of the Event log
If you prefer to use a different language in the Event.log than the one used by your computer at the 
time you installed FileMaker Server, you can change the language of the Event.log by modifying a 
preferences file (Mac OS) or the registry (Windows) on the master machine. 

In the steps below, you can change the locale setting to the name of one of the following supported 
languages exactly as shown here: English, French, German, Japanese, Italian, or Swedish. 
(Locale names are case-sensitive.)

To change the language used for the Event.log (Mac OS): 

Important The following procedure is recommended only for advanced users who are familiar with 
the Terminal application. You must be logged in as the root user. 

1. Start the Terminal application (/Applications/Utilities/Terminal/).

2. Stop the Database Server. For more information, see Starting and stopping FileMaker 
Server (page 51).

3. Log in as the root user.

4. Navigate to the .plist file in the following location:

/Library/FileMaker Server/Library/Preferences/ByHost 

5. In the line after <key>System Locale</key>, change the name of the locale to one of 
the values given above. 

For example, change <string>Japanese</string> to <string>French</string>. 

6. Save your changes.

7. Restart the Database Server for the change to take effect.

The next time you open Event.log, the entries will appear in the new language. 

To change the language used for the Event.log (Windows): 

Important The following procedure is recommended only for advanced users who are familiar with 
the Windows registry. You must be logged in with an account that has administrator privileges. 

1. Stop the Database Server. For more information, see Starting and stopping FileMaker 
Server (page 51).

2. Start Registry Editor.

Click Start button > Run. In the Run dialog box, enter regedit. 

Tip Use Registry Editor to export a copy of the registry before you continue.

3. In Registry Editor, find the following key:

HKEY_LOCAL_MACHINE\SOFTWARE\FileMaker\FileMaker Server\9.0\Preferences 

4. In this key, double-click the SystemLocale entry.

5. Change the value of the SystemLocale entry to one of the values given above, then click 
OK.

For example, change Japanese to French. 

6. Exit Registry Editor.
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7. Restart the Database Server for the change to take effect.

The next time you open Event.log, the entries will appear in the new language. 

Related topics
Event log (page 111)
Tracking activity in log files (page 110)
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Access log
The Database Server logs accesses to databases in a separate log file called Access.log. Typical 
events that are logged include: 

• clients that connect to and disconnect from the Database Server

• databases that clients access with a unique account and with the built-in Guest account

Accesses are logged in the tab-delimited Access.log file that is created in the FileMaker Server/
Data/Logs/ folder.

You can view the Access.log file in any application that can read tab-delimited data (FileMaker Pro 
or a text editor) or the Console application (Mac OS). 

When the Access.log file reaches Log Size specified on the Database Server > Logging tab, it is 
renamed Access-old.log and a new Access.log file is created. 

To configure access logging, see Logging and statistics settings (page 76).

Related topic
Tracking activity in log files (page 110)



Monitoring FileMaker Server Tracking activity in log files

FILEMAKER SERVER 9 HELP 116

Statistics log
When you enable statistical logging for the Database Server, a log file is created in the FileMaker 
Server/Data/Logs/ folder. All of the values that you see in the Statistics pane in Admin Console are 
timestamped and written to a file. See Viewing statistics (page 108).

You can view these statistics by opening the Stats.log file in any application that can read tab-
delimited data (FileMaker Pro or a text editor) or the Console application (Mac OS). 

When the Stats.log file reaches Log Size specified on the Database Server > Logging tab, it is 
renamed Stats-old.log and a new Stats.log file is created. 

To configure statistics logging, see Logging and statistics settings (page 76).

Related topic
Tracking activity in log files (page 110)
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Web publishing logs
The Web Publishing Engine generates the following log files:

• The wpc_access_log.txt access log is a record of all end-user requests to generate XML 
and to use FileMaker Server Instant Web Publishing. These requests are routed from the 
web server directly to the Web Publishing Core component of the Web Publishing Engine.

• The pe_internal_access_log.txt access log is a record of all internal XML requests that the 
XSLT-CWP software component of the Web Publishing Engine makes while processing 
XSLT requests. These requests are routed internally within the Web Publishing Engine from 
the XSLT-CWP software component to the Web Publishing Core software component.

• The pe_application_log.txt application log file is a record of Web Publishing Engine error, 
ScriptMaker script, and user log information.

• The error log information describes any unusual Web Publishing Engine errors that 
have occurred. Common errors reported to the web user, such as “Database not open,” 
are not recorded.

• The script log information describes any errors generated when web users execute 
scripts. For example, it lists script steps that are skipped if they’re not web-compatible.

• The user log messages contains messages generated by the XSLT <xsl:message> 
element in XSLT stylesheets. Whenever web users access your XSLT stylesheet, 
information you’ve included within a <xsl:message> element is recorded in the 
application log file. 

To configure logging for web publishing, see General web publishing settings (page 79).

Note For more information on web publishing logs, see FILEMAKER SERVER CUSTOM WEB 
PUBLISHING WITH XML AND XSLT and FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP on the 
Start Page.

Related topic
Tracking activity in log files (page 110)
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Web Server Module log
If the web server is unable to connect to the Web Publishing Engine, the Web Server Module 
generates a log file that is a record of any errors with its operation. This file is called 
web_server_module_log.txt and is located in the FileMaker Server/Logs/ folder on the machine 
running the web server.

Related topic
Tracking activity in log files (page 110)
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Managing plug-ins
FileMaker Server can use external function plug-ins with hosted FileMaker Pro databases that are 
designed to use server-side plug-ins. When hosted databases use plug-ins enabled on FileMaker 
Server, the machine running FileMaker Server can execute plug-in functions rather than client 
machines. 

Alternatively, FileMaker Server can automatically install or update required or outdated client-side 
plug-ins on FileMaker Pro clients. 

Notes
• For information on solving calculations on a host machine, see FileMaker Pro Help.

• For information about developing third-party FileMaker plug-ins, see the FILEMAKER PRO 
ADVANCED DEVELOPMENT GUIDE available at www.filemaker.com/downloads.

Related topics
Enabling server-side plug-ins (page 120)
Enabling auto-update for plug-ins (page 123)

http://www.filemaker.com/downloads
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Enabling server-side plug-ins
Server-side plug-ins can provide external functions used in the following:

• stored calculations or server-side queries

• ScriptMaker scripts that are scheduled to run on FileMaker Server (see Running 
ScriptMaker scripts (page 131))

To enable plug-ins on FileMaker Server:
1. Place plug-ins in the proper folders so that FileMaker Server can use them.

For details, see Folders for server-side plug-in files (page 121).

2. In Admin Console, click the Database Server > Server Plug-ins tab. 

3. Select Enable FileMaker Server to use plug-ins.

The list shows the plug-ins that are in the plug-in folder.

4. Select Enabled for each plug-in that you want to execute on FileMaker Server.

5. Click Save.

Notes
• Some plug-ins (and the libraries they reference) load only when the process is executed by 

a user who is logged into the system; FileMaker Server executes as a service (Windows) or 
a daemon (Mac OS), not as a user process. Consequently, developers need to write plug-
ins differently to work with FileMaker Server. Users will need to see their operating system 
documentation to find which libraries are typically available.

• If a web publishing solution uses a plug-in, you must place a copy of the same plug-in in a 
folder on the machine running the Web Publishing Engine (even if the Web Publishing 
Engine is running on the same machine as the Database Server).

Related topic
Managing plug-ins (page 119)
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Folders for server-side plug-in files
To enable the Database Server to use plug-ins, you must place them in the proper folder on the 
master machine in your FileMaker Server deployment.

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Database Server\Extensions\

• Mac OS: /Library/FileMaker Server/Database Server/Extensions/

If a web publishing solution uses a plug-in, you must place a copy of the same plug-in in a folder on 
the machine running the Web Publishing Engine (even if the Web Publishing Engine is running on 
the same machine as the database server). 

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Web Publishing\publishing-
engine\wpc\Plugins\

• Mac OS: /Library/FileMaker Server/Web Publishing/publishing-engine/wpc/Plugins/

Notes
• For FileMaker Server on Mac OS, you must set the correct file permissions for plug-ins. See 

Changing plug-in file permissions (Mac OS) (page 122).

• You must install the plug-ins for the Web Publishing Engine in addition to any plug-ins you 
may have installed for FileMaker Server or FileMaker Pro, even if they are the same plug-
ins. 

• If the Plugins folder does not exist, you must create it. Plug-in files placed in this folder or 
subfolders must be owned by the fmsadmin group and be group readable and executable.

Related topic
Enabling server-side plug-ins (page 120)
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Changing plug-in file permissions (Mac OS)

To change plug-in file permissions: 
1. Start the Terminal application and use the cd command to set your path as needed.

2. Enter the following at the command line:

chmod g+rx <filepath>

or

chmod g+wrx <filepath>

The g+rx is necessary because plug-ins and system-level scripts must have the group read and 
executable bits enabled. Use the g+wrx form to permit write permission as well. Some plug-ins or 
scripts that use preferences or folders of additional files may require write permission to those files 
or folders.

Related topics
Folders for server-side plug-in files (page 121)
Enabling auto-update for plug-ins (page 123)
Enabling server-side plug-ins (page 120)
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Enabling auto-update for plug-ins
If database files hosted on FileMaker Server use plug-ins that are designed to execute on the client, 
you can enable the Auto Update plug-in feature in both FileMaker Server and FileMaker Pro clients. 
This feature enables FileMaker Server to automatically install or update required or outdated plug-
ins or support files on FileMaker Pro clients. 

To automatically update a plug-in:
1. Copy the plug-in or support file to the master machine in your FileMaker Server deployment.

Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Data\Databases\AutoUpdate\

Mac OS: /Library/FileMaker Server/Data/Databases/AutoUpdate/

2. (Mac OS) Plug-ins installed on FileMaker Server for Mac OS must also be owned by the 
group fmsadmin and have group read permission. 

Note Convert plug-ins to .tar file format to be placed on FileMaker Server for Mac OS. See 
Preparing Mac OS plug-in files for conversion to .tar format (page 124).

3. In Admin Console, click the Database Server > FileMaker Pro Clients tab, then select 
Allow FileMaker Pro clients to download updates automatically.

4. In FileMaker Pro, users must enable the Auto Update feature in the Plug-Ins tab in the 
Preferences dialog box.

For more information on updating plug-ins, see FileMaker Pro Help.

For more information on preparing a plug-in and a database for the Auto Update feature, see the 
FILEMAKER SERVER GUIDE TO UPDATING PLUG-INS on the Start Page.

Related topics
Changing plug-in file permissions (Mac OS) (page 122)
Managing plug-ins (page 119)
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Preparing Mac OS plug-in files for conversion to .tar format
FileMaker Server on Mac OS temporarily converts an uncompressed Mac OS plug-in to the .tar 
format for downloading to clients. However, this automatic conversion deletes any resource forks, 
which may make a plug-in that contained a resource fork unusable by the client.

Mac OS plug-in files that contain a resource fork require special actions to work properly with Auto 
Update:

• The plug-in must be manually compressed before being placed on FileMaker Server.

• Any Mac OS FileMaker Pro client using Auto Update with this plug-in must have StuffIt 
Expander installed to automatically decompress the plug-in.

To manually compress a plug-in containing a resource fork:
1. Use a third-party utility like StuffIt Standard to manually compress the entire Mac OS plug-in 

into a single file such as a .sitx archive. You can use any utility that compresses files with 
resource forks, as long as the output file can be automatically decompressed by StuffIt 
Expander.

2. Rename the compressed file with the .sitx or other extension to end with .tar. For example, if 
the plug-in is named test.fmplugin, and the compressed file is named 
test.fmplugin.sitx, that compressed file must be renamed to test.fmplugin.tar.

3. Place the compressed plug-in on the server computer in the appropriate folder. See Folders 
for server-side plug-in files (page 121). 

Important StuffIt Expander must be installed on the Mac OS client computer to expand the 
specially compressed plug-in. Auto Update automatically calls StuffIt Expander after downloading 
the plug-in. StuffIt Expander is available from www.allume.com. 

Related topic
Enabling auto-update for plug-ins (page 123)

http://www.allume.com
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Securing your data
You can take advantage of several FileMaker Server features that make your data more secure for 
both FileMaker Pro and web clients: 

• Encrypt the connection between the Database Server and FileMaker Pro clients and 
between the Database Server and the Web Publishing Engine. Both user account 
information and the data are secured using Secure Sockets Layer (SSL) encryption. Click 
Database Server > Security tab and enable Secure connections to FileMaker Server. 
See Database Server security settings (page 70).

• If you’re publishing databases to web-based clients, enable SSL encryption on the web 
server to encrypt data that is passed from the web server to guest computers on the web. 

If you enable SSL on the web server, then you must use the Deployment assistant to configure 
FileMaker Server to use the HTTPS protocol to communicate with the web server. The 
Deployment assistant tries to detect your web server using the HTTP protocol, so if your web 
server uses HTTPS, the Deployment assistant fails to detect the web server and prompts you 
for more information. In the Deployment assistant’s Web Server Test Failed step, select 
HTTPS and continue. See Changing a FileMaker Server deployment (page 28). 

For information on enabling and configuring SSL on your web server, review the web server 
documentation.

• You can enable and disable specific extended privileges, such as PHP, XML, XSLT, and 
Instant Web Publishing for the Web Publishing Engine. For example, if you know that all 
files on one server will be shared with Custom Web Publishing with PHP, you can disable all 
other types of web publishing. Even if a file includes extended privileges that allow access 
to XML data, access to XML data is not available while the file is hosted with that FileMaker 
Server deployment. To enable or disable any web publishing technology for all files on 
FileMaker Server, click Web Publishing, then click either the PHP, XSLT, XML, or Instant 
Web Publishing tab. On each of these tabs, you can enable or disable web publishing for 
all hosted databases even if they have the corresponding extended privilege enabled. See 
Configuring web publishing settings (page 78).

• You can enable FileMaker Server to authenticate users via an external authentication server 
such as Apple Open Directory or Windows Active Directory. For more information, see 
External authentication for database access (page 72).

• Enable FileMaker Server log files to monitor accesses to databases. See Tracking activity in 
log files (page 110). 

Note See “Creating accounts that authenticate via an external server” in FileMaker Pro Help and 
www.filemaker.com/support/security for more information.

http://www.filemaker.com/support/security
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Scheduling administrative tasks
The Schedules pane lists the scheduled tasks performed on databases hosted by FileMaker 
Server. Scheduled tasks run automatically if Allow Enabled Schedules to Run is selected and the 
selected schedule is enabled. See Enabling and disabling schedules (page 140).

Viewing scheduled tasks details
The list displays a summary of each defined schedule, including the task it performs, the last time it 
ran, and the next time it will run.You can view selected schedule details in Details for. 

Managing scheduled tasks
Select a schedule, choose one of the following Actions, then click Perform Action:

You create or edit schedules with the Schedule assistant. The Schedule assistant guides you 
through the steps to specify the scheduled task details, set the frequency, and send an email 
notification when the scheduled task is completed. For information about creating and editing 
scheduled tasks, click the Help button in the Schedule assistant.

For Actions, choose To

Create a schedule Run the Schedule assistant to create one of the following 
scheduled tasks:

• Back Up Databases: back up all hosted databases, 
databases in selected folders, or selected databases. See 
Scheduling database backups (page 128).

• Run Script: Run ScriptMaker scripts (see Running 
ScriptMaker scripts (page 131)) or system-level script 
files (see Running system-level script files (page 132)).

• Send Message: Send messages to clients of hosted 
databases. See Sending scheduled messages to clients 
of hosted databases (page 133).

Edit a schedule Run the Schedule assistant to change scheduled tasks. See 
Editing schedules (page 136).

Duplicate a schedule Duplicate an existing schedule. See Duplicating a schedule (page 
137).

Delete selected schedules Delete the selected schedules. See Deleting a schedule (page 
138).

Run a schedule now Run the selected schedule immediately. See Running a schedule 
manually (page 139)

Enable all schedules Enable all listed schedules. See Enabling and disabling schedules 
(page 140).

Disable all schedules Disable all listed schedules. See Enabling and disabling 
schedules (page 140).

Enable selected schedules Enable selected schedules. See Enabling and disabling 
schedules (page 140).

Disable selected schedules Disable selected schedules. See Enabling and disabling 
schedules (page 140)
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Notes
• A new scheduled task is enabled by default, which means the task will automatically run at 

its scheduled time. For more information about enabling and disabling scheduled tasks, see 
Enabling and disabling schedules (page 140).

• To sort scheduled tasks in a list in ascending or descending order, click a column heading.

• To resize the width of a column, select the column heading border and drag it horizontally.

• You can define up to 50 schedules in FileMaker Server. 

• When a scheduled task completes, FileMaker Server can send an email notification, if you 
enable this feature for a specific schedule. See Enabling email notifications in schedules 
(page 147). 

• FileMaker Server adds entries in the Events.log file when a scheduled task runs. See 
Tracking activity in log files (page 110).

• FileMaker Server puts tasks and file-related commands from Admin Console and the 
command line interface into the following separate queues:

• Back up Database tasks and file-related commands (for example, Open, Close, Pause, 
and Resume). Only one task or command runs at one time from this queue. The 
remaining tasks or commands are delayed until the current one is complete. 

• Send Message and Run Script tasks (ScriptMaker scripts and system-level script files). 
Multiple tasks can run at the same time from this queue.

FileMaker Server runs tasks from both queues at the same time. For example, the first queue 
has a Back Up Database task and a Pause command. The second queue has a Run Script task 
and a Send Message task. FileMaker Server runs the Back Up Database, Run Script, and Send 
Message tasks at the same time. The Pause command is not executed until the Back Up 
Database task completes.

Related topics
Email notification settings (page 57)
Default folder settings (page 73)
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Scheduling database backups 
You can back up all hosted databases, databases in selected folders, or a selected database.

Database backups are saved in the default backup folder or in a folder that you specify. You can set 
the path in the Schedule assistant.

During backups, FileMaker Server copies the database while it is active. Users can continue to 
make modifications. When the copy is complete, the database pauses to synchronize backup files 
with the current database and then the database resumes. In the Schedule assistant, you can also 
specify whether to perform a consistency check on the backup file and receive email notifications 
when backups are complete.

The destination disk that stores your hosted files and backups must have plenty of free space. If the 
hard disk runs out of space while a file is being modified or if a database file reaches the 8 terabytes 
size limit, the file will be compressed. Compression may take some time to complete.

If the hard disk runs out of space during a backup, the backup stops, the backup file is deleted, and 
FileMaker Server logs an error in Event.log. You should check the Schedules list for error 
conditions, which are reported in the Last Run Status. To avoid running out of disk space when 
backing up files, choose a different hard disk as your backup destination, or move completed 
backups to offline storage.

For more information about backups, see Tips for database backups (page 129).

Related topics
Creating schedules (page 134)
Tracking activity in log files (page 110)
Default folder settings (page 73)
Scheduling administrative tasks (page 126)
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Tips for database backups
Develop plans for restoring data, including alternate sites and systems to run business-critical 
information services. A current backup can help you recover from a situation where someone loses 
the administrator account information for a file, or where user error (and sometimes bad database 
design) causes data to be deleted or modified inappropriately.

Keep the following in mind:

• Host databases with FileMaker Server and create regularly-scheduled, automated backups.

Don’t use third-party backup software on hosted FileMaker Pro databases. First, use FileMaker 
Server to make a backup copy of your database, then run your third-party backup software on 
the copy. Backup software can damage open, hosted databases.

For example, make local backups of files at 6:00 AM, 9:00 AM, 12:00 noon, 3:00 PM, 6:00 PM, 
and 11:30 PM weekdays. At midnight, make an incremental backup of the entire system 
(excluding active hosted databases) to the enterprise backup system. Finally, Friday night at 
midnight, perform a full system backup, excluding active hosted databases or stop the Database 
Server during the backup. 

Copy and store the backup media at a remote location. This way, if the server goes down for 
some reason other than catastrophic failure of multiple drives, the more recent backup of the 
data files can be used, meaning a maximum of 3 hours of lost data. If there is a catastrophic 
drive failure, then you can use the previous evening’s backup media, minimizing the loss to one 
day’s data. 

• In the Schedule assistant, you can enable Verify backup integrity. After a backup is 
complete, FileMaker Server performs a consistency check, confirming whether the backup 
file is the same as the hosted file. Enabling this check can detect errors in the backup file 
and send you email notification when the check is complete. However, backup operations 
that have this option enabled can take much longer to complete and may slow other 
activities on the master machine.

• Make sure backup copies aren’t damaged or inaccessible. Verify that they are functioning 
properly before you need them. Run diagnostic tools on your hard drive and your backup 
files regularly.

• Ensure that you can restore an entire set of files from backup copies.

• Regularly export the data to protect against file corruption.

• Protect the backup media. Store backups in a separate fire-proof location.

• Assign backup administrators who can retrieve files, in case the network administrator is 
unavailable.

Important In the event of a server failure, such as an unexpected loss of power, hard drive failure, 
or software failure, use the backup files. Any system failure causing FileMaker Server to shut down 
inappropriately can result in corrupted files if cached data was not written to disk and the files were 
not closed properly. Even if the files re-open and go through a consistency check or recovery, 
corruption might be buried in the file. File recovery cannot guarantee that problems have been fixed. 
For information on recovering damaged files, see FileMaker Pro Help.

Related topics
Examples of repeating schedules (page 135)
Scheduling database backups (page 128)
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Running server-side scripts
FileMaker Server can run two types of scripts to automate administrative tasks:

• ScriptMaker scripts defined in hosted databases. See Running ScriptMaker scripts (page 
131).

• System-level script files. See Running system-level script files (page 132).

Both types of scripts execute on the master machine in your FileMaker Server deployment.

To run a script, create a scheduled task on FileMaker Server. Specify the script, and when and how 
often to run the script. As with any schedule, you can run the scheduled task manually at any time.

Related topic
Scheduling administrative tasks (page 126)
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Running ScriptMaker scripts
FileMaker Server can run ScriptMaker scripts that are defined in hosted databases. You create a 
Run Script scheduled task, specify the database and the FileMaker account to use to run the script, 
choose a script defined in the database, and when to run the script. ScriptMaker scripts that run on 
FileMaker Server can do simple or complex tasks, for example:

• perform a field recalculation across all records

• process and archive new transactions nightly

• remove duplicate records before a scheduled backup

You use the ScriptMaker feature in FileMaker Pro to build scripts by selecting from a list of web-
compatible FileMaker Pro commands, called script steps, and specifying options. To run a 
ScriptMaker script on FileMaker Server:

• The script should include web-compatible script steps. 

• The script must be defined in a database file that is hosted on FileMaker Server. See 
Hosting databases (page 31).

For information about creating ScriptMaker scripts with web-compatible script steps, see 
FileMaker Pro Help.

Notes
• If scripts contain steps that are unsupported, for example, steps that are not web-

compatible, use the Allow User Abort script step to determine how subsequent steps are 
handled.

• If the Allow User Abort script step option is enabled (On), unsupported script steps will 
stop the script from continuing.

• If the Allow User Abort script step is disabled (default), unsupported script steps are 
skipped over and the script continues to execute.

• If this script step is not included, scripts are executed as if the feature is enabled, so 
unsupported script steps will stop scripts.

Some script steps have options that are skipped, such as an option to show a dialog box. The 
Event.log file contains detailed information about errors or script steps that are skipped when 
FileMaker Server runs ScriptMaker scripts. See Tracking activity in log files (page 110).

• Server-side ScriptMaker scripts run in separate sessions on the Database Server, behaving 
like they do for Custom Web Publishing. Each session has a its own copy of global fields 
and variables. Calculation functions return the same values as when scripts run under 
Custom Web Publishing, with the following exceptions:

• Get(AccountName) initially returns the account name that the script was run under 
(specified in the Schedule assistant when the schedule is created).

• Get(UserName) returns the schedule name.

• Get(ApplicationVersion) returns the Database Server version string.

• Functions related to hardware, such as Get(SystemIPAddress), return information from 
the Database Server.

Related topics
Creating schedules (page 134)
Running server-side scripts (page 130)
Scheduling administrative tasks (page 126)
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Running system-level script files
FileMaker Server can run system-level script files, such as Windows batch, Mac OS shell scripts, 
Perl, or VBScript files. You create a Run Script scheduled task, specify the script file, and when to 
run the script. Use system-level scripts to perform tasks outside of FileMaker Server. 

To run a script as a scheduled task, you must place the system-level script file in the FileMaker 
Server Scripts folder:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Data\Scripts\

• Mac OS: /Library/FileMaker Server/Data/Scripts/

For information about creating system-level scripts, see the documentation for the scripting 
language you want to use.

Notes
• In Mac OS, you may need to modify file permissions for shell scripts. Your shell script is 

executed with the fmserver user ID and fmsadmin group ID, so your script file must have 
read and execute permissions for the fmsadmin group. Therefore, you cannot call some 
privileged commands from your scripts. For example, your script does not have access to 
the /etc folder. 

• Enable some form of logging in your script so that you can troubleshoot possible 
permissions issues. Refer to the Apple website for information on creating log files in 
Mac OS.

Related topics
Users, groups, and permissions (Mac OS) (page 36)
Creating schedules (page 134)
Running server-side scripts (page 130)
Scheduling administrative tasks (page 126)
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Sending scheduled messages to clients of hosted 
databases 

You can create a message and set up a schedule to deliver the message to FileMaker users. 
Messages can notify users about important events such as server shutdowns, database upgrades, 
or deadline reminders.

You can send messages to:

• All FileMaker Pro users currently connected to hosted databases

• FileMaker Pro users connected to databases in a selected folder

• FileMaker Pro users connected to a selected database

Related topics
Creating schedules (page 134)
Scheduling administrative tasks (page 126)
Sending messages to FileMaker Pro clients of selected databases (page 95)
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Creating schedules
The following are general steps for creating a scheduled task. For detailed instructions and 
procedures, click the Schedule assistant help button.

To create a scheduled task:
1. Choose Schedules. 

2. For Actions, select Create a schedule.

3. Click Perform Action to open the Schedule assistant.

4. Specify schedule details. Click Finish in the Schedule assistant to save changes to the 
schedule.

For more information, click the Help button in the Schedule assistant.

5. Select Enabled next to the schedule to enable it to run.

Related topics
Examples of repeating schedules (page 135)
Running a schedule manually (page 139)
Scheduling administrative tasks (page 126)
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Examples of repeating schedules
The following examples show how schedules work when they run more than once. For a schedule 
created and enabled at 4:30 PM today, assuming today is Friday:

Notes
• Start/end dates and start/end times are inclusive. The last time a schedule can run is at the 

scheduled end time on the scheduled end date.

• The start time and end time of a schedule must fall within the same day. If you want a 
schedule to run repeatedly overnight, create two schedules. For example, to back up 
databases hourly between 9:00 PM and 5:00 AM starting every Friday night and running 
overnight, create one schedule that backs up every Friday, every hour, starting at 9:00 PM 
and ending at 11:00 PM, and another schedule that backs up every Saturday, starting at 
12:00 AM and ending at 5:00 AM.

Related topics
Selecting the schedule frequency (page 145)
Creating schedules (page 134)
Editing schedules (page 136)
Scheduling administrative tasks (page 126)

A schedule defined this way Runs at these times 

A Daily schedule that runs once per day 
at 5:00 PM, with an end date of 12/31/2008

The first time is at 5:00 PM today, Friday.

The next time is at 5:00 PM tomorrow, Saturday. 

The schedule continues to run once daily at 5:00 PM, 
with its final run at 5:00 PM on 12/31/2008.

A Daily schedule that runs every hour 
with a start time of 9:00 AM and end time 
of 5:00 PM, with no end date specified

The first time is today, Friday, at 5:00 PM.

The next times are at 9 AM, 10 AM, 11 AM, 12 PM, 1 
PM, 2 PM, 3 PM, 4 PM and 5 PM tomorrow, 
Saturday. 

The schedule continues to run daily, every hour 
starting at 9 AM and ending at 5 PM, inclusive.

A Weekly schedule that runs once per 
day at 5:00 PM, every Friday, with an end 
date of 12/31/2008 

The first time is today, Friday, at 5:00 PM.

The next time is next Friday at 5:00 PM.

The schedule continues to run once every Friday at 
5:00 PM, with its final time at 5:00 PM on 12/26/2008 
(the last Friday before the end date).

An Every n days schedule that runs every 
three days, every hour, with a start time 
of 9:00 AM and end time of 5:00 PM, with 
no end date specified

The first time is today, Friday, at 5:00 PM.

The next time is next Monday at 9:00 AM, and every 
hour that day until 5:00 PM, inclusive. 

The schedule continues to run every three days 
every hour starting at 9 AM and ending at 5 PM, 
inclusive.
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Editing schedules
The following are general steps for editing a scheduled task. For detailed instructions and 
procedures, click the Schedule assistant help button.

To edit a schedule:
1. Choose Schedules, then select a schedule from the list. 

2. For Actions, select Edit a schedule.

3. Click Perform Action to open the Schedule assistant.

4. Make changes to the schedule. Click Finish in the Schedule assistant to save changes to 
the schedule.

For more information, click the Help button in the Schedule assistant.

5. Select Enabled next to the schedule to enable it to run.

Related topics
Enabling and disabling schedules (page 140)
Examples of repeating schedules (page 135)
Running a schedule manually (page 139)
Scheduling administrative tasks (page 126)
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Duplicating a schedule
Sometimes it is easier to duplicate and edit an existing schedule rather than define a new schedule. 

To duplicate an existing schedule: 
1. Choose Schedules, then select a schedule from the list.

2. For Actions, select Duplicate a schedule.

3. Click Perform Action.

The selected schedule is copied with the name <schedule name> Copy.

Tip You can rename the schedule in the Schedule assistant. For Actions, select Edit a 
schedule to open the Schedule assistant and change the schedule name.

Related topics
Editing schedules (page 136)
Deleting a schedule (page 138)
Scheduling administrative tasks (page 126)
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Deleting a schedule

To delete a schedule:
1. Choose Schedules.

2. Select one or more schedules from the list.

3. For Actions, select Delete selected schedules.

4. Click Perform Action.

Click Yes to confirm that you want to delete the selected schedules.

Related topics
Editing schedules (page 136)
Duplicating a schedule (page 137)
Scheduling administrative tasks (page 126)
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Running a schedule manually
You can run a schedule manually even in cases where it will not run automatically or it is disabled. 
For example, you can run a schedule manually when:

• You have disabled a given schedule by clearing Enabled 

• You have disabled all schedules by clearing Allow enabled schedules to run
• A schedule is disabled because its final scheduled run has already occurred. The Last Run 

column is updated with the time at which you manually ran the schedule. The Next Run 
column will remain Disabled.

To run a schedule manually:
1. Select Schedules, then select a schedule from the list.

2. For Actions, select Run a schedule now.

3. Click Perform Action.

The Last Run column displays the current date and time of the computer FileMaker Server is 
running on.

Related topics
Enabling and disabling schedules (page 140)
Scheduling administrative tasks (page 126)
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Enabling and disabling schedules
You can enable or disable specific schedules or you can disable all schedules at once.

Related topics
Running a schedule manually (page 139)
Scheduling administrative tasks (page 126)

To Do this

Enable a schedule 
when creating or 
editing it

If you use the Schedule assistant to create a schedule, the scheduled 
task is enabled by default.

Enable a schedule that 
was disabled

In the Schedules pane, select the empty checkbox to the left of the 
schedule name.

Note If the schedule’s final run time has already occurred, you must edit 
the run time before it can be enabled again.

Disable a selected 
schedule

In the Schedules pane, clear the checkbox to the left of the schedule 
name. 

Prevent all schedules 
from running

In the Schedules pane, clear Allow enabled schedules to run.

This option is convenient for performing administrative tasks on the 
server computer. 

This setting overrides any individual schedule settings you have 
enabled.

Allow enabled 
schedules to run

In the Schedules pane, select Allow enabled schedules to run.

A checkmark indicates that all scheduled tasks that are individually 
checked in the scheduled task list are enabled.

Scheduled tasks that were individually disabled are not re-enabled until 
you enable them individually.
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Selecting a task
In this Schedule assistant step, select a task to perform.

To select a task:
1. Select one of the task options:

2. Click Next.
Click Cancel to exit the Schedule assistant.

Related topics
Scheduling database backups (page 128)
Running server-side scripts (page 130)
Sending scheduled messages to clients of hosted databases (page 133)
Scheduling administrative tasks (page 126)

Choose To

Back Up Databases Back up one or more hosted databases.
Run Script Run a ScriptMaker or system-level script on FileMaker Server.
Send Message Send a message to one or more FileMaker Pro users connected to 

a hosted database. The message appears in a dialog box within 
FileMaker Pro. 
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Database backup schedule
In this Schedule assistant step, choose a preset backup schedule or a custom schedule. You can 
choose a preset schedule as a starting point and change the details later in the Schedule assistant.

To select a backup schedule:
1. Select a preset or a custom backup schedule:

2. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topics
Scheduling database backups (page 128)
Default folder settings (page 73)
Scheduling administrative tasks (page 126)

Choose To

Hourly Back up all databases to the default backup folder daily, every hour 
from 8 am to 5 pm.

Daily Back up all databases to the default backup folder once daily, 
starting at 11 pm.

Weekly Back up all databases to the default backup folder once weekly, 
starting at 11 pm.

Custom Create a custom backup schedule.
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Selecting databases
In this Schedule assistant step, choose which databases to back up in this schedule.

To choose databases to back up:
1. Choose the databases to back up:

2. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topics
Scheduling database backups (page 128)
Scheduling administrative tasks (page 126)

Choose To

All Databases Back up all databases in the default database folder and the 
additional database folder, including databases in subfolders. 
For information about the additional database folder, see 
Default folder settings (page 73).

Databases in Folder Back up all databases in the selected folder.
Select a Database Back up the selected database. Select only one database file.
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Selecting the backup folder
In this Schedule assistant step, be sure to specify a backup folder that is not the same as the default 
database folder or the optional additional database folder. Otherwise, your backed up files could 
accidentally be hosted when FileMaker Server starts up.

To select the backup folder:
1. For Backup Folder, enter the path to the backup folder. 

You can specify the path to your own backup folder or use the default backup folder. To specify 
the path, enter:

Windows: filewin:/pathname-to-backup-folder/

Mac OS: filemac:/pathname-to-backup-folder/

Note Click Restore to undo changes made to the path.

2. Click Validate to verify that the path of the backup folder exists and is accessible. If the path 
is not valid, see Tips for valid folders (page 75). 

3. For Verify Backup, select Verify backup integrity to check whether the backup file is the 
same as the hosted file.

If you choose to send email notification later in the Schedule assistant, the status of this check is 
included in the email message.

For more information, see Tips for database backups (page 129).

4. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Note You can configure the default backup folder that appears in this step of the Schedule 
assistant. See Default folder settings (page 73).

Related topics
Scheduling database backups (page 128)
Scheduling administrative tasks (page 126)
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Selecting the schedule frequency
In this Schedule assistant step, specify when and how often to run the scheduled task.

To specify the schedule frequency:
1. For Frequency, choose Daily, Every n days, Once Only, or Weekly.

2. Specify the Schedule Details, which depend on the frequency selected:

For more information, see Examples of repeating schedules (page 135).

3. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topic
Scheduling administrative tasks (page 126)

Choose To

Start date Select the start date for this schedule. Click the calender to select a date.
End date Select End Date and enter an optional ending date for this schedule. 

Click the calender to select a date.
Once per day Run the schedule at the selected Start Time. Enter the time of day to 

start.
Run every Run the schedule at the interval specified in Hours or Minutes. You can 

also specify when to start and end running the schedule by selecting the 
Start Time and End Time.

Days Select the days of the week to run the schedule.
Start time Select the start time to run the schedule.
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Naming the schedule
In this Schedule assistant step, specify a unique name for this schedule. This is the name that 
appears in the Schedules pane.

To name the schedule:
1. Enter a Schedule Name.

Note The schedule name can contain up to 31 characters.

2. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topic
Scheduling administrative tasks (page 126)
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Enabling email notifications in schedules
In this Schedule assistant step, you can enable a schedule to send an email notification when a task 
is completed. 

To enable email notification:
1. Select Send email notification.

2. Enter the email addresses that you want to notify.

You can enter multiple addresses separated by a comma.

Example: user1@email.com,user2@email.com,...

3. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Notes
• Email notifications are sent whether the schedule completes successfully or not. If email 

notification for errors or warnings is enabled on the General Settings > Email Notification 
tab, a second email message is sent to the email addresses specified on the tab. If an email 
address appears on both lists, the addressee receives two email messages about the same 
event. See Receiving email notifications only when a schedule fails (page 148).

• Email notification requires the SMTP server configuration settings specified on the General 
Settings > Email Notification tab. The SMTP server settings are checked when this 
Schedule assistant pane is displayed. If the SMTP server has not been configured, the 
Schedule assistant opens a dialog box prompting you to configure the SMTP server after 
this schedule is created.

Related topic
Scheduling administrative tasks (page 126)
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Receiving email notifications only when a schedule fails
Administrators may want to receive email notifications only when a scheduled task fails. If you 
enable email notifications for a scheduled task, all addressees receive emails every time the task 
completes, whether the task fails or succeeds. To stop receiving these email messages, you can 
disable email notifications (or remove your email address from the list) for a specific schedule using 
the Schedule assistant.

Because FileMaker Server adds an entry in the Events.log file whenever a schedule fails, you can 
enable notifications for warnings and errors and receive an email only when a schedule fails.

To receive email notification only when a schedule fails to complete: 
1. Create a new schedule or edit an existing schedule.

For instructions on creating or editing a scheduled task, see Creating schedules (page 134) or 
Editing schedules (page 136). 

2. Confirm the schedule settings in each step and click Next in the Schedule assistant until 
you reach the Enable Email Notifications step.

3. To disable all email notifications for this schedule, clear Enable email notification.

To continue sending email notifications to other addressees, leave email notifications enabled 
but remove the email addresses that you don’t want to receive email notifications.

4. Click Next, then Finish.

5. Choose the General Settings > Email Notifications tab. 

6. Select Enable email notifications.

7. Choose Warnings or errors to send email notifications. 

8. For Send Email Notifications to, enter the email address that you want to receive email 
notifications of errors and warnings.

Related topics
Enabling email notifications in schedules (page 147)
Tracking activity in log files (page 110)
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Reviewing schedule details
In this Schedule assistant step, review the details of this schedule, then optionally enable this 
schedule to run at the times specified.

To review and enable the schedule:
1. Review the details. Select Back to return to the previous steps to change the schedule 

settings.

2. Select Enable this schedule.

3. Click Finish to save the schedule.

Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topic
Scheduling administrative tasks (page 126)
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Selecting the script type
In this Schedule assistant step, you can choose to run a ScriptMaker script or a system-level script 
on FileMaker Server. For more information, see Running server-side scripts (page 130).

Place system-level script files in the Script folders before starting the Schedule assistant:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Data\Scripts\

• Mac OS: /Library/FileMaker Server/Data/Scripts/ 

To select the script type:
1. Select the Script Type:

2. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topic
Scheduling administrative tasks (page 126)

Choose To

ScriptMaker Script Run a ScriptMaker script defined in a hosted database.
System-Level Script Run a system-level script file — such as Windows batch, Mac OS 

shell scripts, Perl, or VBScript file — that is in the Scripts folder.
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Selecting a database to run the ScriptMaker script
In this Schedule assistant step, select the database containing the ScriptMaker script that you want 
to run. For more information, see Running ScriptMaker scripts (page 131).

To select a database with the ScriptMaker script to run:
1. Select the Database from the list.

2. Choose the type of account that you want FileMaker Server to use when it runs the script.

3. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topic
Scheduling administrative tasks (page 126)

To Choose

Use the built-in Guest 
account

Guest Account 
No account name or password is necessary.

Use any other account Account Name and Password 

Choose the account that FileMaker Server uses to 
access the database every time the script runs. The 
account must have sufficient privileges to perform 
the script. For more information about accounts and 
privilege sets, see FileMaker Pro Help.

Enter the Account Name and Password.
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Selecting a ScriptMaker script to run
In this Schedule assistant step, select the ScriptMaker script that you want to run.

To select a ScriptMaker script to run:
1. Select the script from the Script Name list.

Tip If a script group in the list is closed, click the icon beside the group name to open the group 
and view the scripts.

2. Enter an optional Script parameter.
Note For more information on script parameters, see FileMaker Pro Help.

3. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topics
Running ScriptMaker scripts (page 131)
Scheduling administrative tasks (page 126)
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Selecting a system-level script to run
In this Schedule assistant step, select the system-level script to run. For more information, see 
Running system-level script files (page 132). 

Put system-level script files in the Scripts folder before starting the Schedule assistant:

• Windows: [drive]:\Program Files\FileMaker\FileMaker Server\Data\Scripts\

• Mac OS: /Library/FileMaker Server/Data/Scripts/

If you do not see the script you want, click Cancel to exit the Schedule assistant, copy the script to 
the Scripts folder on the FileMaker Server computer, and run the Schedule assistant again.

Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topic
Scheduling administrative tasks (page 126)
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Selecting users to send a message to
In this Schedule assistant step, select the users that you want to receive a message. You select 
users by choosing one or more databases. Any FileMaker Pro user who is connected to one of 
these databases will receive the message.

To select users to send a message to:
1. Select one of the following options for sending a scheduled message:

2. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topics
Sending scheduled messages to clients of hosted databases (page 133)
Scheduling administrative tasks (page 126)

Choose To

All FileMaker Pro 
users (all databases) 

Send a scheduled message to all FileMaker Pro users connected to 
hosted databases.

FileMaker Pro users of 
databases in folder 

Send a scheduled message to FileMaker Pro users connected to 
hosted databases in a specified folder.

FileMaker Pro users of 
a selected database 

Send a scheduled message to FileMaker Pro users connected to a 
selected hosted database. 
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Creating a message
In this Schedule assistant step, create a message for FileMaker Pro users.

To create the message:
1. Type the message that you want to send.

2. Click Next.
Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topics
Sending scheduled messages to clients of hosted databases (page 133)
Scheduling administrative tasks (page 126)
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Troubleshooting
Problems with FileMaker Server typically occur in the following areas:

• Deployment problems (page 157)

• Admin Console problems (page 158)

• General problems (page 159)

• Network problems (page 160)

• Problems on client computers (page 162)

• FileMaker Server event log messages (page 164)

• Command line error messages (page 167)

• Improving performance (page 168)

Note If FileMaker Pro is already running while the Database Server is starting up on the same 
machine, the Database Server will start up but then abruptly stop. Stop FileMaker Pro, then start the 
Database Server. If this problem persists, restart your computer, then start the Database Server 
before starting FileMaker Pro.
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Deployment problems

The Deployment assistant reports that the web server test failed
If the Deployment assistant cannot communicate with the web server that you specified, you can 
provide more information and try again. 

To detect the web server:

1. Click Edit Server Deployment.
2. In the Deployment assistant, click Next until you reach the Web Server Test Failed step.

3. Follow the instructions in Web Server Test Failed (page 21).

The Mac OS web server fails during startup
When you install the FileMaker Server supported version of PHP, it does not appear in the 
Mac OS X Server Admin tool; it is not supposed to be listed. If you use the Mac OS X Server Admin 
tool to turn on PHP, the Server Admin tool adds a second PHP engine to the web server's 
configuration files. As a result, the web server may fail during startup when it attempts to load the 
second PHP engine. 

Refer to the FileMaker Knowledge Base for more information. See Customer support and 
Knowledge Base (page 198). 

Related topic
Troubleshooting (page 156)
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Admin Console problems

Admin Console Start Page says to install Java when it’s already installed
Internet Explorer may be configured to prevent add-ons from running. Click the Information Bar at 
the top of the browser window and allow Internet Explorer to run the Java Web Start ActiveX Control 
add-on. Java Web Start technology uses this add-on to determine whether the required version of 
Java is installed. After you allow this add-on to run, click Start Admin Console.

Cannot start Admin Console from a remote machine
• If the master machine has a firewall enabled, then you must open the ports required by 

FileMaker Server to communicate with users and administrators. See Ports used by 
FileMaker Server (page 161).

• If you double-click an Admin Console shortcut and Admin Console doesn’t open, check 
whether the IP address of the master machine has changed. Each shortcut starts Admin 
Console for a specific FileMaker Server deployment. If the IP address of the master 
machine changes, you must remove the shortcut and start Admin Console from the 
FileMaker Server Admin Console Start Page again. See Starting Admin Console (page 29).

Related topic
Troubleshooting (page 156)
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General problems

FileMaker Server is sending too many email messages
You have many, frequently-run scheduled tasks with email notifications enabled. Try disabling email 
notifications or remove email addresses for some scheduled tasks. Also, see Receiving email 
notifications only when a schedule fails (page 148).

None of the scheduled tasks are running
FileMaker Server has been configured not to allow any schedules to run. To allow FileMaker Server 
to run enabled schedules, click Schedules and select Allow schedules to run.

The path for my additional database folder or backup database folder is not 
valid
Check the ownership and permissions of the folder. When you click Validate in the Database 
Server > Default Folders tab or the Schedule assistant, Admin Console may fail to validate a folder 
path because the folder does not have the correct permissions. Check that the folder is owned by 
the user fmserver (or in the group fmsadmin) and has read and write permissions. See Tips for 
valid folders (page 75).

Related topic
Troubleshooting (page 156)
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Network problems

A FileMaker Pro client using TCP/IP can't find FileMaker Server databases on 
the network
Verify that TCP/IP networking software is properly configured on the host and client computers. 
Verify that the simultaneous client limit you specified has not been reached.

On the client computer, in the FileMaker Pro Open Remote File dialog box, type: 

fmnet:/[IP address]

If no client computers can see FileMaker Server in the Open Remote File dialog box, check the 
server network connection, and make sure the FileMaker Server ports are open on any firewall.

Cannot start Admin Console from a remote machine
If the master machine has a firewall enabled, then you must open the ports required by FileMaker 
Server to communicate with users and administrators. See Ports used by FileMaker Server (page 
161).

Each shortcut starts Admin Console for a specific FileMaker Server deployment. If the IP address of 
the master machine has changed, you must remove the shortcut and start Admin Console from the 
FileMaker Server Admin Console page again. See Starting Admin Console (page 29).

Clients cannot see databases hosted by FileMaker Server
The firewall settings on the master machine may be blocking the display of databases to clients. See 
Ports used by FileMaker Server (page 161) for more information on which ports need to be 
unblocked in firewalls.

Related topics
FileMaker Server event log messages (page 164)
Troubleshooting (page 156)
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Ports used by FileMaker Server
When running FileMaker Server in an environment that uses a firewall, be sure to configure the 
firewall on each machine to allow FileMaker Server to communicate. The table below lists all the 
ports used in a FileMaker Server deployment. 

Note Not all of the ports listed below need to be open to end users or between all machines in a 
FileMaker Server deployment. For more information on deploying on multiple machines, see 
FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

End users need only these ports to be open: 

• Port 80 for web publishing, or another port if your web server uses a port other than the 
default

• Port 5003 for FileMaker Pro clients. 

Admin Console users need ports 16000 and 16001 to be open.

Related topic
Network problems (page 160)

Port number Used by Purpose

80 Web server machine, end users HTTP
5003 Master machine, end users FileMaker Pro and FileMaker Server for 

hosting files
16000 All machines, Admin Console 

users
HTTP: Admin Console Start Page, Admin 
Helpers

16001 Master machine, Admin Console 
users

HTTPS: Admin Console communications

16004 All machines Admin Console
16006 Web Publishing Engine machine FileMaker Internal
16008 Web Publishing Engine machine FileMaker Internal
16010 Web Publishing Engine machine Custom Web Publishing Engine
16012 Web Publishing Engine machine FileMaker Internal
16014 Web Publishing Engine machine FileMaker Internal
16016 Web Publishing Engine machine Apache Jakarta Protocol (AJP) 1.3
16018 Web Publishing Engine machine Apache Jakarta Protocol (AJP) 1.3
50003 Master machine (local only) FileMaker Server service (Windows) or 

daemon (Mac OS)
50006 Master machine (local only) FileMaker Server Helper service (Windows) or 

daemon (Mac OS)
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Problems on client computers

Admin Console Start Page says to install Java when it’s already installed
Internet Explorer may be configured to prevent add-ons from running. Click the Information Bar at 
the top of the browser window and allow Internet Explorer to run the Java Web Start ActiveX Control 
add-on. FileMaker Server uses this add-on to detect whether the required version of Java is 
installed. After you allow this add-on to run, click Start Admin Console.

The FileMaker Server name does not appear in the FileMaker Pro Open 
Remote File dialog box
• Windows: Verify that the FileMaker Server service is started in the Services (Local) node.

• You may need to specify the host IP address of the computer running FileMaker Server. In 
the Open Remote File dialog box, type: fmnet:/[IP address].

Clients cannot see databases hosted by FileMaker Server
The firewall settings on the FileMaker Server machine may be blocking the display of databases to 
clients. See Ports used by FileMaker Server (page 161) for more information on which ports need to 
be unblocked in firewalls.

Clients receive “Communication with the host was interrupted and could not 
be re-established” message on client computer

FileMaker Server disconnected a client from a database because the client didn't comply with a 
request from FileMaker Server to close a database. Communication between the host and client 
may have been disrupted because of a hardware failure (lost network connection) or a software 
connection time-out (no response from client for a given period of time). The latter could be 
caused by a screen saver or processor-intensive operation.

Clients receive “servername is no longer available or the host capacity has 
been exceeded” message on client computer

FileMaker Server has shut down or you reached the maximum allowable connections or clients 
on FileMaker Server. Verify that FileMaker Server is running or increase the number of clients 
allowed in the Database Server > FileMaker Pro Clients tab.

Clients receive “Host capacity exceeded” message on client computer
You reached the maximum allowable connections or clients on FileMaker Server. Increase the 
number of clients allowed in the Database Server > FileMaker Pro Clients tab.

Clients receive “This action cannot be performed because the file is not 
modifiable” message on client computer (FileMaker Pro databases hosted by 
FileMaker Server on Mac OS)
Clients can’t modify the database file because the database file permissions are incorrectly set. The 
operating-system-level group fmsadmin must own the database file and have read and write 
access permissions. The Event.log will report “Opened database [filename] read only”. (If the 
database file is not owned by the group fmsadmin, FileMaker Server will not recognize the 
database file and there will be no entry in the Event.log.)
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Related topics
FileMaker Server event log messages (page 164)
Configuring Database Server settings (page 62)
Improving performance (page 168)
Users, groups, and permissions (Mac OS) (page 36)
Troubleshooting (page 156)
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FileMaker Server event log messages
The following is an alphabetical list and explanation of some of the log file messages you might see 
in the Event.log or in the Windows Event Viewer. Variables returned by FileMaker Server or the 
operating system, such as the name of the destination or file, are in [brackets].

Client [client name] no longer responding; connection closed. ([error 
number])

A connected client's computer has stopped communicating with FileMaker Server due to a 
network disruption or a software error.

Closing database [filename] due to serious error. ([error number])
The specified file is being closed by FileMaker Server due to an error condition. The file may 
need to be recovered in an earlier version of FileMaker Pro. See FileMaker Pro Help for 
information about recovering damaged files.

Database cache size: [x] MB.
The specified amount (x) of memory is usable for the database cache. This message is logged 
when FileMaker Server starts. You can adjust application memory by changing the RAM 
reserved for database cache in the Database Server > Databases tab. The new cache size 
takes effect immediately.

Database [filename] consistency check skipped by administrator, database 
opened. Use of this database could result in data corruption.

Administrator omitted the file consistency check via the Open a database action in the 
Databases pane. See Opening hosted files (page 96).

Database [filename] could not be opened. Database may be damaged; use 
the Recover command in FileMaker Pro 9.

The specified file failed the consistency check. Try opening the file in FileMaker Pro: start the 
FileMaker Pro application, open the file, and follow any instructions on your screen. (See 
FileMaker Pro Help for more information about recovering files.) Then try opening the file with 
FileMaker Server.

Database [filename] could not be opened in its current state: open it in 
FileMaker Pro first.

The database might be in an older format (databases need to be in FileMaker Pro 7 (.fp7) 
format before you can host them using FileMaker Server 9). For information about converting 
files, see FileMaker Pro Help.

Database [filename] is being opened for the first time in FileMaker 9, 
performing consistency check.

Since the specified file was created in FileMaker Pro 7 and has not been previously opened in a 
FileMaker 8 or later product, FileMaker Server performs a file consistency check.



Troubleshooting FileMaker Server event log messages

FILEMAKER SERVER 9 HELP 165

Database [filename] is damaged and has been closed.
Try opening the file in FileMaker Pro: start the FileMaker Pro application, open the file, and 
follow any instructions on your screen. (See FileMaker Pro Help for more information about 
recovering files.) Then try opening the file with FileMaker Server.

Database [filename] was not closed properly, performing consistency check.
The specified file was in use when FileMaker Pro or FileMaker Server shut down abnormally; 
therefore, FileMaker Server performs a file consistency check to examine the file’s blocks.

FileMaker Server is going to sleep. The entire cache will be flushed. All 
schedules will be suspended.

If the server computer is configured to sleep during periods of inactivity, before doing so the 
operating system prompts each open service or application to find out if the service or 
application can accommodate energy-saving mode. If any clients are currently connected to a 
hosted database, FileMaker Server denies the sleep request and the server computer does not 
sleep. If no clients are connected, FileMaker Server writes any unsaved changes to disk 
(flushes the cache) and allows the server computer to sleep. During sleep, all scheduled tasks 
are suspended and do not run again until the next scheduled time when the server computer is 
awake.

FileMaker Server is now awake. All schedules will now be resumed.
This message is sent to the log by FileMaker Server when the server computer wakes up from 
sleep mode. During sleep, all scheduled tasks are suspended and do not run until the next 
scheduled time when the server computer is awake.

FileMaker Server quitting! An unrecoverable error occurred. ([error number])
FileMaker Server detects a severe error during network use, due to a network failure or other 
causes. Check network installation, settings, and the system error log.

Registration with directory service failed. ([error number])
Registration with the directory service failed because the error number reported is an LDAP 
error from the LDAP server.

Schedule [schedule name] aborted; [destination] could not be found.
The specified destination could not be found. If the destination is a removable medium, make 
sure it is inserted in its drive. If the destination is an external or network drive, connect the drive 
or network. Try again after the destination volume drive is correctly set up.

Schedule [schedule name] aborted; no open databases to operate on.
The schedule specifies a folder in which FileMaker Server currently has no databases open. 
Therefore, the scheduled task can't proceed. Make sure that the schedule specifies the correct 
folder to operate on and that all databases have been opened correctly.
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Schedule [schedule name] aborted; the destination [destination] is not 
writable.

The specified destination is not accessible, and the schedule is now disabled. If the destination 
is a removable medium, you might need to remove it from the drive, make it writable, and 
reinsert it. Try again after the destination is correctly set up.

Related topics
Network problems (page 160)
Problems on client computers (page 162)
Viewing activities in the Event Viewer (Windows) (page 112)
Troubleshooting (page 156)
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Command line error messages 
The following is a list of the error codes you might see when working with the command line 
interface, and a brief description of each code. For additional information, consult the Event.log or 
see Troubleshooting (page 156).

10001 Invalid parameter

10502 Host was unreachable

Make sure the server is available.

10504 Cannot disconnect administrator

The client you're trying to disconnect is an administrator, which must always remain 
connected.

10600 Schedule is missing

10604 Cannot enable schedule

10606 Invalid backup destination for schedule

10801 Locale was not found

10900 Engine is offline

10901 Too many files are open

10902 File is not open

10903 File by the same name is already open 

10904 File for this operation was not found

11000 User specified an invalid command

11001 User specified invalid options

11002 Command is invalid as formatted

11005 Client does not exist

20302 Unknown Universal Path Type

20400 File operation canceled

20401 End of file

20402 No permission

20404 File is not open

20405 File not found

20406 File exists

20407 File already open

20500 Directory not found

20600 Network initialization error

For other error codes, see Customer support and Knowledge Base (page 198).

Related topic
Command line reference (page 171)
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Improving performance
For best performance, FileMaker Server should be run on a dedicated machine reserved for use as 
a database server. When FileMaker Server is hosting many clients or a large number of database 
files, it uses a high level of processor, hard disk, and network capacity. Other processor-intensive 
software or heavy network traffic on the same machine will cause FileMaker Server to run more 
slowly and degrade the performance of FileMaker Pro on client machines.

• Avoid installing FileMaker Server on a machine that is a user’s primary workstation or 
network file server. 

• You cannot run two different versions of FileMaker Server on the same machine at the 
same time.

• Avoid using the machine running FileMaker Server as an email, print, or file server.

• Do not use system backup software to back up databases hosted by FileMaker Server. 
Instead use the FileMaker Server Admin Console to schedule backups of databases.

• Do not use anti-virus software to scan the folders that contain hosted database files.

• Disable screen savers and sleep (or hibernate and standby) mode on the server. These OS 
features reduce performance or suspend access to hosted databases.

• Use a fast hard disk.

• Turn off file indexing (on Windows, Indexing Service; on Mac OS, Spotlight; or on any other 
third party file indexing software). This feature reduces performance.

• If you have a large number of FileMaker Pro and Web Publishing clients, consider switching 
to a multiple-machine deployment.

Note Because some DHCP servers cycle IP addresses, FileMaker recommends using a static IP 
address.

Related topic
Troubleshooting (page 156)
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Checking for updates
From the Start Page, you can check for updates to FileMaker Server software. In the Software 
Update section, click Check Now. If an update is available, you can click a link to download the 
update.

For information on enabling or disabling this feature, see Admin Console settings (page 59).
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About the license key
FileMaker software comes with a unique, 35-character license key. Do not lose this license key. We 
recommend that you keep the license key in a safe place in case the software ever needs to be 
reinstalled.

You can find your license key(s) on the back of the CD sleeve. If you paid for your software 
electronically, you received an email with a link to a PDF file with your license key.

The license key ensures adherence to the single user license agreement, which generally allows for 
use of one (1) copy of the Software on a single machine or a single multi-machine deployment at a 
time (refer to your Software License). If the license key is invalid or if another copy of the software 
installed with that same license key is running on the network, the FileMaker Server software 
displays an error message and does not start.

You can choose to deploy FileMaker Server components across multiple machines that work 
together to form a single FileMaker Server deployment. You must have a unique license key for 
each multiple-machine deployment, or obtain a volume license for more than one deployment. You 
must license one copy of FileMaker Server for each deployment.

Updating the FileMaker Server license
If you want to update your license from a trial version of FileMaker Server 9 or from FileMaker 
Server 9 to FileMaker Server 9 Advanced on the same machine, you must update your FileMaker 
Server license key.

To update the FileMaker Server license of an existing deployment, see Server information settings 
(page 55).

To move your FileMaker Server 9 deployment to a new machine or to upgrade from an earlier 
version of FileMaker Server, see FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.
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Command line reference
FileMaker provides the tool fmsadmin for administering FileMaker Server via the command line 
interface (CLI). You must be logged on to the computer running FileMaker Server to use the CLI.

Note The CLI is available via the command prompt (Windows) and the Terminal application 
(Mac OS). 

Command Line Interface files
The CLI executable fmsadmin is located in the folder:

• Windows: [drive]:\Program Files\Filemaker\FileMaker Server\Database 
Server\fmsadmin.exe

• Mac OS: /usr/bin/fmsadmin

Commands
The general format for fmsadmin commands is: 

fmsadmin command [options]

The following example authenticates with Admin Console user name admin and the password 
pword and closes all open databases without prompting you to confirm:

fmsadmin close -y -u admin -p pword 

Important CLI commands can include the Admin Console name and password. If a command is 
used interactively, the user name is visible but the password is not. If a command in a script or batch 
file must include a name and password, be sure that only the password owner can view the script or 
batch file.

In the CLI, use the fmsadmin help command to see Help pages on other commands. For 
FileMaker Server online Help on specific commands, see fmsadmin commands (page 174). 

Options
Options pass switches and parameters to fmsadmin. Type fmsadmin help options to see the 
list. You can specify options in a short or a long format, for example: -h or --help. You can use the 
following options with all commands.

Use To

-h, --help Print this page. 
-p password, --password password Specify the password to use to authenticate the 

server.
-u username, --username username Specify username and/or domain name to use to 

connect to FileMaker Server. 
-v, --version Print version information. 
-w seconds, --wait seconds Specify time in seconds for command to time out.
-y, --yes Automatically answer yes to all prompts.
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Options for specific commands

• To specify the short form of options, use a single hyphen (-). You can specify multiple 
options together. If an option requires a parameter, that option is usually the last option that 
you specify. For example, 

fmsadmin close -ym 'Closing for maintenance' Database.fp7 

• To specify the long form of options, use double hyphens (--). Long options can be used in 
scripts to increase readability. You must specify each option separately, preceded by two 
hyphens. A space is required between the option and any parameters, for example,

fmsadmin close --yes --message "Closing for maintenance" Database.fp7 

Parameters 
• Enclose any parameters that contain spaces in single or double quotation marks. 

Tip For computer and filenames, use names consisting of standard ASCII characters without 
spaces. 

• You can specify file IDs instead of filenames. Use fmsadmin list files [-s] to return 
file IDs and other statistics. File IDs are dynamically generated.

• Symbols that may be interpreted by the shell must be escaped, that is, preceded by a 
backslash character (\). Refer to the documentation for your shell or command interpreter.

• Example: the following command does not prompt for confirmation (-y), allows clients 5 
minutes to close the file (-t300), and sends a message (-m). The command operates on 
file IDs 20 and 22 and the folder “Solution”.

fmsadmin close -y -t300 -m "Closing for maintenance" 20 22 "filemac:/
Library/FileMaker Server/Data/Databases/Solution/"

Scripting language 
If you use a scripting language that allows execution of shell or Terminal commands, you can script 
many tasks with fmsadmin. On Mac OS, you can use tools such as cron or launchd to schedule 
execution of fmsadmin commands like ‘run schedule’ or ‘backup’. On Windows, you can use the 
Scheduled Task Wizard to schedule scripted tasks.

Administrator authentication
FileMaker Server always challenges the CLI for authentication. FileMaker Server logs all 
administrator connections, both successful or failed.

Use To

-d path, --dest path Specify a destination path.
-f, --force Force close a database or shut down the server.
-m message, --message message Specify a text message to be sent to clients.
-o, --offline Perform an offline backup.
-s, --stats Return file or client statistics.
-t seconds, --grace-time seconds Specify time in seconds before client is forced to 

quit.
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Related topic
Command line error messages (page 167)
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fmsadmin commands
The fmsadmin command line interface (CLI) commands are listed below. Type: fmsadmin help 
commands to see the list. Click a link for more information.

Related topics
Command line error messages (page 167)
Command line reference (page 171)

Use To

BACKUP command (page 175) Back up databases
CLOSE command (page 176) Close databases
DISABLE command (page 177) Disable schedules 
DISCONNECT command (page 
178)

Disconnect a client 

ENABLE command (page 179) Enable schedules
HELP command (page 180) Get help pages for fmsadmin commands
LIST command (page 181) List clients, files, plug-ins, or schedules
OPEN command (page 182) Open databases
PAUSE command (page 183) Temporarily stop database access
RESUME command (page 184) Make databases available
RUN command (page 185) Run a schedule
SEND command (page 186) Send a message
START command (page 187) Start the Database Server 
STATUS command (page 188) Get status of clients or files
STOP command (page 189) Stop the Database Server
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BACKUP command

Format 
fmsadmin BACKUP [FILE...] [PATH...] [options] 

Description
Backs up the specified files (FILE) or all the hosted files in the specified paths (PATH).

By default, the BACKUP command performs a live backup of a hosted file, without interfering with 
client usage. Alternatively, first PAUSE the databases, then issue the BACKUP command, followed 
by a RESUME command to perform an offline backup. If you don’t specify a path, the databases are 
backed up to the default backup folder. If you don’t specify a file, all hosted databases are backed 
up.

Option
-d path, --dest path

Overrides the default backup folder destination by backing up the databases to the specified 
path. If the path doesn't exist, FileMaker Server attempts to create it.

Related topics
RUN command (page 185)
Default folder settings (page 73)
Command line reference (page 171)
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CLOSE command

Format
fmsadmin CLOSE [FILE...] [PATH...] [options]

Description
Closes the specified files (FILE) or all the hosted files in the specified paths (PATH). If no FILE or 
PATH is specified, closes all hosted files.

Note If you want to close a specific file, you must type a space between any options and the 
filename or file ID. For example,

Options
-m message, --message message 

Specifies a text message to be sent to the client that is being disconnected.

-t seconds, --grace-time seconds

Specifies the total number of seconds to wait before forcing disconnection of clients. The default 
(and minimum) value is 120 seconds.

For example, if you type

fmsadmin close --grace-time 120

clients see a dialog box immediately and can click Close Now or Cancel. If the client does not 
click a button, the file closes in 30 seconds. If the client clicks Cancel, the dialog box will 
reappear 45 seconds before the specified time limit (120 seconds). If the client clicks Close 
Now at this point, the file closes immediately. If the client clicks Cancel again, the file closes 
after another 45 seconds.

-f, --force 

Forces a database to be closed without a prompt for confirmation.

Related topics
DISCONNECT command (page 178)
OPEN command (page 182)
STOP command (page 189)
Command line reference (page 171)

Command Result

fmsadmin close -y Database Closes only the specified file.
fmsadmin close -y Closes all hosted files.
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DISABLE command

Format 
fmsadmin DISABLE [TYPE] [SCHEDULE_NUMBER]

Description
Disables the item of the specified TYPE.

Valid TYPES
SCHEDULE: Disables a schedule. 

SCHEDULE_NUMBER is the ID of the schedule to disable. Use the LIST SCHEDULES 
command to obtain the ID number of each schedule.

Options
None.

Related topics
ENABLE command (page 179)
LIST command (page 181)
Command line reference (page 171)
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DISCONNECT command

Format 
fmsadmin DISCONNECT CLIENT [CLIENT_NUMBER] [options]

Description 
Disconnects the specified client. The CLIENT_NUMBER is the ID number of the client. Use the LIST 
CLIENTS command to obtain a list of clients and their ID numbers.

Important The command fmsadmin DISCONNECT client without a client ID number 
disconnects all clients.

Option
-m message, --message message 

Specifies a text message to be sent to the client that is being disconnected.

Related topics
CLOSE command (page 176)
LIST command (page 181)
STOP command (page 189)
Command line reference (page 171)
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ENABLE command

Format 
fmsadmin ENABLE [TYPE] [SCHEDULE_NUMBER] 

Description 
Enables items of the specified TYPE.

Valid TYPES
SCHEDULE: Enables a schedule. 

SCHEDULE_NUMBER is the ID of the schedule to enable. Use the LIST SCHEDULES 
command to obtain the ID numbers of each schedule.

Options
None.

Related topics
DISABLE command (page 177)
LIST command (page 181)
Command line reference (page 171)
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HELP command

Format 
fmsadmin [options] HELP [COMMAND]

Description
Displays a help page for other fmsadmin commands.

• Type fmsadmin help for general information.

• Type fmsadmin help commands for a list of available commands. 

• Type fmsadmin help [COMMAND] for help on a specific command. 

• Type fmsadmin help options for a list of available options.

Related topic
Command line reference (page 171)
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LIST command

Format 
fmsadmin LIST [TYPE] [options]

Description 
Lists items of the specified TYPE. 

Valid TYPES
CLIENTS: Lists the connected clients. The following example lists the currently connected users:

fmsadmin list clients

FILES: Lists the hosted files. The following example returns file IDs and other statistics for the 
currently open, hosted files in the default folders: 

fmsadmin list files [-s]

PLUGIN: Lists Database Server calculation plug-ins. The following example lists all plug-ins:

fmsadmin list plugins

SCHEDULES: Lists schedules. The following example lists all schedules:

fmsadmin list schedules

Option
-s, --stats

Displays statistical information about CLIENTS and FILES.

Related topic
Command line reference (page 171)
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OPEN command

Format 
fmsadmin OPEN [FILE...] [PATH...]

Description
Opens databases in the default and additional database folders. Each FILE specified is opened, or 
all the files in each PATH are opened. If no FILE or PATH is specified, all files in the default folder 
are opened.

To specify a file by its ID rather than its filename, first use the LIST command to get a list of all 
currently open files and their file IDs:

fmsadmin list files [-s]

After you have the file IDs, you can use the OPEN command and specify IDs of the files to open.

For example, the following command opens file IDs 20 and 22 and the folder “Solution”:

fmsadmin open 20 22 "filemac:/Library/FileMaker Server/Data/Databases/
Solution/"

Options
None.

Related topics
CLOSE command (page 176)
LIST command (page 181)
Command line reference (page 171)
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PAUSE command

Format
fmsadmin PAUSE [FILE...] [PATH...]

Description
Pauses the specified files (FILE) or all the hosted files in the specified paths (PATH). If no FILE or 
PATH is specified, pauses all hosted files. 

After a file is paused, it is safe to copy or back up the file until a RESUME is performed.

Options
None.

Related topics
BACKUP command (page 175)
RESUME command (page 184)
Command line reference (page 171)
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RESUME command

Format 
fmsadmin RESUME [FILE...] [PATH...]

Description
Makes a database that has been paused available again. Each FILE specified is resumed, and all 
files in each PATH are resumed. If no FILE or PATH is specified, all paused files are resumed.

Options
None.

Related topics
BACKUP command (page 175)
PAUSE command (page 183)
Command line reference (page 171)
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RUN command

Format 
fmsadmin RUN schedule [SCHEDULE_NUMBER]

Description
Manually runs a schedule specified by its SCHEDULE_NUMBER. To obtain a list of schedules and 
their ID numbers, use the LIST SCHEDULES command.

Options
None.

Related topics
LIST command (page 181)
Command line reference (page 171)
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SEND command

Format 
fmsadmin SEND [options] [CLIENT_NUMBER] [FILE...] [PATH...]

Description
Sends a text message to a client specified by CLIENT_NUMBER, to the clients connected to the 
specified files (FILE), or to all clients connected to any file in the specified paths (PATH). 

If no CLIENT_NUMBER, FILE, or PATH is specified, the message is sent to all connected clients. By 
default, parameters are expected to be FILES or PATHS.

To specify a CLIENT_NUMBER, you must use the -c option. For example: 

fmsadmin SEND -c 2 -m "This is a test message"

Options
-m message, --message message 

Specifies the text message to send.

-c, --client

Specifies a CLIENT_NUMBER.

Related topics
LIST command (page 181)
Command line reference (page 171)
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START command

Format 
fmsadmin START SERVER 

Description
Starts the Database Server. This command works only if the FileMaker Server service (Windows) or 
daemons (Mac OS) are running.

Options
None.

Related topics
STOP command (page 189)
Starting and stopping FileMaker Server (page 51)
Command line reference (page 171)
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STATUS command

Format 
fmsadmin STATUS [TYPE] [CLIENT_NUMBER] [FILE]

Description 
Retrieves the status of the specified TYPE. 

Valid TYPES
CLIENT: Retrieves the status of a client specified by CLIENT_NUMBER. For example:

fmsadmin STATUS client 2

Use the LIST CLIENTS command to obtain a list of clients and their ID numbers. 

FILE: Retrieves the status of an open file specified by FILE. For example, to get the status of a file 
named “Database”:

fmsadmin STATUS file Database

Options
None.

Related topics
LIST command (page 181)
Command line reference (page 171)
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STOP command

Format
fmsadmin STOP [options]

Description
Stops the Database Server. 

Options
-f, --force 

Expedites shut down of the Database Server. All clients are immediately disconnected. 

-m message, --message message 

Specifies a text message to send to the connected clients.

-t seconds, --grace-time seconds 

Specifies the total number of seconds to wait before forcing disconnection of clients. The default 
(and minimum) value is 120 seconds.

For example, if you type

fmsadmin stop --grace-time 120 

clients see a dialog box immediately and can click Close Now or Cancel. If the client does not 
click a button, the client is disconnected in 30 seconds. If the client clicks Cancel, the dialog box 
will reappear 45 seconds before the specified time limit (120 seconds). If the client clicks Close 
Now at this point, the client is disconnected immediately. If the client clicks Cancel again, the 
client is disconnected after another 45 seconds.

The grace-time option is available only if the --force option is not used.

Related topics
START command (page 187)
CLOSE command (page 176)
DISCONNECT command (page 178)
LIST command (page 181)
Starting and stopping FileMaker Server (page 51)
Command line reference (page 171)
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Glossary

A
Access privileges

Permission to view and work with certain records, fields, layouts, value lists, and scripts and to 
perform selected activities in a file. 

Account
A username and (usually) password that accesses a file with a defined level of privileges. 

Active Directory
In Windows, the distributed directory service that is included with the Microsoft Windows 2000 
and 2003 Server operating systems. Active Directory provides centralized, secure management 
of a network.

Admin Console
The application you use to configure and administer FileMaker Server, work with hosted 
databases, view details about connected clients, and track statistical information.

Administrative tasks
Procedures performed regularly by the administrator to keep FileMaker Server running 
efficiently and insure data integrity in hosted databases. For example, running regularly 
scheduled database backups is a typical administrative task.

API (Application Programming Interface)
A set of software application building blocks, such as classes, methods, data structures, 
variables, procedures, and functions.

AppleScript
Mac OS: A scripting language you can use to control functions of the Mac OS and of 
applications that support AppleScript (often called scriptable applications).

Assistants
Onscreen instructions that guide you step-by-step through a task.

Authentication
The process of checking the validity of an account and password (if one is defined) before 
assigning privileges and allowing access to a system or a database file. 

B
Backup

A copy of a database file that can be used if the original is lost, damaged, or otherwise 
irretrievable.

Block
A string of data elements recorded or transmitted as an individual unit. A block is often the 
smallest unit of data a program reads from or writes to the hard disk.
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C
Cache

An area of RAM reserved by a program to store frequently used data, providing faster access 
than if the data had to be read from the hard disk. A larger cache size increases FileMaker 
Server performance. 

CLI
CLI is the command line interface. Using the FileMaker Server CLI, an administrator can enter 
fmsadmin commands to administer FileMaker Server.

Client
A user who opens a connection to a database hosted on FileMaker Server with FileMaker Pro, a 
web browser, or an ODBC/JDBC client application.

Client application
The application that requests data from a data source. Examples include FileMaker Pro, when it 
accesses a database hosted by FileMaker Server, and a spreadsheet, when it requests data 
using SQL via ODBC or JDBC.

Container field
A FileMaker Pro field that can store pictures, sounds, QuickTime movies, or files of any type.

Custom Web Publishing
A method of sharing FileMaker databases on the web using XML, XSLT, or PHP. You can create 
dynamic webpages that enable users to interact with databases hosted on FileMaker Server.

D
Daemon

Mac OS: a process that runs in the background and performs functions to support other 
programs. FileMaker Server runs as several daemons in Mac OS.

Database file
A collection of information in a file containing one or more tables pertaining to a subject, such as 
customers or invoices. (A large database can also comprise many database files.)

Database file compression
The process of removing empty fields or redundant or unnecessary data in database files to 
minimize the amount of disk space they require.

Database Server
The component of FileMaker Server that hosts databases. In a multiple-machine deployment, 
the machine running the Database Server is called the master machine. Database files are 
stored on the master machine’s hard disk.

Databases folder
On startup, FileMaker Server looks for databases to host in the default Databases folder, 
additional folder, and in subfolders one level down. 

Data source
Data you want to access, for example, data in a FileMaker Pro database or in another database 
management system.
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Data source name (DSN)
A data structure that contains the information about a specific database that an ODBC driver 
needs in order to connect to it. 

Deployment
The process and result of installing and configuring FileMaker Server components on one or 
more machines. In a multiple-machine deployment, components are deployed across more than 
one machine and work together as a unit.

Directory service
Software with a client/server architecture that is used to store information about your 
organization.The primary function of a directory service is to centralize the storage of 
information and respond quickly to queries.

Distinguished name (DN)
Uniquely identifies an entry in a directory tree, using a series of comma-separated attributes. In 
a DN, the left-most component is the actual directory object, and the right-most value is the 
directory root.

Domain name
A name that identifies a computer on the internet.

Driver
The ODBC or JDBC driver translates SQL queries into commands that a DBMS can 
understand. It processes ODBC/JDBC calls, submits SQL requests to the data source, and 
returns the data back to the driver manager, which then routes it to the requesting application.

E
Event Viewer

Windows: An administrative tool that comes with the Windows operating system and displays 
events stored in various log files. FileMaker Server reports its events to the Application log, and 
these events can be viewed using Event Viewer.

Event.log
A file that records events that occur while the Database Server is running.

Extended privilege
FileMaker Pro data sharing permissions that determine if a privilege set allows users to access 
a hosted file using FileMaker Pro, use a database as an ODBC/JDBC data source, or access 
data published on the web.

F
FileMaker Pro

An application for creating and modifying database files. Clients use FileMaker Pro to access 
database files hosted by FileMaker Server.

FileMaker Pro Advanced
An application that enables database developers to build custom FileMaker solutions for use on 
the web or in workgroups, and to create royalty-free runtime applications and custom FileMaker 
plug-ins.
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G, H
Hibernate

Windows: A power conservation mode that saves energy on an idle system. If the computer 
running FileMaker Server hibernates, all client activity is suspended. Hibernation will not occur 
on the server machine if there are clients connected to hosted databases.

Hosted database
A file opened by FileMaker Server for clients to use on a computer network. One or more clients 
can access and change information simultaneously in hosted databases.

I, J, K
IP (Internet Protocol) address

A four-part number, usually formatted as 12.34.56.78, that uniquely identifies a computer on a 
network or on the Internet.

IWP (Instant Web Publishing)
A method of sharing your FileMaker databases with other users via a web browser. Web clients 
are limited to the layouts that you provide and to the privilege sets assigned to their user 
accounts.

JDBC
A Java API that uses SQL statements to access data from, and exchange data with, many 
database management systems. The JDBC driver communicates between your Java applet and 
the FileMaker Pro or FileMaker Server Advanced data source.

JDBC client driver
A JAR (Java Archive) file that sends an SQL query to access data stored in a database and 
delivers the requested data to the client application.

Java Web Start
A technology that deploys applications to users by making the applications available from a 
standard web server. The user computer requires the Java Runtime Environment (JRE).

L
Lightweight Directory Access Protocol (LDAP)

This protocol, which runs over TCP/IP, makes it possible for system administrators to centrally 
manage users, groups, devices, and other data.

M
Machine roles

Each computer in a FileMaker Server deployment is assigned a machine role as either a master 
(only one) or a worker (one or two).

Master
The machine in a FileMaker Server deployment that runs the Database Server and manages all 
worker machines. The master communicates with the workers to handle database requests 
from users, configure the settings on all machines, and monitor the status and activity of all 
components. 
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N
NetInfo

The information management system for the Mac OS platform. It manages all of the operating 
system settings and information, such as users and groups. It also handles the authentication of 
users.

Network protocol
A set of rules that governs how computers exchange messages on a network. Common 
protocols include TCP/IP, HTTP, and HTTPS.

O, P, Q
ODBC

An API that uses SQL statements to access data from, and exchange data with, many database 
management systems. FileMaker Server Advanced can share data as a data source via ODBC. 
FileMaker Server can also interact with data from other applications (as an ODBC client 
application).

ODBC client driver
A DLL (Windows) or shared library (Mac OS) that sends an SQL query to access data stored in 
a data source and delivers the requested data to the client application.

Open Directory
Apple’s standards-based directory and network authentication services architecture for Mac OS 
X. 

PHP (PHP: Hypertext Preprocessor)
An open-source programming language primarily used in server-side application software to 
create dynamic web pages. FileMaker Server lets you publish data from FileMaker Pro 
databases on customized web pages created with PHP. 

Plug-in
Software that extends the capabilities of an application in a specific way. 

Privilege set
A defined set of permissions that determines a level of access to a database file. 

R
Relationships graph

In FileMaker Pro, you can see the occurrences of tables both in the current file and from any 
external, related database files. In this relationships graph, you join tables and change 
relationships between fields in different tables.

Runtime solution file
A database file that has been created with FileMaker Pro Advanced software in which data can 
be added, deleted, and changed, but in which database fields and layouts cannot be altered.
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S
Schedules

You can create schedules to back up hosted databases, run scripts, and send messages to 
clients. 

ScriptMaker
A feature in FileMaker Pro that enables you to create a script that tells FileMaker Pro to perform 
one action or a sequence of actions, or script steps.

Secure Sockets Layer (SSL)
A protocol to encrypt and authenticate communications on the Internet. Used by the HTTPS 
access method.

Service
Windows: a process that runs in the background and performs functions to support other 
programs. FileMaker Server runs as a service in Windows.

Sleep
A feature of the operating system that saves energy on an inactive computer. If the computer 
running FileMaker Server sleeps, all client activity is suspended.

SMTP (Simple Mail Transfer Protocol)
A standard server-to-server protocol for transferring email messages. FileMaker Server uses 
this protocol to send email notifications.

SQL
A structured programming query language that controls and interacts with a DBMS.

Standby
Windows: A power conservation feature that saves energy on an idle system. If the computer 
running FileMaker Server enters Standby mode, all client activity is suspended. The server 
computer will not enter Standby mode if there are FileMaker Pro clients connected to hosted 
databases.

Stats.log
A file that records statistical information about how FileMaker Server is performing.

T
TCP/IP (Transmission Control Protocol/Internet Protocol)

The basic communication protocol that is the foundation of the Internet.

Toolbar
A collection of tools in Admin Console that execute frequently used commands. 

U, V, W, X, Y, Z
Upload

To transfer data or files from one computer to a remote computer. For example, to use the 
Upload Database assistant to transfer a database file to FileMaker Server.

Web Publishing Core
A software component of the Web Publishing Engine that processes requests for data and 
converts data from the Database Server into XML.
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Web Publishing Engine
The Web Publishing Engine provides the Custom Web Publishing services for databases 
hosted by FileMaker Server and the Instant Web Publishing services (for FileMaker Server 
Advanced).

Web server
The software responsible for responding to HTTP or HTTPS requests from users on the web. 
Required in a FileMaker Server deployment for publishing databases on the web.

Web Server Module
A FileMaker Server software component installed on the web server machine. The Web Server 
Module enables the Web Publishing Engine to connect to the web server.

Worker
A machine in a FileMaker Server deployment that runs either the Web Publishing Engine or the 
web server. Workers are configured and monitored by the master.

XML
Instead of being a rigid file format, XML is a language for defining agreed-upon formats that 
groups can use for exchanging data. Many organizations and businesses use XML to transfer 
product information, transactions, inventory, and other business data.

XSLT
XSLT (XSL Transformations) is a subset of XSL (Extensible Stylesheet Language) that is used 
to transform, or change, the structure of an XML document into a different document format. For 
example, you can use an XSLT style sheet to transform an XML document into an HTML or TXT 
document.
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Registration 
Please take the time to register your product by choosing Help menu > Register Now in FileMaker 
Server Admin Console. By registering your software, you may be eligible for upgrade offers and 
other customer services. 

If you are using the FileMaker Server trial version, you must register your software prior to use. 

For more information on registration, see “Registration and customer support” in FILEMAKER SERVER 
GETTING STARTED GUIDE on the Start Page. 
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Customer support and Knowledge Base
For information about technical support and customer service, visit www.filemaker.com/intl.

To access resources on the FileMaker web site such as ready-made solutions and the FileMaker 
Knowledge Base, in FileMaker Server Admin Console choose Help menu > FileMaker on the Web.

For free online technical support, use the FileMaker Knowledge Base. It offers answers to frequently 
asked questions, tips, troubleshooting advice, and much more. Knowledge Base articles are 
available only in English.

http://www.filemaker.com/kb 

If you do not have access to the web, please refer to the FileMaker Service Directory that comes 
with your software. North American customers can also call (800) 325-2747 to learn about the 
service options available.

http://www.filemaker.com/intl
http://www.filemaker.com/kb
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Copyright information
© 2007 FileMaker, Inc. All Rights Reserved.
FileMaker, Inc.
5201 Patrick Henry Drive
Santa Clara, California 95054

FileMaker is a trademark of FileMaker, Inc., registered in the U.S. And other countries, and 
ScriptMaker and the file folder logo are trademarks of FileMaker, Inc. All other trademarks are the 
property of their respective owners.

FileMaker documentation is copyrighted. You are not authorized to make additional copies or 
distribute this documentation without written permission from FileMaker. You may use this 
documentation solely with a valid licensed copy of FileMaker software.

All persons and companies listed in the examples are purely fictitious and any resemblance to 
existing persons and companies is purely coincidental. Credits are listed in the Acknowledgements 
document provided with this software. Mention of third-party products is for informational purposes 
only and constitutes neither an endorsement nor a recommendation. FileMaker, Inc. assumes no 
responsibility with regard to the performance of these products.

For more information, visit our website at www.filemaker.com.

http://www.filemaker.com
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